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Very Large Scale Integration with VHDL (22062)

Preface

The primary focus of any engineering laboratory/ field work in the technical
education system is to develop the much needed industry relevant competencies and skills. With
this in view, MSBTE embarked on this innovative _I° Scheme curricula for engineering diploma
programme with outcome-base education as the focus and accordingly, relatively large amount
of time is allotted for the practical work. This displays the great importance of laboratory work
making each teacher; instructor and student to realize that every minute of the laboratory time
need to be effectively utilized to develop these outcomes, rather than doing other mundane
activities. Therefore, for the successful implementation of this outcome-based curriculum, every
practical has been designed to serve as a “vehicle’ to develop this industry identified competency
in every student. The practical skills are difficult to develop through _chalk and duster® activity
in the classroom situation. Accordingly, the _I° scheme laboratory manual development team
designed the practical’s to focus on the outcomes, rather than the traditional age old practice of
conducting practical’s to verify the theory® (which may become a byproduct along the way).

This laboratory manual is designed to help all stakeholders, especially the students,
teachers and instructors to develop in the student the pre-determined outcomes. It is expected
from each student that at least a day in advance, they have to thoroughly read through the
concerned practical procedure that they will do the next day and understand the minimum
theoretical background associated with the practical. Every practical in this manual begins by
identifying the competency, industry relevant skills, course outcomes and practical outcomes
which serve as a key focal point for doing the practical. The students will then become aware
about the skills they will achieve through procedure shown there and necessary
precautions to be taken, which will help them to apply in solving real-world problems in
their professional life.

This manual also provides guidelines to teachers and instructors to effectively facilitate
student-centered lab activities through each practical exercise by arranging and managing
necessary resources in order that the students follow the procedures and precautions
systematically ensuring the achievement of outcomes in the students.

In the present scenario of electronics technology, CMOS is a vital important and basic
need in the design/development of almost all products in the range from consumer to industrial
and telecommunication engineering area. Functional capabilities of this technology leads to
advanced Very Large Scale Integration, large density of components, high speed of operation, less
area with less power dissipation. Therefore imparting knowledge of VLSI and its tools is need of
today. After completion of this course, students will be able to develop applications in the area of
digital electronics using VLSI design tools.

Although all care has been taken to check for mistakes in this laboratory manual, yet it is
impossible to claim perfection especially as this is the first edition. Any such errors and
suggestions for improvement can be brought to our notice and are highly welcome
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Programme Outcomes (POs) to be achieved through Practical of this
Course

Following programme outcomes are expected to be achieved through the practical of the
course.

PO1. Basic knowledge: Apply knowledge of basic mathematics, sciences and basic
engineering to solve the broad-based FElectronics and Telecommunication engineering
problems.

PO2. Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering related
problems

PO3. Experiments and practice: Experiments and practice: Plan to perform experiments
and practices to use the results to solve broad-based Electronics and Telecommunication
engineering problems

PO4. Engineering tools: Apply relevant Electronics and Telecommunications technologies
and tools with an understanding of the limitations

POS5. The engineer and society: Assess societal, health, safety, legal and cultural issues and
the consequent responsibilities relevant to practice in field of Electronics and
Telecommunication engineering

PO6. Environment and sustainability: Apply Electronics and Telecommunication
engineering solutions also for sustainable development practices in societal and
environmental contexts

PO7. Ethics: Apply ethical principles for commitment to professional ethics, responsibilities
and norms of the practice also in the field of Electronics and Telecommunication engineering.

POS8. Individual and team work: Function effectively as a leader and team member in
diverse/ multidisciplinary teams

PO9. Communication: Communicate effectively in oral and written form

PO10. Life-long learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication engineering
and allied industry.

Program Specific Outcomes (PSO) (What s/he will be able to do in the Electronics and
Telecommunication engineering specific industry soon after the diploma programme)

PSOL1. Electronics and Telecommunication Systems: Maintain various types of Electronics
and Telecommunication systems.

PSO2. EDA Tools Usage: Use EDA tools to develop simple Electronics and
Telecommunication engineering related circuits.

Maharashtra State Board of Technical Education ii
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Practical- Course Outcome matrix

Course Outcomes (COs)

a. Develop design flow for the given application using VLSI tools.
b. Interpret CMOS technology circuits with their specifications.
c. Use relevant VHDL model for given application.
d. Debug VHDL programme for the given application.
e. Maintain FPGA based circuits
Pro CO [CO |CO |CO |cCOo
N ' Practical Outcomes (PrO)
0. a. b. C. d. €.
1.* | Identify internal block and pin configuration of FPGA v - - - -
and CPLD using datasheet.
2 = | Develop flow chart of CMOS IC fabrication using ; v - , ,
relevant website.
3.* | Install EDA tool (VHDL) for VLSI application. - - v - -
4.* | Implement any two gates using Data flow and - - - v -
Behavioral model.
5. | Implement Half /full adder / subtractor using FPGA. - - - v -
6. | Implement 8:1 multiplexer using FPGA. - - - v -
7. | Implement 1:8 Demultiplexer using FPGA. - - - v -
8. | Implement T and D-flip-flop using FPGA. - - - v -
9. | Implement 2:4 Decoder using FPGA. - - - v -
10. | Implement 8:3 Encoder using FPGA. - - - v -
11. | Implement up-counter using FPGA. - - - v -
12. | Implement synchronous counter using FPGA. - - - v -
13. | Implement binary to gray code converter using FPGA. - - - v -
14.*| Build /Test DAC using FPGA - - - - v
15. | Implement Stepper motor controller using FPGA. - - - - v
16.*| Implement four Bit ALU or sequence generator using . . - . v

FPGA.

Maharashtra State Board of Technical Education
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List of Industry Relevant Skills

The following industry relevant skills of the competency ‘Maintain VLSI based
electronic circuits and equipments’ are expected to be developed in students by
undertaking the practical’s of this laboratory manual.

Develop the flow chart for CMOS fabrication.
Identify the various blocks of FPGA and CPLD.
Develop ‘“VHDL’ code using IDE tools.

Use Input/output port pins of FPGA.

Interface FPGA KIT and desktop PC.

Nk W=
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10.
11.

12.

13.

N vk

8.
9.

10.

Guidelines to Teachers

Teacher is expected to refer complete curriculum document and follow guidelines for
implementation
Teacher should provide the guideline with demonstration of practical to the students with

all features.

Teacher shall explain prior concepts to the students before starting of each practical
Involve students in performance of each practical.

Teacher should ensure that the respective skills and competencies are developed in the
students after the completion of the practical exercise.

Teachers should give opportunity to students for hands on experience after the
demonstration.

Teacher is expected to share the skills and competencies to be developed in the students.
Teacher may provide additional knowledge and skills to the students even though not
covered in the manual but are expected the students by the industry.

Give practical assignment and assess the performance of students based on task assigned
to check whether it is as per the instructions.

Assess the skill achievement of the students and COs of each unit.

At the beginning Teacher should make the students acquainted with any of the simulation
software environment as few experiments are based on simulation.

It is desirable to paste the photo of actual practical setup or draw block diagram of
practical setup.

Practical No.1 , 2 and 3 should not be consider for Practical (ESE-End Semester Exam).

Instructions for Students
Listen carefully the lecture given by teacher about course, curriculum, learning structure,

skills to be developed.

Before performing the practical student shall read lab manual of related practical to be
conducted.

For incidental writing on the day of each practical session every student should maintain
a dated log book for the whole semester, apart from this laboratory manual which s/he
has to submit for assessment to the teacher.

Organize the work in the group and make record of all observations.

Students shall develop maintenance skill as expected by industries.

Student shall attempt to develop related hand-on skills and gain confidence.

Student shall develop the habits of evolving more ideas, innovations, skills etc. those
included in scope of manual

Student shall refer technical magazines, IS codes and data books.

Student should develop habit to submit the practical on date and time.

Student should well prepare while submitting write-up of exercise.

Maharashtra State Board of Technical Education %
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Content

List of Practical’s and Progressive Assessment Sheet

Sr.
No.

Page Date of Date of

Title of the practical No. performance | submission

Assessment
marks(25)

Dated sign.
of teacher

Remarks
(if any)

Identify internal block and pin
1.* | configuration of FPGA and CPLD 1
using data sheet.

Develop flow chart of CMOS IC

2.* . . . 12
fabrication using relevant website.
3 % Install EDA tool (VHDL) for VLSI 51
' application.
4% Implement any two gates using Data 31
" | flow and Behavioral model.
Implement Half /full adder /
5. | subtractor using FPGA. 49
6 Implement 8:1 multiplexer using 2
" | FPGA.
7 Implement 1:8 Demultiplexer using 4
" | FPGA.
] Implement T and D-flip-flop using %6
" | FPGA.

9. | Implement 2:4 Decoder using FPGA. 98

10. | Implement 8:3 Encoder using FPGA. 111

11. | Implement up-counter using FPGA. 123

12 Implement synchronous counter using 137
" | FPGA.

13 Implement binary to gray code 151
" | converter using FPGA.

14.* | Build /Test DAC using FPGA 164

15 Implement Stepper motor controller 176
" | using FPGA.

16.% Implement four Bit ALU or sequence 190
" | generator using FPGA.

TOTAL

e The practical marked as “*’ are compulsory,
° Column 6™ marks to be transferred to Performa of CIAAN-2017.

Maharashtra State Board of Technical Education
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Practical No. 01: Identify internal block and pin configuration of FPGA

Vi

Vil

and CPLD using data sheet.

Practical Significance

A field-programmable gate array (FPGA) is a regular structure of logic cells (or
modules) and interconnect, which is under user’s complete control. This allows the
user to design, program and make changes to their circuit as per the application. CPLD
is “Complex programmable logic devices”, is an integrated circuit that application
designers design to implement digital hardware like mobile phones. This practical will
help the student to identify various blocks and pin configuration of FPGA and CPLD.

Relevant Program Outcomes (POSs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.”

e Identify the various blocks of FPGA and CPLD.

e Understand the architecture of FPGA and CPLD.

e Understand the significance of pins and their use.

Relevant Course Outcome
Develop design flow for the given application using VLSI tools.

Practical Outcome
Identify internal block and pin configuration of FPGA and CPLD using data sheet..

Relevant Affective domain related Outcome(s)
e Follow safety practices.

e Maintain tools and equipment.

e Follow ethical practices.

Minimum Theoretical Background

a) Field-programmable gate array (FPGA): A field-programmable gate array (FPGA)
is an integrated circuit designed to be configured by a customer or a designer after
manufacturing — hence "field-programmable". The FPGA configuration is generally
specified using a hardware description language (HDL), similar to that used for an
application-specific integrated circuit (ASIC) (circuit diagrams were previously used
to specify the configuration, as they were for ASICs, but this is increasingly rare).

Maharashtra State Board of Technical Education 1
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FPGAs contain programmable logic components called "logic blocks", and a hierarchy
of reconfigurable interconnects that allow the blocks to be "wired together" —
somewhat like many logic gates that can be inter-wired in different configurations.
Logic blocks can be conFig.d to perform complex combinational functions, or merely
simple logic gates like AND and XOR. In most FPGAs, the logic blocks also include
memory elements, which may be simple flip-flops or more complete blocks of
memory, ref fig.. no. 1.1.

[Inpuﬂﬂutput Blocks }

L Laogic Blocks J

i

Programmable ]3

—T Interconnect

Fig 1.1 Block diagram of FPGA
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Pin Configuration of FPGA [XC3S400]:
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Table 1.1: Pin functions of XC3S400

Type Description Pin Name(s) in Type

I/O Unrestricted, general-purpose user-1/0 10,
pin. Most pins can be paired together to 10 Lxxy #
form differential 1/Os.

DUAL Dual-purpose  pin  used in some | IO Lxxy #/DIN/DO,
configuration =~ modes during the 10 _Lxxy #/Dl1,
configuration process and then usually 10 _Lxxy #/D2,
available as a user I/O after configuration. 10 _Lxxy #/D3,

If the pin is not used during configuration, 10 _Lxxy #/D4,
this pin behaves as an I/O-type pin. There 10 _Lxxy #/DS5,
are 12 dual-purpose configuration pins on 10 _Lxxy #/D6,
every package. 10 Lxxy #/D7,
10 Lxxy #/CS B,
10 _Lxxy #/RDWR_B,
10 _Lxxy #/BUSY/DOUT,
10 Lxxy #/INIT B

CONFIG Dedicated configuration pin. Not available CCLK, DONE, M2, Ml,
as a user-1/0 pin. Every package has seven MO, PROG B,
dedicated configuration pins. These pins HSWAP_EN
are powered by VCCAUX.

JTAG Dedicated JTAG pin. Not available as a TDI, TMS, TCK, TDO
user-1/O pin. Every package has four
dedicated JTAG pins. These pins are
powered by VCCAUX.

DCI Dual-purpose pin that is either a user-I’/O | IO/VRN_#
pin or used to calibrate output buffer IO L
impedance for a specific bank using XXy
Digital Controlled Impedance (DCI). #/VR
There are two DCI pins per I/O bank. N #

10/V
RP #
10 Lxxy #/VRP #

VREF Dual-purpose pin that is either a user-I/O | IO/VREF #
pin or, along with all other VREF pins in | 10 Lxxy #/VREF #
the same bank, provides a reference voltage
input for certain I/O standards. If used for a
reference voltage within a bank, all VREF
pins within the bank must be connected.

GND Dedicated ground pin. The number of GND | GND
pins depends on the package used. All must
be connected.

VCCAUX Dedicated auxiliary power supply pin. The | VCCAUX
number of VCCAUX pins depends on the
package used. All must be connected to
+2.5V.

VCCINT Dedicated internal core logic power supply | VCCINT

Maharashtra State Board of Technical Education
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Type Description Pin Name(s) in Type
pin. The number of VCCINT pins depends
on the package used. All must be connected
to +1.2V.
VCCO Dedicated I/O bank, output buffer power | VCCO_#
supply pin. Along with other VCCO pins in | TQ144 Package Only:
the same bank, this pin supplies power to | VCCO_LEFT,
the output buffers within the I/O bank and | VCCO_TOP,
sets the input threshold voltage for some | VCCO_RIGHT,
I/O standards. VCCO_BOTTOM
GCLK Dual-purpose pin that is either a user-I/O | 10 Lxxy #GCLKO,
pin or an input to a specific global buffer | 10_Lxxy #/GCLKI,
input. Every package has eight dedicated | I0_Lxxy #/GCLK2,
GCLK pins. 10 Lxxy #/GCLK3,
10 _Lxxy #/GCLKA4,
10 _Lxxy #/GCLKS,
10_Lxxy #/GCLKS®,
10 Lxxy #/GCLK7
N.C. This package pin is not connected in this | N.C.
specific device/package combination but
may be connected in larger devices in the
same package.
FPGA Development board:

P16
Connectors

3N
RS-232%y e

TI LDOs

TI SWIFT

usB

Clock
Socket

Platform

5v 385400 Flash P4 JTAG

SvstemACE
S User 1/O
Header

MODE
Jumpers

PROCGRAM
Button

Pletronics
50 Mz
Clscillator

Fig 1.3 FPGA Development Board

b) Complex Programmable Logic Device (CPLD): A Complex Programmable Logic Device
(CPLD) is a combination of a fully programmable AND/OR array and a bank of macrocells.
The AND/OR array is reprogrammable and can perform a multitude of logic functions.
Macrocells are functional blocks that perform combinatorial or sequential logic, and also have
the added flexibility for true or complement, along with varied feedback paths. Ref fig.. no.
1.4.
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1'0 Block
4 4 A 4
v v v v
Macrocell MMacrocell Macrocell Macrocell
PLA or PAL PLA or PAL PLA or PAL PLA or PAL

T

T

T

T

Programmable Interconnect

l

l

Macrocell Macrocell Macrocell Macrocell
PLA or PAL PLA or PAL PLA or PAL PLA or PAL
4 4 4 4
v v v v
'O Block
Fig 1.4 Block Diagram of CPLD
Pin configuration of CPLD :
Device Typa
Peckage
This line not
Speed ralated lo davice
OCperating Range part numbay

Fig 1.5 Package Pinout Diagram

Table no 1.2: General Pin Functions of CPLD IC

Sr. | Pin Functions
No | name
1 I0 | Each external I/O pin can be used as an input, an output, or a
pins | bidirectional pin according to device programming. The I/O pins at
the bottom are also used for special purposes.
2. | GCK | “Global Clocks” (GCK).Each macro cell can be programmed to

Maharashtra State Board of Technical Education
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use a selected clock input.

3. | GSR | “Global Set/Reset” (GSR).Each macro cell can use this signal as an
asynchronous Preset or Clear.
4. | GTS | “Global Three State Controls”

(GTS).One of the signals can be selected in each macro cell to output
enable the corresponding output driver when the macro cell’s output

is hooked to an external I/O pin.

CPLD Development Board:

Altera Expansion 66 MHZ Current

Profotype Headsr Oscillator ~ USE MAC Sensor e

-
211

ERETENER RN R

i

e

w Fulad

L ]
PR
L
L]
[ |
W
L ]
k]
L]
1
L]
-
[ %
.
L ]
L

eci A/D Comverter  Pojentiomeler
Active O - Quickswitches  PCIEdge Temperature
Test Points Connector  Sensor

Figl.6 CPLD Development Board

VIl Resources Required
Sr. | Instrument/ S _
No | Components Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208),0n board +5V,
FPGA +3.3V, +2.5V supply to FPGA and other hardware circuit.,
1. | Development | On board, 2 Crystal SMHz and 25MHz. JTAG Interface 1 No.
kit (Boundary Scan),PROM Interface (XCF02S),40 pin, 4
header connector for external I/O's
Mabharashtra State Board of Technical Education 7
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Sr. | Instrument/

No | Components Specification Quantity

Desktop PC Loaded with open source IDE, simulation and program

downloading software. 1 No.

Data Sheets of
3. | Xilinx CPLD
and FPGA

IX Precautions to be followed

1. Do not power up the development board when identifying the components on the
board.
2. Refer data sheets for the given development board.

X Resources Used
,i(r)'. Instrument /Components Specification Quantity
1.
2.
3.

XI Precautions Followed (use blank sheet provided if space not sufficient)

X1l Observations (use blank sheet provided if space not sufficient)
Observe the pin out diagram for FPGA and give the functions of following pins:

Sr No Pins Functions
1. JTAG
2. DCI
3. DUAL
4, VCCO
5. GCLK

Maharashtra State Board of Technical Education 8
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X1l  Conclusion and Recommendation

XIV  Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. List the features of FPGA.
2. List the features of CPLD.
3. Compare FPGA and CPLD on the basis of following points:
a. Power consumption.
b. Number of input and output pins.
c. Complexity in board design and layout.
d. Prediction of speed performance of design.

[Space for Answers]

Maharashtra State Board of Technical Education 9
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XV  References / Suggestions for further reading

1
2
3
4

http://www.ti.com/lit/ds/symlink/ads1258-ep.pdf

http://www.datasheetdir.com/ADS1258+24bit-Analog-Digital-Converter

http://www.datasheetdir.com/CPLD

https://www.dataman.com/media/datasheet/ Atmel/ATF1502ASV _doc1615.pdf

XVI Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Identifying the development board 30%
2 | Identifying components on developer kit 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct pin functions 20%
5 | Answer to sample questions. 15%
6 | Timely Submission of report Answer to sample questions. 05%
TOTAL (25 Marks) 100%

Name of student Team Member

Marks Obtained
Process | Product
Related | Related

(15) (10)

(25)

Total | Dated signature of Teacher

Maharashtra State Board of Technical Education
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Practical No. 02: Develop flowchart of CMOS IC fabrication using relevant website.

Vi

Vil

Practical Significance

Complementary metal-oxide—semiconductor (CMOS) is a type of MOSFET (metal—
semiconductor field-effect transistor) semiconductor device fabrication process used
for constructing integrated circuits (ICs). CMOS technology is wused in
microprocessors, microcontrollers, memory chips, and other digital logic circuits.
CMOS technology is also used for several analog circuits such as image sensors
(CMOS sensor), data converters, and highly integrated transceivers for many types of
communication. This practical will help the student to understand the CMOS IC
fabrication process.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication  engineering
knowledge to solve broad-based Electronics and Telecommunications
engineering related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications

technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.”

e Understand the CMOS IC fabrication.

e To develop the flowchart for CMOS fabrication.

Relevant Course Outcome
Interpret CMOS technology circuits with their specifications.

Practical Outcome
Develop flowchart of CMOS IC fabrication using relevant website.

Relevant Affective domain related Outcome(s)
e Follow safety practices.

e Maintain tools and equipment.

e Follow ethical practices.

Minimum Theoretical Background

For less power dissipation requirement CMOS technology is used for implementing

transistors. If we require a faster circuit then transistors are implemented over IC using

BIJT. Fabrication of CMOS transistors as IC’s can be done in three different methods.

e The N-well / P-well technology, where n-type diffusion is done over a p-type
substrate or p-type diffusion is done over n-type substrate respectively.

Maharashtra State Board of Technical Education 12
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e The Twin well technology, where NMOS and PMOS transistor are developed over
the wafer by simultaneous diffusion over an epitaxial growth base, rather than a
substrate.

The silicon On Insulator process, where rather than using silicon as the substrate
an insulator material is used to improve speed and latch-up susceptibility.

MOS Fabrication Steps:
The CMOS fabrication process flow is conducted using following basic fabrication steps
while manufactured using N- well/P-well technology.

Making of CMOS using N well
Step 1: First we choose a substrate as a base for fabrication. For N- well, a P-type silicon
substrate is selected.

Fig 2.1: Selection of Substrate
Step 2 — Oxidation: The selective diffusion of n-type impurities is accomplished using SiO2 as a
barrier which protects portions of the wafer against contamination of the substrate. SiO, is laid out by
oxidation process done exposing the substrate to high-quality oxygen and hydrogen in an oxidation
chamber at approximately 1000°c

Fig 2.2: Oxidation

Step 3 — Growing of Photoresist: At this stage to permit the selective etching, the SiO2 layer is
subjected to the photolithography process. In this process, the wafer is coated with a uniform film of a
photosensitive emulsion.

Fig 2.3: Growing of Photoresist

Step 4 — Masking: This step is the continuation of the photolithography process. In this step, a desired
pattern of openness is made using a stencil. This stencil is used as a mask over the photoresist. The
substrate is now exposed to UV rays the photoresist present under the exposed regions of mask gets
polymerized.

Mabharashtra State Board of Technical Education 13
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G & e bsr > S I Bb S [ U

Fig 2.4: Masking
Step 5 — Removal of Unexposed Photoresist: The mask is removed and the unexposed region of
photoresist is dissolved by developing wafer using a chemical such as Trichloroethylene.

Fig 2.5: Removal of Unexposed Photoresist

Step 6 — Etching: The wafer is immersed in an etching solution of hydrofluoric acid, which removes
the oxide from the areas through which dopants are to be diffused.

Fig 2.6: Etching

Step 7 — Removal of Whole Photoresist Layer: During the etching process, those portions of SiO2
which are protected by the photoresist layer are not affected. The photoresist mask is now stripped off
with a chemical solvent (hot H2SO4).

Fig 2.7: Removal of Photoresist Layer

Step 8 — Formation of N-well: The n-type impurities are diffused into the p-type substrate through the
exposed region thus forming an N- well.

Fig 2.8: Formation of N-Well
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Step 9 — Removal of SiO2: The layer of SiO2 is now removed by using hydrofluoric acid.

Fig 2.9: SiO2 Removal of SiO2

Step 10 — Deposition of Polysilicon: The misalignment of the gate of a CMOS transistor would lead
to the unwanted capacitance which could harm circuit. So to prevent this “Self-aligned gate process” is
preferred where gate regions are formed before the formation of source and drain using ion
implantation.

Fig 2.10: Polysilicon Deposition

Polysilicon is used for formation of the gate because it can withstand the high temperature greater than
8000°c when a wafer is subjected to annealing methods for formation of source and drain. Polysilicon
is deposited by using Chemical Deposition Process over a thin layer of gate oxide. This thin gate
oxide under the Polysilicon layer prevents further doping under the gate region.

Step 11 — Formation of Gate Region: Except the two regions required for formation of the gate
for NMOS and PMOS tran5|stors the remaining portion of Polysﬂlcon is stripped off.

Fig 2.11: Formation of Gate Region

Step 12 — Oxidation Process: An oxidation layer is deposited over the wafer which acts as a shield
for further diffusion and metallization processes.
Ll

Fig 2.12: Oxidation Process
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Step 13 — Masking and Diffusion: For making regions for diffusion of n-type impurities using
masking process small gaps are made.

Fig 2.13.a: Masking and Diffusion

Using diffusion process three n+ regions are developed for the formation of terminals of NMOS.

Fig 2.13.b: Masking and Diffusion

Step 14 — Removal of Oxide: The oxide layer is stripped off.

Fig 2.14: Removal of Oxide

Step 15 — P-type Diffusion: Similar to the n-type diffusion for forming the terminals of PMOS p-type

diffusion are carried out.

Fig 2.15: P-Type Diffusion

Step 16 — Laying of Thick Field oxide: Before forming the metal terminals a thick field oxide is laid
out to form a protective layer for the regions of the wafer where no terminals are required.

Fig 2.16: Laying of Thick Oxide
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Step 17 — Metallization: This step is used for the formation of metal terminals which can provide
interconnections. Aluminum is spread on the whole wafer.

Fig 2.17: Metallization
Step 18 — Removal of Excess Metal: The excess metal is removed from the wafer.

Step 19 — Formation of Terminals: In the gaps formed after removal of excess metal terminals are
formed for the interconnections.

Fig 2.18: Terminal Formation

Step 20 — Assigning the Terminal Names: Names are assigned to the terminals of NMOS and
PMOS transistors.

NAFOS PAIOS

Fig 2.19: Terminal Naming

VIl Observations (use blank sheet provided if space not sufficient)
Draw the flowchart for the CMOS IC fabrication using N well Process.
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IX Conclusion and Recommendation

X Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. List the CMOS applications.
2. Draw the process diagram of CMOS Fabrication using P well process.
3. Draw the flowchart for the CMOS fabrication using Twin tub process.

[Space for Answers]
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Xl References / Suggestions for further reading

1 https://www.elprocus.com/the-fabrication-process-of-cmos-transistor/
2 https://www.slideshare.net/cmos-fabrication
3 https://www.electronics-tutorial.net/CMOS-Processing-Technology/Twin-tub-

Process/

X1l  Assessment Scheme

Total (25 Marks)

Performance indicators Weightage

Process related (15 Marks) 60%

1 | Identifying the fabrication process 30%
2 | Listing the steps in fabrication process. 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%

4 | Correct material selection 20%
5 | Answer to sample questions. 15%
6 | Timely Submission of report Answer to sample questions. 05%
100%

Name of student Team Member

Marks Obtained
Process | Product Total Dated signature of Teacher
Related | Related (25)
(15) (10)
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Vi

Vil

Practical No. 03: Install EDA tool for VLSI application.

Practical Significance

The Electronic Design Automation (EDA) industry develops software to support
engineers in the creation of new integrated-circuit (IC) designs. Due to the high
complexity of modern designs, EDA touches almost every aspect of the IC design
flow, from high-level system design to fabrication. EDA addresses designers’ needs
at multiple levels of electronic system hierarchy, including integrated circuits (ICs),
multi-chip modules (MCMs), and printed circuit boards (PCBs).

Relevant Program Outcomes (POSs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.”

e Install the EDA tool for VLSI applications.

e To use the EDA tool in implementing of various applications.

Relevant Course Outcome
Use relevant VHDL model for given application.

Practical Outcome
Install EDA tool for VLSI application.

Relevant Affective domain related Outcome(s)
e Follow safety practices.

e Maintain tools and equipment.
e Follow ethical practices.

Minimum Theoretical Background

Xilinx  ISE (Integrated Synthesis Environment) is a  software tool produced
by Xilinx for synthesis and analysis of HDL designs, enabling the developer
to synthesize ("compile") their designs, perform timing analysis,
examine RTL diagrams, simulate a design's reaction to different stimuli, and config.
the target device with the programmer.

Xilinx ISE is a design environment for FPGA products from Xilinx, and is tightly-
coupled to the architecture of such chips, and cannot be used with FPGA products
from other vendors. The Xilinx ISE is primarily used for circuit synthesis and design,
while ISIM or the Model Sim logic simulator is used for system-level testing. Other
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components shipped with the Xilinx ISE include the Embedded Development Kit

(EDK), a Software Development Kit (SDK) and Chip Scope Pro.

VIl Resources Required:

sy Instrument /

No' Components Specification Quantity
' EDA tool

1. Desktop PC Preferably OS: Windows 7 01

2. EDA tool Xilinx ver. 14.7 01

IX  Precautions to be followed:
Follow steps in sequence to execute programs properly.

X Procedure:

Steps for installing Xilinx Software (EDA Tool)
1. Click on the setup file to install Xilinx software.

ISE 14.7 Installer

-= Welcome
Accept License Agreements
Select Products to Install
Select Installation Options
Select Destination Directory

Installation

Copyright (<) 1995-2013 Xiin, Inc, All rights
reserved,

XILINX, the Xilinx logo and other designated
brands inchided herein are rademarks of Xilins,
Inc. All other trademarks are the property of
their respedtive owners,

Welcome

We are glad you've chosen Xilinx as your platform development partner. This program will install ISE

design environment, Software development kit or Lab tools.

You will need to have administrator privileges in order to install this software on Windows operating

systems.

For the product you select to install, we recommend that you identify a directory that does not

contain an older installation of the same product version.

Mote - To reduce installation time, we recornmend that you disable any anti-virus software before

continuing.

Next > I Cancel

Fig 3.1: Xilinx Installer Welcome Screen.

Maharashtra State Board of Technical Education

22




Very Large Scale Integration with VHDL (22062)

2. Click next on the Xilinx Agreement window.

Accept License Agreements (1 of 2)

Please read the following terms and conditions and click the checkbox below it to indicate that you
accept and agree.

HILINX, INC. ﬂ

EMND USER LICEMSE AGREEMEMNT

CAREFULLY READ THIS EMD USER LICENSE AGREEMENT CAGREEMEMNT™). BY CLICKING THE
"ACCEPT  OR "AGREE™ BUTTOM, OR OTHERWISE ACCESSING, DOWMNLOADING, INSTALLING OR
USING THE SOFTWARE, YOU AGREE ON BEHALF OF LICENSEE TO BE BOUND BY THIS
AGREEMENT.

IF LICEMSEE DOES MOTAGREE TOALL OF THE TERMS AND COMDITIONS OF THIS AGREEMENT,
DO MOT CLICK THE "ACCEPT OR "AGREE™ BUTTOMN OR ACCESS, DOWNLOAD, INSTALL OR USE
THE SOFTWARE; AMD IF LICEMNSEE HAS ALREADY OBTAINED THE SOFTWARE FROM AN
AUTHORIZED S0URCE, PROMPTLY RETURM IT FOR A REFUND.

ISE 14.7 Installer

Welcome
-> Accept License Agreements
Select Products to Install 1. Definitions
Select Installation Options
Select Destination Directory “Authorization Codes™ means any FLEXIm license key, license file, license manager, dongle or other
Installation key, code or information issued by (or on behalf of) Xilinx that is necessary to download, install, operate
andior regulate User access to the applicable Software.

¥ Iaccept and agree to the terms and conditions above

¥ Ialso accept and agree to the following terms and conditions

. . I also confirm that I have read Section 13 of the terms and conditions above concerning WebTalk and have been afforded
G°D\"":d"“ (=) 1555-2013 Xilirs, Inc. All rights e opportunity to read the WebTalk FAQ posted at http:/fwww. xilinx. comfisefwebtalk/. I understand that I am able to
reserved, " - P P - . "

YILINKG the Xiin logo and desig " disable WebTalk later if certain criteria described in Section 13(c) apply. If they don't apply, I can disable WebTalk by

brands inchided hersin are trademarks of Xilino uninstalling the Software or using the Software on a machine not connected to the internet. IfI fail to satisfy the

Inc. All other trademarks are the of applicable criteria or i i e applicable steps to prevent su ansmission of information, I agree to allow Xilinx
proparty pplicable criteri if I fail to take the applicable steps to t such tr. ission of information, T to allow ¥ili

their respective owners, to collect the information described in Section 13{a) for the purposes described in Section 13{b).

< Back | Mext = I Cancel

Fig 3.2 a: Xilinx License Agreement window

Accept License Agreements (2 of 2)

’ | S E Please read the following terms and conditions and click the checkbox below it to indicate that you
DESIGN SUITE

accept and agree.

CAREFULLY READ THIS COLLECTION OF INFORMATIOMN AND LICENSE AGREEMENTS. BY -
CLICKIMNG THE "ACCEPT” OR "AGREE™ BUTTON, OR OTHERWISE ACCESSING, DOWNLOADING,
INSTALLING OR USING THE SOFTWARE, YOU AGREE ON BEHALF OF LICENSEE TO BE BOUND BY
THIS INFORMATION AMD LICEMSE AGREEMENTS (TO THE EXTENT APPLICABLE TO THE SPECIFIC
SOFTWARE YOU OBTAIN AMD THE SPECIFIC MANMNER IN WHICH YOU USE SUCH SOFTWARE).

IF LICEMSEE DOES NOTAGREE TOALL OF THE INFORMATION AND LICENSE AGREEMENTS
BELOW, DO NOT CLICK THE "ACCEPT" OR "AGREE" BUTTON OR ACCESS, DOWNLOAD, INSTALL
OR USE THE SOFTWARE; AMD IF LICEMNSEE HAS ALREADY OBTAINED THE SOFTWARE FROM AN

ISE 14.7 Installer
AUTHORIZED SOURCE, PROMPTLY RETURM IT FOR A REFIUND.

Welcome ] )
-» Accept License Agreements Part One: Overview.

Selace pmd"ms_m ["s'_a“ The following information applies to certain items of third-party technology that are included along with
Select Installation Options certain Xilinx software tools.

Select Destination Directory

Installation The Xilinx Embedded Development Kit (EDK) is a suite of software and other technology that enables

Licensee to design a complete embedded processor system for use in a Xilinx Device. EDK includes,
among other components, (a) the Xilinx Platform Studio (XPS), which is the development environment,
or GUI, used for designing the hardware portion of an embedded processor system; and (b) the Xilinx
Software Development Kit (SDK), which is an integrated development environment, complementary to
XPS, thatis used to create and verify C/C++ embedded software applications. SDK is also made
available separately from EDK.

zgu;adg'ft (2] 19852013 Xl Inc, All rights Licensee's use of the GNU compilers {including associated libraries and utilities) that are supplied
KILINX, the ¥ilinx logo and other designat=d | With SDK may cause Licensee’s software application (or board-support package) to be governed by LI
brands inchided herein are tademarks of Xilin, s - - —— e e - -

Inc. All other trademarks are the mroperty of
their respective owners.

¥ Iaccept and agree to the terms and conditions above

< Back | Mext > I Cancel |

Fig 3.2b: Xilinx License Agreement window
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3. Select the products to install.

Select Products to Install
= Edition List
7 I5E WebPACK
DESIGN SUITE " ISE Design Suite Logic Edition
" ISE Design Suite Embedded Edition

" |SE Design Suite DSP Edition

" Lab Tools - Standalone Installation

ISE 14.7 Installer

Welcome Disk Space Required : 20439 MB

Accept License Agreements

-=> Select Products to Install
Select Installation Options — Description of ISE Design Suite System Edition
Select inatii i v
Installation This installation contains everything you need to do a complete system design. It includes ISE

Design Suite Logic Edition, the Embedded Development Kit (EDK) and System Generator for DSE

Copyright () 19952013 il Inc, All rights
ed,

resarved,
XILINX, the Xilinx logo and other designated
brands inchided herein are wademarks of Xilin,
Inc, All other trademarks are the property of
their respective cwners,

Fig3: Select products to install.

4. Select the Installations options.

Select Installation Options

Select the desired installation options below. Selection of these options may result in additional
programs being run at the conclusion of the installation process.

. i} ¥ Use multiple CPU cores for faster installation
DESIGN SUITE

Enabling this option will speed up installation but may slow down other active applications.

Install WinPCap for Ethernet Hardware Co-simulation
Install Cable Drivers
Enable WebTalk to send software, IP and device usage statistics to Xilinx (always enabled for we

ISE 14.7 Installer

Welcome
Accept License Agreements 1 | i3
Select Products to Install

-» Select Installation Options Select/Deselect All |

loct Destination Di
Select nation Di i — Description of Acquire or Manage a License Key

Installation

Most Xilinx applications now require a license key file in order to run. If this selection is enabled,
the Xilinx License Configuration Manager will be opened in order to assist you either in acquiring
a new license file or in managing an existing license file. If this is your first time using Xilinx ISE
Design Suite 14.7, it is highly recommended that you use this application to acquire or install
your license file.

Copyright (<) 1995-2013 Xiins, Inc. All rights
reserved,
¥ILIMX, the Xiinx logo and other designated
brands included herein are trademarks of Xilin,
Inc, All other trademarks are the property of
their respective owners,

< Back | Mext = I Cancel

Fig 3.4: Installations options
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5. Select the destination path.

® ' Select Destination Directory
\ | S E Select the directory where you want the software installed.
DESIGN SUITE |E! Browse
Install location(s) @
E:14.7\ISE_DS
Disk Space Required : 20439 MB
Disk Space Available : 187132 MB
TISE 14.7 Installer
Welcome
Accept License Agreements
Select Products to Install
Select Installation Options ¥ Create Start Menu and Desktop Icons
> Select Destination Directory Select a Program Folder
Installation
This name will appear in the Start Menu > Programs list.
|X|I|nx Design Tools j
¥ Tool preferences and file association
Impert tool preferences from previous version and change project file assodation to ISE Design Suite System Edition 14,7
Copyright (c) 1555-2013 Xl Inc, All rights
reserved.
XILINX, the Xilinx logo and other designated
brands inchided harsin are tademarks of Xilin,
Inc. All other ademarks are the property of
their respective owners,
< Back | MNext > I Cancel

Fig 3.5: Select Destination path

6. Click Install on the Installation Summary window to start the installation.

Installation

G)]
CISE == .

E:14 AISE_DS

Edition - ISE Design Suite System Edition
Program Group: Xilinx Design Tools
Option: Acguire or Manage a License Key

SIGN SUITE

ISE DS Common

Install Location: E: 14 75SE_DS“common

Module: ISE DS Common

Option: Script to install VC++ runtime libraries for 32-bit 0S

1SE 14.7 Installer Option: Script to install VC=+ runtime libraries for 64-bit OS5
Welcome EDK
Accept License Agreements Install Location: E:14. 7\SE_DS\EDK

Module: EDK

Select Prod tol & Option: MB Linux Toolchain postinstall

Select Installation Options
Select Destination Directory PlanAhead Analysis Tool
-» Installation Install Location: E:14. 7WSE_DSYPlanAhead
Module: PlanAhead Common Files
Option: setupEnv bat

ISE

Install Location: E:14.7\SE_DSMSE
Medule: Design Environment Tools
Module: WebPACK Devices

N N Module: Edition Devices
Co vedg'Tt () 19952013 i, Inc. All rights Option: Install WinPCap for Ethemet Hardware Co-simulation

¥ILINX, the Xiinx logo and other designated Option: Install Windows System Generator Info XML
brands incheded hersin are trademarks of Xiling, | Option: Install MSWC 2005 Redistributable Files
Inc. All other wademarks are the property of | Option: Install Cable Drivers LI

their respective owners, Ointinn: Carfimre WeahTalle
< Back | Install I Cancel |
Fig 3.6: Installation Summary options.
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7. Installation of the software continues.

@ ISE

' Extracting: ise_0002.zip.xz, dsp_tools_0001.zip.xz, ise_0008.zip.xz, ise_...
\ | S E 40%
DESIGN SUITE

ISE 14.7 Installer

Welcome Zynq' - 7000 All Programmable SoC, Enabling New
Accept License Agreaments Product Innovations Across Markets

Select Products to Install
Select Installation Options
Select Destination Directory >

Xilinx All Programmable SoCs are processor-centric platforms that
-> Installation .

or and industry-leading programmab
g systems with fewer

Copyright (<) 1595-2013 i, Inc. All rights www.xilinx.com/Zynqg xl LI NX
reserved,

HILINY, the Milins logo snd other designsted ol
brands inchuded harein sre trademarks of Xilin,
Inc, All other trademarks are the property of
their respective owners,

RAMMABLE.

< Back Install | Cancel I

Fig 3.7: Installation Window

8. Click Finish on the Install Complete window.

©®

Install Completed

’ Congratulations! You have successfully installed Xilinx ISE Design Suite Systemn Edition.
\ The environment variables are written to the settings[32|64].bat file at "E:14.7USE_DS™. In order to setthe
DESIGN SUITE

variables in your environment, you must run the settings[32|64].bat file.

ISE 14.7 Installer

Welcome

Accept License Agreements
Select Products to Install
Select Installation Options
Select Destination Directory

-» Installation

Copyright (<) 1955-2013 Xilinx, Inc. All rights
reserved,

XILINX, the Xilinx logo =nd other designated
brands inchuded herein are wademarks of Xilino,
Inc, All other trademarks are the property of
their respective owners,

Fig 3.8: Install complete window
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9. Click Next on the License Configuration window.

Acquire a License | Manage Licenses | Borrow/Restore Licenses | Return Licenses | Internet Settings |

~Select one of the following opi

" Start Now! - 30 Day Trial (No Fitstream)
" GetFree Vivado/ISE WebPack License
" Start 30 Day Evaluation

' Get My Purchased License(s)

" Locate Existing License(s)

~Description of the above selected aptic

Getall purchased licenses and start using your Xiinx software, You wil be taken to the Xiinx website where you can generate a license for all Xiinx software and IP you have purchased, Once your license file is generated, the Manage Xiinx Licenses™ tab will open to
enable you to configure your system to use the license,

About... Close

Fig 3.9: License Configuration Window

10. After the license is accepted the Xilinx Project navigator icon is created on
Desktop. Click on the icon to run the Xilinx EDA Tool.

!lif‘
N 2

Project Navigator

Rirkeads erae 14,7
dpplEin bprmon B B0813

Coprghs i SVM-2000 ke, I
B ot el

g RTX, A £ XILINX

Fig 3.10: Xilinx Initialize Window
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Xl Resources Used:

Sr Instrument

No. /Components/ Specification Quantity
' EDA tool

1

X1l Precautions Followed (use blank sheet provided if space not sufficient)

X111 Actual Procedure followed:

XV  Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. List features of Xilinx software.
2. Define the terms simulation, synthesis..

[Space for Answers]
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XVI References / Suggestions for further reading
1 https://en.wikipedia.org/wiki/Xilinx ISE
2 https://www xilinx.com/support/documentation/sw_manuals/xilinx10/isehelp/ise c

_overview.htm

3 https://www.xilinx.com/html_docs/xilinx2019 _1/sdsoc_doc/introduction-

mwq1504034373484.html

4 http://allpcworld.com/xilinx-ise-design-suite-14-7-free-download/

XVII Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Identifying the given IDE 30%
2 | Identifying the features of IDE 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct procedure followed 20%
5 | Answer to sample questions. 15%
6 | Timely Submission of report Answer to sample questions. 05%
Total (25 Marks) 100%
Name of student Team Member
2
T
A
Marks Obtained
Process | Product Dated signature of Teacher
Total
Related | Related (25)
(15) (10)
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Practical No. 04: Implement any two logic gates using Data flow and

Vi

Vil

Behavior Model.

Practical Significance

VHDL stands for very high-speed integrated circuit hardware description language
which is one of the programming language used to model/ describe the hardware of a
digital system by dataflow, behavioral and structural style of modeling. This practical
will help the students to model the logic gates using different modelling techniques.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.”

e Use relevant VHDL model for the given applications.

e Debug VHDL programme for the given application.

Relevant Course Outcome
Debug VHDL programme for the given application..

Practical Outcome
Implement any two logic gates using Data flow and Behavior Model.

Relevant Affective domain related Outcome(s)
e Follow safety practices.

e Maintain tools and equipment.
e Follow ethical practices.

Minimum Theoretical Background

VHDL is used for describing hardware. There are four styles of modelling/ description

using VHDL.

e Dataflow Description: A data flow description describes the transfer of data from
input to output and between signals. The view of data as flowing through a design,
from input to output. An operation is defined in terms of collection of data
transformations, expressed as concurrent statements.

e Behavioral Description: A Behavioral modelling describes the design in terms of
circuit or system behavior using algorithms. This high level language uses
language constructs that resemble a high level software programming language.
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e Structural Description: A structural description describes the circuit structure in
terms of the logic gates used and the interconnect wiring between the logic gates to
form a circuit netlist. This view is expressed by component instantiations.

e Mixed Style of Modelling: Mixed style of modelling is combination of different
modelling styles to describe an entire hardware.

VHDL Flow Elements: The VHDL provides five different types of primary
constructs called design units:

e Entity

e Architecture

e Configuration
e Package

e Package body

Entity declaration: It defines the names, input output signals and modes of a

hardware module.
Syntax:
entity entity name is

Port declaration,;
end entity name;

An entity declaration should starts with ‘entity’ and ends with ‘end’ keywords.
Ports are interfaces through which an entity can communicate with its environment. Each
port must have a name, direction and a type. An entity may have no port declaration also.
The direction will be input, output or inout.

In Port can be read

Out Port can be written

Inout Port can be read and written

Buffer Port can be read and written, it can have only one source.

Architecture: It describes the internal description of design or it tells what is there inside
design. Each entity has at least one architecture and an entity can have many architecture.
Architecture can be described using structural, dataflow, behavioral or mixed style.
Architecture can be used to describe a design at different levels of abstraction like gate
level, register transfer level (RTL) or behavior level.

Syntax:
architecture architecture name of entity name

architecture declarative part;
begin

Statements;
end architecture name;

Here we should specify the entity name for which we are writing the architecture body.

The architecture statements should be inside the begin and end keyword.

Architecture declarative part may contain variables, constants, or component declaration.
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Logic Gate symbols and truth table:

Logic Logic Truth Boolean

functiorn symbol table expression
A bl
Buffer s —I>— s O [=) w = A
1 1
Inverter A e B 2 o
NOT gate) hd [s] 1 - = B
1 (=]
A B h
P lu] (] (o]
Z-input A
~ o 1 (=] o= Ae B
AND gate B D i o | o
1 1 1
A B o
Z2-input - (=] o -1
MNAND A (o} 1 | o= Ae B
gate B 1 (=] 1
i1 o
Fay B h
(o] o o
Z-input i o 1 b Y =A+B
OR gate - b 1 o 1
1 A -1
A [=] N
i o o 1
Z-input A
[} “ (o] o= A+ B
NOR gate = D— ¥ g o
A 1 (o]
A [=] ¥
2-i t Eas = e
—inpu 1 1 W= B B
e 29y >~ | 3 I]3 -
gate 11 o
s B il
2-input A o (=] 1
EX-NOR ~ o 1 Ln ] w = A0 B
gate e 1 O o
1 A L

Fig 4.1: Logic Gates Symbols, Truth Table, Boolean Equation

VIl Resources Required:

Sr. Instrument / P :
No. Components Specification Quantity
1 Desktop PC Loaded with open source EDA tool (VHDL) 1 No.

IX Precautions to be followed:
Check the syntax / rules of VHDL Programming.

X Procedure:
1. Create the Xilinx ISE project for your top-level FPGA design, by doing the
following in ISE:
In the ISE software, select File > New Project.(refer fig. 4.2)
In the Project name and Project location fields, enter the project name and location,
respectively. (refer fig. 4.2)
Select HDL or Schematic as the Top-level source type, and click Next. (fig. 4.5)
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RIS P e oS RBBOIBT013) - D\or\orise - (Design Summanl I e ] eS| %)

£ File Edit View Project Source Process Tool indow Layout Help [=[=]x]
DEF I L X DEX|w o : H H :
[Design coex =
5] | view: © 48} 1mplementation @ & Simuiation 5 Errors: o Errors
ehavioral =
&[5 3 New
[g2] | Hierarchy 5] E—
| e I3 Create New Project
Warnings:
o £ xa3s400-4pqg208
é — Specify praject location and type. Routing Results:
—1 38 Enter a name, locations, and comment for the project Timing Constraints:
= Final Timing Score:
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Working Directory: |Br\and =] =
rs Warnings Infos
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=] ¥ Update All Schematic Files
?t €)  Compile HDL Simulation Libr.
— . Regenerate All Cores
o Check All Core Versions
Select the type of top-level source for the prasect
Topevel source type: I =]
[HoL [=] | P—— 1=
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Console o8 %
% INFO: EDLCompiler:1061 — Parsing VADL ile a
i) INFO:ProjectMomt - Parsing design hierarch
Launching Design Summary/Report Viewer... — — m
« (i »
Console Errors | 1\ Warmings | (66 Find in Files Resuits

Fig 4.2: Create new project

o 1SE Project Navigstor PBBIZ1013) - Diertorse - DesignSummand h LW T )
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e © - E =
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Behavioral -] @ @ New Project Wizard
— - ion State: new
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8 or (%] Project Settings
‘Warnings:
@ £ xa3sd00-4pqg208
@ Specify device and project properties. Routing Results:
om | BE Select the device and design flow for the project
B8 Timing C i
H Property Name Value nd Final Timing Score:
— Evalustion Development Board None Specified -
Product Cateqory All - =
Family Automotive Spartan3 = IS
Device XA35400 - rs Warnings Infos
: €2 Mo Processes Running Package PQG208 -
11| No single design module is selected. Speed -4 L4
S| 53  Design Utilities E
B2 Update All Schemnatic Files Top-Level Source Type HDL -
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e e var Simulator 1Sim (VHDL/Verilog) -
Preferred Lanquage Verilog -
Property Specification in Project File |Store all values - I
Manual Compile Order
VHDL Source Analysis Standard |vHDL-93 =] I -
|~
= Start | B3 Design |7 Fies [ tbrares|| & Enahls 1 Eitt. =1 S
Console <08 X
i) INFO:EDLCompiler:1061 - Parsing VHDL file 2
INFO:ProjectMgmt — Parsing design hierarch:
Launching Design Summary/Report Viewer... — D
i 3

4 o
Console | @ Emors | 1\ warnings | 128 Find in Fles Results

Fig 4.3: Project File Settings
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I 5 v BB 5\ o - A A e

X File Edit View Project Source Process Tools Window Layout Help EEE

FEEE IR IR = AL , :
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— Project Name: and -
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Top Level Source Type: HDL
| B2 Mo Processes Running . Device:
— - - - Detail Device Family: Automotive Spartan3
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e % Design Utilities e Package: pgg208
— | ¥)  Update All Schematic Files Design Pi Spesd: 4
) ¥)  Compile HDL Simulation Libr... [ E
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o Simulator: ISim (VHDL/Verileg) LA
5 Preferred Language: Verilog
Property Specification in Project File: Store all values
Manual Compile Order: false
VHDL Scurce Analysis Standard: VHDL-83 rm—— 2
[ sart[mg peson [ Fies | ) brares] & |
Eiltawinme Aisamlan

Console 08 X

i) THFO:HDLCompiler:1061 — Parsing VHDL file

I INFO:ProjectlMgmt - Parsing design hierarchyl
Launching Design Summary/Report Viewer. .. m

Ll . »
Console ro Erors | 1\ Wamings | (36 Findin Fies Resuts

Fig 4.4: Project Summary

2. Create New Source file. Select Source Type” select the Source type and give the name to
the source then click “Next”. .(refer fig.. 4.5)

oF Drojgetia

File Edit View Project Source Process Took Window Layout Help

DPEF L i¥abEx|val iR AR

b 15 Prfect Novioator JBBRIBA01S) Danlordse . WS e o e S W W)

|Desion ~08x

i |Vew: @ {8} mplementation ©) [ simulation

(5] | Hierarchy o

] and |

2 5 £ xa3sd00-4pqg208 E

o

i Empty View

Select Source Type

% The view currently containe no fles. Ma

::\:;Q:fn?g:sr :’i‘;ﬁ:’:xn ds Select source type, file name and its location,

P from the Project menu, and by ?{ 1P (CORE Generator & Architecture Wizard)

— using the Design, Fies, and

Libraries panels. User Document
m Bl
L Verilog Module
Use: ] Verilog Test Fixture

| B2 Mo Pracesses Running [y VHDL Module " .
= VHDL Library File name:
£ | No single design medule is selected. [¥] VHDL Package and|

P @ % Design Utilties iy VHDL Test Bench Loation:
) g% Embedded Processor 3
5’: ‘ D:\and ipcore _dir

m

Add to project

| strt| e pesgn |13 Fies [ ibreres|

Consale

oooom ] 3
console | @ Evors | 1) Wamings | (g Find n Files Resuts

Fig 4.5: Selecting Source Type
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3. Define Module: Enter the entity used in design and then click “Next”. (refer fig.. 4.6 and
4.7)

ISE Project Navig
File Edit View Project Source Process Tools Window Layout Help

DAEFP| L DD X9
| Design
] | View: @ {8} Implementation )
(3] | Hierarchy
and
| & 3 xa3s400-4pgg208
o
&3 Empty View
& Define Module
=l The view currently contains no files.
. You can add files to the project
using the toolbar atleft, commands Specify ports for modue.
) from the Project menu, and by Entity name | and
— using the Design, Fies, and
= Lbraries panes, architecture name | Behavioral

Lse: Port Name Direction

]

P2 Mo Processes Running

N single design module is selected.
¥ Design Utilities

o ER|v
ojoE|@

sl

| stert | =3 pesign [ Fies | Y thraries

Console

« i b
|8 console ]_6 Errors | 1\ Wernings | 1g§ Find in Fies Resuts

Fig 4.6: Define Entity

File Edit View Project Source Process Teols Window Layout Help

DAEHP X DD X0
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(E Hierarchy o

& and ]

— | & £ xa3s400-4pgg208 3

o

il Empty View

& Summary

- The view currently contains no files.

::::‘gm;‘:f:‘ige:’ :ﬁ&wu?:nc\tands Project Navigator will create a new skeleton source with the following specifications.
[@ from the Project menu, and by Add to Project: Yes

— using the Design, Files, and Source Directory; D:land
m Libraries panels. Source Type: YHDL Module

Source Name: and,vhd
Use: 2
Entity name: and

7 | B2 MNoProcesses Running Architecture name: Behaviorsl
P Port Definitions:

4| Mo single design module is selected. a

G| & Design Utilities b

) ¥

u

| start | B3 Design | L1 Fies | O Lhraries

Console

L) v
[l console | @ Erors [ 1) Warings | 6 FindinFies Resuts

Fig4.7 Entity Summary
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4. Develop VHDL code for given problem and Synthesize the .vhd file and view RTL
schematic. (refer fig.. 4.8 and 4.9)

L ISE Project Navigator (P20I31013) _ Di\and\andadse [andhd’l . M o o . TR e et e

File Edit View Project Source Process Tools Window Layout Help [BEE
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(| - and - 22
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£l 29 --library UNISIM:
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: - 36 end andl: L
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ks Design Utlities 38 architecture Behavioral of andl i3
H|e User Constraints e
- Synthesize - XST ..

d Implement Design -
: Generate Programming File 42 y<= a and bs
Configure Target Device el Benavioral:
Analyze Design Using ChipScope e
45 -
« il v
& Start | 53 Design U Fies [ [ Ubraries| | 2 and.vhd* aJE Design Summary <]
Console 08 x
Started : "Launching ISE Text Editor to edit and.vhd".
Launching Design Summary/Report Viewer... m
i v

a
Console | @ Ervars | 1\ Wamings | @ Find in Files Results

Ln38 Col32 VHDL

Fig 4.8: VHDL Coding

File Edit View Project Source Process Toals Window Layout Help [REE
BT R TR Y I EEL E P T
|Design “08x | 15 — A
View: @ 18} mplementation () & Smuation 18
- —| 20 library IEEE;
il erarchy 21 use IEEE.STD_LOGIC 1164.ALL:
| -G and o | 22
—|& £ xa35400-8pqg208 23 -- Uncomment the following library declaration if using
it [ty and1 - Behavioral (andivhd) 24 -- arithmetic functions with Signed or Unsigned values
= 25 --use IEEE.NUMERIC_STD.ALL;
4 26 B
27 -- Uncomment the following library declaration if instantiating
28 -- any Xilinx primitives in this code.
E 29 --library UNISIM; M
:J 30 --use UNISIM.VComponents.all;

32 entity andl is
33 Pozt { a : im STD LOGIC;

@O & & & |15

» | B0 Mo Processes Running 7 b : in STD LOGIC:
74 | Processes: andl - Behavioral 2o ¥ : out STD_LOGIC):

f . 36 end andl; L
gf| - & Design Summary/Reports o =
a Design umm.ﬂ 38 architecture Behavioral of andl is
% User Constraints
il 39
m 40 begin
@ 82 Implement Design "

) Generate Programming File
Configure Target Device

~@*  Analyze Design Using ChipScope

42 y<= a and b;
43 end Behavioral;

‘, Start | E§ Design |® Files |® Libraries and.vhd 8 ‘ b Design Summary DI

Console 08 x

Process "Synthesize - XST" completed successfully =

il 3

‘
Console ro Brors | 1\ Wamings | g FindinFles Resuits

Ln38 Col32 VHDL

Fig 4.9: Synthesize the .vhd file

5. Create Test Bench file- A test benchis HDL code that allows you to provide a
documented, repeatable set of stimuli that is portable across different simulators. A test
bench can be as simple as a file with clock and input data or a more complicated file that
includes error checking, file input and output, and conditional testing.

6. Go to implementation to simulation tab, right click on main source file and create Test
Bench file for simulation extend with abc_tb. (refer fig..4.10-12)
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Project Source Process Tools Window Layout Help [NEE
$Rbxval AR AR mEDCseirPlQ
[Design 08 & 18 -- o
& Implementation @ & Smulation 19
Behavioral = 20 library IEEE;

& 21 use IEEE.STD LOGIC_1164.ALL:
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£l 29 --library UNISIM:
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Ln33 Col32 VHDL

Fig 4.10 Select Simulation tab to create test bench file
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& 21 use IEEE.STD LOGIC_11&4.ALL:
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= 25 --use IEEE.NUMERIC_STD.ALL:
% 26
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37
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€A Design Properties... 45 -
[4] Seurce Properties. o, >
- stert | g e U, i and.vhd <13 Design Summary (Synthesized) o]
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Add a new source to the project Ln38 Col32 VHDL

Fig 4.11 (a): Creating test bench file
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A
P A
E %
%
£ No Processes Runring )

Processes: andl - Behavioral
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Fig 4.11(b): Creating test bench
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Fig 4.11(c): Creating test bench
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[B) File Edit View Project Source Process Window Layout  Help
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B | @@ 15im Simulator E
£
o

3

| stert | &% pesign | Fies [ I Liraries @

Console
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Fig 4.12 Cre

ated Test Bench
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Hierarchy S 56 signal y : std_logic:
- & and N = —— No clocks detected in port list. Replace <clocky below with
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QT and_tb - behavior (and_tb.vhd) 1 59
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BEGIN
% 62
] 6
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* 65 uut: andl PORT MAP (
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E’t ? Design Utlties 71 -- Clock process definitions
% 72 --<clock> process :process
- 73 --begin
m T4 -—<clock> <= '0';
75 --wait for <clock>_period/2;
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73 -
4 m 5
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-

.

]
Cansole ]-5 Brors | 1\ Wanings | @ Findin Fles Results

Fig 4.13: Disable clock parameters [as per .vhd file]

Ln95 Col12 VHDL
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File Edit View Project Source Process Tools Window Layout Help [-]=]
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‘ [ »

Consale Errors | 1\ Warnings | /@8 Findin Fies Results

Ln85Col12 VHDL

Fig 4.14: Initialize Input values

7. In order to view test files, select the box of “Simulation” in the “View Panel” of the
“Design” panel. In the “Process Panel,” double click on the “Behavioral Check Syntax” to
make sure that you didn’t make any syntax errors while making changes.

(refer fig.. 4.15)

[ ISE Project Navigato
[S File Edit View Project Source Process Tools Window Layout Help BE
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EIESE A
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Console |ﬁ Erors | 1\ Warnings | 8 Find in Files Results

Ln95 Col12 VHDL

Fig 4.15: Behavioral Check Syntax
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8. Double click on “Simulate Behavioral Model” in the “Process Pane”, which will open the
ISim software with your test bench loaded. (refer fig.. 4.16)

[ ISE Project Navigator (B20131013) - Diand\andaise - [and_towhd] | - B o o e
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! 2 L -1
- 100
101 wait; E
102 end process;
103
104 END;
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Parsing VEDL file "D:/and/and_tb.vhd" into library isif Cemp a

Process "Behavioral Check Syntax" completed successfully

a i
5] console | @ Emors |t Warnings | @ Findin Files Results

Ln95Col12 VHDL

Fig 4.16: Simulation Check window

9. ISim simulator window will open with your simulation executed, as shown in Fig. 4.17
where one can simulate designs and check errors if any.
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Instance and Process Name

& and.th || Object Name Value
J std_logic_1164 st| ] 1
B b 1
oy 1
« i v 4 4 ~
£ Instanc... Memory | |Z] Source .| | « n = Default.wcfg [x]
Console c0O& X
WARNING: A WEBPACK icense was found. -

WARNING: Please use Yilinx License Configuration Manager to check out a full ISim license.

WARNING: ISim will run in Lite mode. Please refer to the ISim documentation for more information on the differences between the Lite and the Full version.
This is a Lite version of ISim.

Time resolution s 1ps

Simulator is doing circuit initialization process,

Finished circuit initialization process.

T5im> -

@ Console |[] Complationlog | @ Breskpoints | i Find in Files Results | [gg Search Resuits

m

Sim Time: 1,000,000 ps

Fig 4.17: Simulation Output
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Sample Program: Implement AND gate using Data flow and Behavior Model.

Data Flow Model:

VHDL Code

library IEEE;

use [IEEE.STD LOGIC 1164.ALL;

use [EEE.STD LOGIC ARITH.ALL;

use [EEE.STD_LOGIC UNSIGNED.ALL;

Entity AND-GATE is

Port (A,B:in STD LOGIC;
P:out STD LOGIC);

end AND-GATE;

Architecture dataflow of AND GATE is
begin

P <= A and B;

end dataflow;

Behavior Model:

VHDL Code

library IEEE;

use [IEEE.STD LOGIC 1164.ALL;

use [EEE.STD_LOGIC ARITH.ALL;

use [EEE.STD LOGIC UNSIGNED.ALL

Entity AND is
port(
A,B: in std_logic;
C: out std_logic
);
end AND;

Architecture arch of AND is
begin
process(a, b)
begin
if a='1" and b='1" then
c<="1%
else
c<='0
end if;
end process;
end arch;
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Program Statement for Student: Implement OR Gate using Data flow and Behavior Model.
Data Flow Model:

VHDL Code

Behavior Model:
VHDL Code
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Xl Resources Used:

Sr.
No.
1.

Instrument /Components Specification Quantity

2.

3.

XII.  Actual Procedure Followed (use blank sheet provided if space not sufficient)

X1l  Precautions followed:

XIV  Observations (use blank sheet provided if space not sufficient)
Observations for Problem Statement given to Student.

A | B Y=A+B

0 0
0 1
1 0
1 1

XV  Results (output of Program)
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XVI Interpretation of result

XVII Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)

XVII1I Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. Explain the term model. List different types of Model.

Compare different types of model.

Give the syntax of Entity and Architecture with example.

Implement NAND gate using Behavioral Model.

Explain the Process statement with an example.

bl o

[Space for Answers]
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XIX References / Suggestions for further reading
1 https://startingelectronics.org/software/VHDL-CPLD-course/tut2-AND-and-OR-

gates/
2 https://buzztech.in/vhdl-modelling-styles-behavioral-dataflow-structural/
3 https://www.tutorialspoint.com/vlsi_design/vlsi_design vhdl introduction.htm

XX  Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
. o 30%
1 | Coding ability
2 | Debugging ability 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA Board 20%
5 | Answer to sample questions. 15%
6 | Timely Submission of report Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained

Dated signature of
Process Product Total Teacher
Related (15) | Related (10) (25)

Maharashtra State Board of Technical Education



Very Large Scale Integration with VHDL (22062)

Vi

Vil

Practical No. 05: Implement Half/Full adder/ subtractor using FPGA.

Practical Significance

Field Programmable Gate Arrays (FPGAs) are semiconductor devices that are based
around a matrix of configurable logic blocks (CLBs) connected via programmable
interconnects. FPGAs can be reprogrammed to desired application or functionality
requirements after manufacturing. This practical will help the students to implement
the various combinational circuits like Half or Full adder/ subs tractor using FPGA.

Relevant Program Outcomes (POSs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.”

Debug VHDL programme for the given application.

Relevant Course Outcome
Debug VHDL programme for the given application.

Practical Outcome
Implement Half/Full adder/ subtractor using FPGA.

Relevant Affective domain related Outcome(s)
e Follow safety practices.

e Maintain tools and equipment.

e Follow ethical practices.

Minimum Theoretical Background
a) Half Adder: A Logic circuit used for the addition of two one bit numbers is known
as Half adders. It has two inputs A and B and two outputs Sum (S) and Carry (C).

Table 5.1: Truth Table for Half adder

A B Sum Carry
0 0 0 0
0 1 1 0
1 0 1 0
1 1 0 1
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From the truth table the output equations are: S = AB+ AB
Carry (C)=A.B

° D—)SumS=AeB=iB+AE
D—CarryC:A-B

Fig 5.1: Half Adder

@ >
-]

b) Full Adder: In Half adder there is no provision to add the carry generated by lower
bits while adding present inputs that is when multibit addition is performed. Hence
a third input is added and this circuit is used to add A, Band Cin where A , B are
present state inputs and Cin is the last state output that is previous carry. This
circuit is known as Full Adder.

Table No 5.2: Truth table for Full Adder

A B Cin Sum (S) |Carry (C)
0 0 0 0 0
0 0 1 1 0
0 1 0 1 0
0 1 1 0 1
1 0 0 1 0
1 0 1 0 1
1 1 0 0 1
1 1 1 1 1
% _‘D S=(A®B)®C,,

in

——Dﬁ@_cﬁmmomwcm

Fig 5.2: Full Adder

c) Half Subtractor: A logic circuit used for subtraction of B (Subtrahend) from A
(minuend) where A and B are 1-bit numbers is referred to as Half Subtractor.

Table 5.3: Truth table for Half Subtractor

A |B Difference | Borrow
0 0 0 0
0 1 1 1
1 0 1 0
1 1 0 0

From the truth table the output equations are: D = AB + AB
B=AB
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A B

e+ m

D

L

|
D >
Fig 5.3: Half Subtractor

d) Full Subtractor: A full subtractor is used for performing multibit subtraction where
the borrow from the previous bit position is available. This circuit has three inputs
A (minuend), B (subtrahend) and Bin (borrow from previous stage) and two
outputs Difference (D) and Borrow (BO0).

Table 5.4: Truth table for Full Subtractor

A B Bin | Difference(D) | Borrow (B0)
0 0 0 0 0
0 0 1 1 1
0 1 0 1 1
0 1 1 0 1
1 0 0 1 0
1 0 1 0 0
1 1 0 0 0
1 1 1 1 1
A B B,

]

"_z > 0oD=A®B®B,

D%—oaﬁiamdmsam
: BB '

Fig 5.4: Full Subtractor
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VIl Practical Circuit Diagram:
a) Practical JTAG cable setup:-

10-pin Female Connector

LED Color Description
off Not connected or suspended
Blue Connected at 12MHz (USB full speed)

Teal

Green

Green flickering
Magenta blinking

(Connects to target printed ()
circuit board 10-pin male header.)
T p
N AN

Connected at 480MHz (USB high speed)
JTAG port open, idle

JTAG port open, active

Set by user to identify a cable "

==l

»>® s @D o wa

. Weag
i Digital Input Output Interface Board
)

Fig. 5.5.b: Lab Practical Setup
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b) Create Encoder HA .vhd file:

[ File Edit View Project Source Process Tools Window Layout Help

BEE|

DREAL[a0bXx|wal 2288 Q]

EEEEIPLIEEEIE]

|Design 08 x| & 19 =
[Hf Implemamahcn ® ﬁsimulanon = 20 library IEEE;
— 21 use IEEE.STD_LOGIC 11&4.ALL:
(| | Hierarchy = = -
2| T HA “ 23 -- Uncomment the following library declaration if using
—| = xﬂ:‘““-“mgm 24 - arithmetic functions with Signed or Unsigned values
Fi [y HA - Behavioral (HAvhd) 25 --use IEEE.NUMERIC_STD.ALL;
s |
= —| 27 -- Uncomment the following library declaration if instantiating
A 28 -- any Xilinx primitives in this cods.
. 9| 29 --library UNISDM;
@ 30 --use UNISIM.VComponents.all; W
m Al 3
5 32 entity HA is
. 33 Port ( @ : in STD LOGIC:
@ 34 b : in STD LOGIC;
7| 1 Mo Processes Running @ 3 3 : out STD LOGIC;
4 | Processes: HA - Behavioral = =3 ¢ i out SID_LOGIC):
37 end HA; L
B & DesignSummary/Reports = 2
B Design Utiiies 39 architecture Behavioral of HA is
i User Constraints hos
41 begin
T 582 Implement Design e e b
~8)  Generate Programming File e
@ Configure Target Device 22
&% Analyze Design Using ChipScope 45  end Behavioral; ()
46 -
4 [ »
|' Start ‘ ® Design ‘@ Fles |® Lbranes‘ @ HA.vhd 1E Design Summary (Synthesized) B8]
Console «08x
Process "Synthesize - X5T" completed successfully =

l n

Fig 5.6: HA .vhd file

¢) Create Encoder HA test bench file:

[) File Edit View Project Source Process Tools Window Layout Help

BEE]

DAEF | dPEX|wal| =R 2R

EEREERTITE TR

| Design P=1-53 27 A
i} {83} mplementation @ [ Simuiation 28 LIBRARY isee;
5 pehevr = 29 USE iese.std_logic 1164.ALL;
30
@ Hierarchy 3 31 -- Uncomment the following library declaration if using
—| - E Ha 32 -- arithmetic functions with Signed or Unsigned values
o5 | B €1 xa3s400-4pgg208 33 --USE ieee.numeric_std.ALL:
QT HA_tb - behavier (HA_tb.vhd) 2 34
E2l —| 35 ENTITY HA_tb IS
A | 36 ENDHA tb;
| 37 E
ﬂ 38 ARCHITECTURE behavior OF HA_tb IS
- A 30
5%| 40 - Component Declaration for the Unit Under Test (UUT)
—| a1
Q| = CCMPONENT HA
t €2 No Processes Running () a3 PORT(
| No single design module is selected. I a: IN std logic:
. . 45 b : IN =td logic:
U@ @ Design Utiliies ' @i OUT =ed tegies
% 47 ¢ : OUT std_logic
= 48 ;
o 43 END COMPCNENT;
50
51
52 —-Inputs
53 signal a : std logic :
54 signal b : std logic : -
« n 3
[ sert| =8 pesgn [ Fies | IR Lhrares] [2] Ha.vhd o= Design Summary (Synthesized) =HIE] HA_th.vhd™ ﬂJ
Consale +08x
3 ERROR:ProjectMamt - ¢ error(s) found while parsing design hierarchy. -
Started : "Launching ISE Text Editor to edit HA_tb.vhd". 5
4 n [k
console | @ Emors [ 1) wamings | g4 Find nFies Resuts

Ln93 Col25 VHDL

Fig 5.7: HA Test Bench file
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HA test bench Simulation waveforms:
L i (P20131013) - Defaultcigl I . A e A B

=aa X

gFiIe Edit View Simulation Window Layout Help

LAE L XD ® (o oM m )WiR g mo

Instances and Processes + 0@ X| Cbjects #08 X @ --
Simulation Objects for ha_th 2

¢
(Gl GIE0)] @ B
Instance and Process Name D
iF nato hi| ObjectName Value P e
) std_logic_1164 st 52 1 7
. ! (€]
@b : 3
s 0 L
('3 ] 1 L=
or
¥
i
I
I
« T »
S Instanc Memory || E]source .| | « i = Default.wef [x]
Consale

WARNING: A WEBPACK license was found.

WARNING: Please use Xiinx License Configuration Manager to check out a full ISim license,

WARNING: I5im will run in Lite mode. Please refer to the ISim documentation for more information on the differences between the Lite and the Full version,
This is & Lite version of I5im.

Time resolution is 1 ps

Simulator is doing circuit initialization process,

Finished dircuit initialization process.

15im>

@ consol: | -] Compiationlog | @ Breskpoints | 6 Findin FiesResults | g SearchResults

Fig 5.8 HA Simulation output

d) Actual Experimental set up used in laboratory:

n

Sim Time: 1,000,000 ps
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IX Resources Required:
,3:): /(I:r;s;;rgjgplgms Specification Quantity
FPGA  Development | Device: Xilinx FPGA (XC3S400 PQ208), On
1. | kit board +5V, +3.3V, +2.5V supply to FPGA and
other hardware circuit. On board, 2 Crystal
8MHz and 25MHz.JTAG Interface ( Boundary | 1 No.
Scan ),PROM Interface (XCF02S),40 pin, 4
header connector for external 1/0's
2. | Desktop PC Loaded with open source IDE, simulation and 1 No.
program downloading software.
IX  Precautions to be followed:
1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.
X Procedure:

1. Create the Xilinx ISE project for top-level FPGA design, by doing the following

in ISE:

In the ISE software, select File > New Project.

In the Project name and Project location fields, enter the project name and location,
respectively.

Select HDL or Schematic as the Top-level source type, and click Next.

2. Create New Source file. Select Source Type” select the Source type and give the
name to the source then click “Next”.

3. Define Module”. Enter the entity used in design and then click “Next”.

4. Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic.

5. Create Test Bench file- A test bench is HDL code that allows documentation,
repeatable set of stimuli that is portable across different simulators. A test
bench can be as simple as a file with clock and input data or a more complicated
file that includes error checking, file input and output, and conditional testing.

6. Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation.

7. In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioral Check
Syntax” to make sure that there are no syntax errors, while making changes.

8. Double click on “Simulate Behavioral Model” in the “Process Pane”, which will
open the ISim software with test bench loaded.

9. ISim simulator window will open with simulation executed, as shown in Fig. 5.8
where one can simulate designs and check for errors.

10. After simulation implement 2 as 4 decoder Using FPGA development board.

11. Go to User Constraints — select Floorplan Area/IO/Logic (PlanAhead) — Windows
— Properties — now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run
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14. Go to Config. Target Device and Run — Impact wizard opened — select Device 2

(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx

IC And select Program.

Sample Program: Implement Half Adder and Full Adder using data flow model.

Half Adder:

VHDL Code

library IEEE;

use [IEEE.STD LOGIC 1164.ALL;
use [EEE.STD LOG IC ARITH.ALL;
uselEEE.STD LOGIC UNSIGNED.ALL;
entity HA is

Port ( A, B : in std_logic;

S, C: out std_logic);

end HA;

architecture dataflow of HA is

begin

S<= A xor B;

C<=A and B;

end dataflow;

Full Adder:

VHDL Code

library IEEE;
use I[EEE.STD _LOGIC 1164.ALL;
use IEEE.STD LOG IC_ARITH.ALL,;
uselEEE.STD LOGIC UNSIGNED.ALL,;
entity full adder is
port(A, B, Cin :in bit;
S, C:out bit);
end full adder;
architecture data of full adder is
begin
S<= A xor B xor Cin;
C <=((A and B) or (B and Cin) or (A and Cin));
end data;
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Program Statement for Student: Implement Half and Full Subtractor using data flow model.
Half Subtractor:

VHDL Code

Full Subtractor :

VHDL Code
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Xl Resources Used:

Sr. No. Instrument /Components Specification Quantity

1.

2.

X1l Actual Procedure Followed (use additional sheets if required)

X1l  Precautions followed:

XIV  Observations (use blank sheet provided if space not sufficient)
Observations for Half Subtractor for Problem Statement given to Student.

A |B D |B

0 |0
0 |1
1 |0
1 |1

XV  Results (output of Program)
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XVI Interpretation of result

XVIl Conclusion and Recommendation (Actions/decisions to be taken based on the
interpretation of results)

XVII1I Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. Write the VHDL code for half adder using Behavioral Model.
2. Write the VHDL code for full subtractor using if-then-else statement.
3. Write VHDL code for full adder using mixed style of model.

[Space for Answers]
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XIX References / Suggestions for further reading

1 https://buzztech.in/vhdl-modelling-styles-behavioral-dataflow-structural/

https://www.tutorialspoint.com/vlsi_design/vlsi_design vhdl introduction.htm

3 https://www.tutorialspoint.com/vlsi_design/vhdl programming for combinational

_circuits.htm

4 http://ece2day.blogspot.com/2012/10/vhdl-tutorial-introducction-part-7.html

XX  Assessment Scheme

Total (25 Marks)

Performance Indicators Weightage
Process related (15 Marks) 60%
. s 30%
1 | Coding ability
2 | Debugging ability 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA Board 20%
5 | Answer to sample questions. 15%
6 | Timely Submission of report Answer to sample questions. 05%
100%

Name of student Team Member

Marks Obtained

Process Product
Related Related
(15) (10)

Total
(25)

Dated signature of Teacher
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Vi

Vil

Practical No. 06: Implement 8:1 Multiplexer using FPGA.

Practical Significance

In electronics, a multiplexer (or mux) is a device that selects between several analog or
digital input signals and forwards it to a single output line. Multiplexers are used to
implement Boolean functions of multiple variables. This practical will help the
students to implement the 8:1 using FPGA.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.”

e Use relevant VHDL model for the given applications.

e Debug VHDL programme for the given application.

Relevant Course Outcome
Debug VHDL programme for the given application.

Practical Outcome
Implement 8:1 Multiplexer using FPGA.

Relevant Affective domain related Outcome(s)

e Follow safety practices.

e Maintain tools and equipment.

e Follow ethical practices.

Minimum Theoretical Background

A multiplexer (Mux) is a device that allows digital information from several sources to
be routed on to a single line for transmission over that line to a common destination.
The basic multiplexer has several data input lines (Do, D;.....Dy-1) and single output
line(Y). It has also data select inputs (So, S;....... Sm-1) which permits digital data on
any one input to be switched to the output line. Multiplexers are also known as Data
Selectors. (refer fig. 6.1)

The select lines m and the input lines n are related by the formula: 2™=n.

Depending upon the digital code applied at the select inputs one out of ‘n’ data sources
is selected and transmitted to the single output Y.

Strobe [E or G] signal is used for cascading of inputs. It is an active low signal means
it will perform the intended function only when it is active low i.e. at logic 0.
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Data ot
i —— Y (output
|”F3'Ut_< Multiplexer (onstput)

Enable

Input { {
L 5 05
Select Input

Fig 6.1: Basic Symbol of Multiplexer

8: 1 Multiplexer:

An 8-to-1 multiplexer consists of eight data inputs DO through D7, three input select
lines S2 through SO and a single output line Y. Depending on the select lines
combinations, multiplexer decodes the inputs.

Fig. 6.2 shows the block diagram of an 8:1 multiplexer with Enable input pin which
enable or disable the multiplexer. Since the number data bits given to the MUX are
eight then 3 bits (2°=8) are needed to select one of the eight data bits

Dy —
Dy —»
D, —
Data D; —f 8:1
routs Dy — MUX

Ds—.

—Y (Output)

Dg —|
Dy —»

e—d 111

(Strobe S2 §1 So
or Enable)

\\—-v—l
Select inputs

F.ig 6.2: Block Diagram of 8:1 Multiplexer
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The truth table for an 8-tol multiplexer is given below with eight combinations of
inputs so as to generate each output corresponds to input.

Table 6.1: Truth Table of 8:1 Multiplexer

Enable | Selectinputs | Output
E [S;|[Si|s]| Y
0 X X X 0
1 0 0 0 Do
1 0 0 1 D,
1 0 1 0 D,
1 0 1 1 D5
1 1 0 0 D,
1 1 0 1 Ds
1 1 1 0 Dg
1 1 1 1 D,

For example:

e IfS2=0, S1=1 and S0=0 then the data output Y is equal to D2.

Similarly the data outputs DO to D7 will be selected through the combinations of S2,
S1 and SO.

From the above truth table, the Boolean equation for the output is given as:
v=S,55S,D,+S,S,S,D, +S,S,5,D, +S,5,S,D, +S,S,S,D, +S,S,S,D; +S,S,S,D, +S,S,S,D,

VIl Practical Circuit Diagram:
a) Practical JTAG cable setup:-

10-pin Female Connector
(Connects to target printed
circuit board 10-pin male header.)

LED Color Description

Off Not connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Greenflickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable ")

Fig. 6.3 a: Practical Setup with JTAG CABLE
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Fig. 6.3.b:

b) Create MUX .vhd file:

4 15E Project Navigator (P.20131013) - AL SCHEMEVWT SEM | SCHEME\mux\mux.xise - [multiplexer8X1.vhd]

File Edit View Project Source Process Tools Window Layout Help

b= [JK‘MIL ]

I X|od| = 2PRRARIANBEDID AN

Loglc Output

- ® s B

Digital Input Output Interface Board

Lab Practical Setup

pELQ

Design +«+08 X

D View: (O I:Hj[lmu\amenmhun ®

Behaviaral ~

30 --use UN

Simulation 31

| Il 1%

33 Port |
Hierarchy

5

- £3 xa7al00t-2Icsg324 36 Z:
= mux_th - behavior (mu_tb.vhd)
uut - multiplexer8X1 - Behavioral (multiplex

5

38

40
41 begin
42 process(sel)
43
44 begin
45 case sel is
46 )
47
48
Processes: mux_th - behavior 49
5% 1SmSimulstor 50
QO Behavioral Check Syntax 51
Simulate Behavioral Model 52
58

1 @ (B | g0 6D o

< b4

DO ¥ ¥ FE |

€

£ Mo Processes Running

128|208 |v

55 end case;
56

57 end process;

58 end Behavioral;
ca

34 din :
] mux 35 sel !

omponents.all;
32 entity multiplexer8X1
in
in
out

37 end multiplexer8X1;

54 when others =>

is

39 architecture Behavioral of multiplexer8Xl is

= din(0);
= din(l);
din(2);
= din(3);
= din(4);
= din(5);
din(g);
din(7);

5TD_LOGIC vector(7 downto 0);
vector (2 downto 0);

E Design Summary (Synthesized)

multiplexer8X 1.vhd

[x] | mux_th.vhd B

Console

Process "Simulate Behavioral Model™ completed successfully

£
Console 0 Errors 1) Warnings

Ln30Col1 VHOL

Fig 6.4:

MUX .vhd file
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¢) Create MUX test bench file:

ISE Project Navigator (P.20131013) - F:l SCHEMEWYI SEM | SCHEME\musmuxxise - [mus_tb.vhel] - ®
File Edit View Project Source Process Tools Window Layout Help
o2 ) Vol p2ERS RlA oo A PP
Design ~08x g ~
view: ©) {83} Implementation @) & simulation 5
Behavioral v
Hierarchy -
& mux
B €3 xa7a100t-2lesg324
& & mux_th - behavior (musx_th.vhd) )
uut - multiplexer8X1 - Behavioral (multiple sele= ;
A for 100 ns;
= % < B
o . 50
- A 51 for 100 ns:
2 ) g2 B
- 83 :
@ N 54 for 100 ns;
85 d: B
> | B2 No Processes Running 56 i
for 100 ns:
B, | Processes: mux_th - behavior ;
|53 1sim Simulator 95 :
Behavioral Check Syntax 100 for 100 ns;
A 2 Simulate Behavioral Model 101 :
- 102 ;
103
104
108
loe
107 END;
1na e
< >
L. Design Summary (Synthesized) multiplexer8X 1.vhd muxBx1_th.vhd mux_th.vhd ]
Consale ~08x
) INFO: ProjectMgmt - Parsing design hiera v completed successful ~
v
< >
Console @ Erors  f\ Warnings
Save all the files that need saving Ln 103 Col 6 VHDL
£ I5im (P.20131013) - [Default.wcfg] - X
[ File Edit View Simulstion Window Layout Help
0P e ®|o o |diE BETMSI AR ALR ARl ex|t @ r 2 Loous[v]6 [3) Redaunch

[

_- LS
<

>
= Defaultwcfg ]
Console coax
WARNING: A WEBPACK cense was found. ~
WARNING: Please use Xiin License Configuration Mansger to check out a full 15im lcense.
WARNING: T5im wil un in Lite mode. Plesse refer to the [5im docLmentation for more information on the differences betwesn the Lite and the Full version,
This i 3 Lite version of [5im.
Time resoiution s 1 ps
Simulator i deing creut ntislzation process.
Finished crauit intalzation process.
ISim> v

@ console [] Compiationlog @ Breakpoints (g FindinFlesResults [gf SearchResuits

Sim Time: 1,000,000 ps

Fig 6.6 MUX Simulation output
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e) Actual Experimental set up used in laboratory:

IX Resources Required:

Sr. Instrument /

No Components Specification Quantity
1. | FPGA Development | Device: Xilinx FPGA (XC3S400 PQ208), On | 1 No.
kit board +5V, +3.3V, +2.5V supply to FPGA

and other hardware circuit. On board, 2
Crystal 8MHz and 25MHz.JTAG Interface (
Boundary Scan ),PROM Interface
(XCF02S),40 pin, 4 header connector for
external I/O's

2. | Desktop PC Loaded with open source IDE, simulation and | 1 No.
program downloading software.

X Precautions to be followed:
1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.

Xl Procedure:
1. Create the Xilinx ISE project for your top-level FPGA design, by doing the
following in ISE:

In the ISE software, select File > New Project.
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In the Project name and Project location fields, enter the project name and location,

respectively.

Select HDL or Schematic as the Top-level source type, and click Next.

2.

10.
1.

12.
13.
14.

Create New Source file. Select Source Type” select the Source type and give the

name to the source then click “Next”.
Define Module enter the entity used in design and then click “Next”.

Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic.

Create Test Bench file- A test bench is HDL code that allows documentation,
repeatable set of stimuli that is portable across different simulators. A test
bench can be as simple as a file with clock and input data or a more complicated

file that includes error checking, file input and output, and conditional testing.

Go to implementation to simulation tab , right click on main source file and create

Test Bench file for simulation.

In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioral Check

Syntax” to make sure that there are on syntax errors.

Double click on “Simulate Behavioral Model” in the “Process Pane”, which will

open the ISim software with test bench loaded.

ISim simulator window will open with simulation executed, as shown in Fig. 6.6.

where can simulate designs and check for errors.
After simulation implement 8:1 multiplexer Using FPGA development board.

Go to User Constraints — select Floorplan Area/IO/Logic (PlanAhead) — Windows

— Properties — now assign pin configuration and save.
Go to Implement Design — Run all.
Go to Generate Programming File and Run

Go to Config. Target Device and Run — Impact wizard opened — select Device 2
(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx
IC And select Program.

Maharashtra State Board of Technical Education 68



Very Large Scale Integration with VHDL (22062)

Sample Program: Implement 8:1 Multiplexer.
8:1 Multiplexer:

VHDL Code

library IEEE;

use I[EEE.STD_LOGIC 1164.ALL,;

use [IEEE.STD LOG IC_ARITH.ALL,;

use [EEE.STD_LOGIC UNSIGNED.ALL;
entity mux8 1 is

port(

din : in STD_LOGIC VECTOR(7 downto 0);
sel : in STD LOGIC VECTOR(2 downto 0)
Y :out STD LOGIC

);

end mux8 1;

architecture multiplexer8 1 arc of mux8 1 is
begin
Y <= din(7) when (sel="000") else

din(6) when (sel="001") else
din(5) when (sel="010") else
din(4) when (sel="011") else
din(3) when (sel="100") else
din(2) when (sel="101") else
din(1) when (sel="110") else
din(0);

end multiplexer§ 1 arc

Program Statement for Student: Implement 4:1 Multiplexer using structural model.
4:1 Multiplexer

VHDL Code
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XI1 Resources Used:

Sr.No. | Instrument/Components Specification Quantity
1.

2.

XI  Actual Procedure Followed (use blank sheet provided if space not sufficient)

X1V  Precautions followed:

XV  Observations (use blank sheet provided if space not sufficient)
Observations for Problem Statement given to Student.

SO S1 Y

| k| O O

0
1
0
1

XVI Results (output of Program)
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XVII Interpretation of result

XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the
interpretation of results)

XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. Give the syntax of if statement.
2. Write the VHDL code for 4:1 multiplexer using the “case” statement.

[Space for Answers]
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XX  References / Suggestions for further reading
https://buzztech.in/vhdl-modelling-styles-behavioral-dataflow-structural/

1
2
3

4
5
6

https://www.tutorialspoint.com/vlsi_design/vlsi_design vhdl introduction.htm

https://www.tutorialspoint.com/vlsi_design/vhdl programming for combinational

_circuits.htm

https://www.electronicshub.org/multiplexerandmultiplexing/

http://ece2day.blogspot.com/2012/10/vhdlI-tutorial-introducction-part-7.html

https://www.allaboutcircuits.com/technical-articles/sequential-vhdl-if-and-case-

statements/

XXI Assessment Scheme

Performance indicators Weightage

Process related (15 Marks) 60%
. o 30%

1 | Coding ability
2 | Debugging ability 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA Board 20%
5 | Answer to sample questions. 15%
6 | Timely Submission of report Answer to sample questions. 05%

Total (25 Marks) 100%0)

Name of student Team Member

Marks Obtained

Process Product Total
Related (15) | Related (10) (25)

Dated signature of Teacher
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Vi

Vil

Practical No. 07: Implement 1:8 Demultiplexer using FPGA.

Practical Significance

In electronics, a demultiplexer (or demux) is a device that takes a single input line and
routes it to one of several digital output lines. Demultiplexer can be used to implement
general purpose logic. By setting the input to true, the demux behaves as a decoder.
This practical will help the students to implement the 8:1 using FPGA.

Relevant Program Outcomes (POSs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.”

e Use relevant VHDL model for the given applications.

e Debug VHDL programme for the given application.

Relevant Course Outcome
Debug VHDL programme for the given application.

Practical Outcome
Implement 1: 8 Demultiplexer using FPGA.

Relevant Affective domain related Outcome(s)
e Follow safety practices.

e Maintain tools and equipment.

e Follow ethical practices.

Minimum Theoretical Background

A Demultiplexer is a data distributor read as DEMUX. It is opposite to multiplexer or
MUX. It is a process of taking information from one input and transmitting over one
of many outputs.

0 Y,
INPUTS ———— Y,
O— DE-MUX B—mMmMmmO ™

S bl

St SmeSq Sz
Fig 7.1: Symbol for Demultiplexer
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Demultiplexing is the process of converting a signal containing multiple analog or
digital signals backs into the original and separate signals. A demultiplexer of 2"
outputs has m select lines.

The enable input will enable the demultiplexer. The relation between the n output lines

and m select lines as follows; n=2"

1:8 Demultiplexer: The block diagram of a 1: 8 De-MUX having only one data input
D and eight outputs. It has three select lines SO, S1, S2 which are used as the control
signals. There is a strobe input E which is active low. The data bit at input D is
transferred to one of the eight outputs depending upon the states of the select lines.

—o Y,
—o Y,
o v,
DI;MSX _on Outputs
—oYg
—oYg

oY,

T 11

Sz $1 S
Select lines
Fig 7.2: 1:8 Demultiplexer

Table 7.1: Truth Table of 1:8 Demux

Data Input Select Inputs Outputs

D

o
(5]
-
[¥5)
[—]
-
=
o
-
&5
_‘
-
-
el
==
_c
(=]

o ol ||| |g
LRl === =]
=R E=R ==
= ol ok |o|k|o
Olo|lo|lo|lo|lo| oo
o | oie o o 0 0o
L= = I I = I == I — TR = D = I = |
ool o|lo|o|o|o
|l o|lo|lo|o|lo | o|o
ol ol o|lo|lgo|lo|o
ol ol o|lo|lo| 0|2
o o|lo o|lo|lo|o|oO
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VIl Practical Circuit Diagram:
a) Practical JTAG cable setup:-

10-pin Female Connector
(Connects to target printed
drcuit board 10-pin male header.)

LED Color Description

off Not connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Greenflickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable "

Logle it

»>® s @D

Digital Input Cutput interface Board

Fig. 7.3.b: Lab Practical Setup
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b) Create Demux .vhd file:

SE Project Navig: ise - [Demux.
File Edit View Project Source Process Tools Window Layout Help EEE
£ F| L XDR AEPBR AR = h ? )
AT BXx|wa| 2 2FBRLPRIARE T2 ERPELY
«+08 X‘ - 24 —- arithmetic functions with Signed or Unsigned values -
{8} implementation ©) [ simuiation 25 --use IEEE.NUMERIC STD.ALL;
Hiesarch —| 2
\er: ¥ 27 -- Uncomment the following library declaration if instantiating
- |8] Demux I 28 -- any Xilinx primitives in this code.
e 304 pagle 29 --library UNISIM;
B @#u Demus - Behavioral (Demux.vhe 30 --use UNISIM,VComponents.all;
2 31
— 32 entity Demux is
33 ort : in 5
A Port (d : in STD LOGIC
% 34 sel : in S5TD LOGIC WECTCR (2 downto 0);
E 35 ¥ i out S5TD LOGIC VECTCR (7 downto Q));
m * 36 end Demux; i
% 37
a W, ' 6 38 architecture Behavioral of Demux iz
39
: ) NoProcesses Running 9| »
£ | Processes: Demux - Behavioral - % wnen sel=rooorelse’0’;
. 42 when 001"else'0';
% = ] Des!gn Sun?mary/Report; 43 when sel=r0i0velse’0’s E
% 35@; Utities 44 when "else'0';
A ser Constraints 45 when 100"else'0";
m 46 when 0l"else’0';
€2 Implement Design ] a when Lonelsaors
[¢] Genevatepwgrammm File 48 when velastnrs
@ Configure Target Device 13
“-@*  Analyze Design Using ChipScope 5 m
51 end Behavioral; -
1 n 3
[ st | 3 peson [0 s [ ) thrares | 2 Demux.vhd B[E Design Summary (Synthesized) =]
Console +08x
-
Process "Synthesize - XST" completed successfully =

T P——

conscle | @ Erors | 1y wamings | g6 Fndin Fies Resuls

Ln48 Col17 VHDL

Fig 7.4: Demux .vhd file

c) Create Demux test bench file:

o ISE Proj

[E) File Edit View Project Source Process Tools Window Layout Help

DAEF L[ snbxval regp ,RIR =E [ s#0pef[@

Design © 08 x| €[ 22 -- This testbench has been automatically generated using types std logic and N
5 1} Implementation © 58] Smulation 23 - std logic_vector for the ports of the unit under test. Xilinx recommends

_ [Behavioral = 24 -- that these types always be used for the top-level I/0 of a design in order
g 25 -- to guarantee that the testbench will bind correctly to the post-implementation
ezt 26 -- simulation medel.
| B demix =1 a7
o | B £ 135400-4pqg208 28 LIBRARY ieee;

& [ demux_tb - behavior (demux_thvh 29 USE iese.std logic 1164.ALL;
=} —| =0 3
a A | 31 -- Uncomment the following library declaration if using
94| 92 -- arithmesic functions with Signed or Unsigned values
=) 33 --USE iese.numeric_std.RLL;
- BT
% | 35 ENTITY demux_tb IS
d wJ ‘| —| 36 END demux tb;
Q|
P | T2 o Processes Ruming ©)| 38 ARCHITECTURE behavier OF demux_cb IS
Tt | Processes: demus_tb - behavior —| 3=
40 —- Component Declaration for the Unit Under Test (UUT)
Sp| =@ 1simSimulator "
% 8 @) g.eha\‘nuras\ Chheck sma;; | ® COMBONENT de:
x imulate Behavioral Model o BORT
] 44 d: IN std logic:
45 s : IN std logic vector(2 downto 0);
46 v : OUT std_logic_vector(7 downto 0)
47 1
a8 END COMECNENT:
43 -
< m 13
[« strt [ @3 pesign [ Fies [ wbrares E demu.vhd BT Design Summary (Synthesized) =1IEl demux_th.vhd a|
Console 08 x

Fuse Memory Usage: 29048 EB S

Fuse CPU Usage: 607 ms

Launching ISim simulation engine GUI...

"D:/demux/demux_tb_isim beh.exe" -intstyle ise -gui -tclbatch isim.cmd —wdb "D:/demux/demux_th_isim beh.wdb" il
< ilf - ) T C C »
Console Errors |J§ Warnings |['ji Find in Files Results

Ln107 Col 18 VHDL

Fig 7.5: Demux Test Bench file

Maharashtra State Board of Technical Education

77



Very Large Scale Integration with VHDL (22062)

d) Demux test bench Simulation waveforms:

. v v - S S L W

ol

EF“E Edit  View Simulation Window Layout Help
asg Do oM & QIFZI DT LN r EIRCE R A Y - A EE

Instances and Processes [0 & X/ Objects
Simulation Objects for demux_tb

- BEEGED «

Instance and Process Name

i demux tb af [bject Name Value
) std ogc 1164 A I -
25 sizo]
2501 RN
‘ m » q
S Instenc Memory a Source .| | 4 m y j Default.wcfg 8
Cansole

VUARMNING: A WEBPACK license was found.

WARNING: Please use Xilinx License Canfiguration Manager to check out a full 15im license,

VUARMNING: I5im will run in Lite made, Please refer to the 15im documentation for more information on the differences between the Lite and the Ful version,
This is aLite version of ISim,

Time resolution is 1ps

Simulator is doing circuit initislization process.

Finished dircuit initialization process.

ISim>

B console j CompiationLog | @ Ereakpoints | @4 FindinFilesResults | gy SearchResults

Force the selected signal to a constant value

‘ L Redaunch

Sim Time: 1,000,000 ps

Fig 7.6 Demux Simulation output

e) Actual Experimental set up used in laboratory:
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IX Resources Required:
22 Qggg&iﬁé Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208), On board +5V,
FPGA +3.3V, +2.5V supply to FPGA and other hardware circuit.
1. | Development On board, 2 Crystal S8MHz and 25MHz.JTAG Interface 1 No.
kit ( Boundary Scan ),PROM Interface (XCF02S),40 pin, 4
header connector for external I/O's
Desktop PC Loaded with open source IDE, simulation and program
2. . 1 No.
downloading software.
X Precautions to be followed:
1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.
X1 Procedure:
1. Create the Xilinx ISE project for your top-level FPGA design, by doing the
following in ISE:
In the ISE software, select File > New Project.
In the Project name and Project location fields, enter the project name and location,
respectively.
Select HDL or Schematic as the Top-level source type, and click Next.
2. Create New Source file. Select Source Type” select the Source type and give the
name to the source then click “Next”.
3. Define Module”. Enter the entity used in design and then click “Next”.
4. Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic.
5. Create Test Bench file- A test bench is HDL code that allows you to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing.
6. Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation.
7. In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioral Check
Syntax” to make sure that you didn’t make any syntax errors while making
changes.
8. Double click on “Simulate Behavioral Model” in the “Process Pane”, which will
open the ISim software with your test bench loaded.
9. ISim simulator window will open with your simulation executed, as shown in Fig.
7.6. where you are able to simulate your designs and check for errors.
10. After simulation implement 1:8 demux using FPGA development board.
11. Go to User Constraints — select Floorplan Area/IO/Logic (Plan Ahead) — Windows
— Properties — now assign pin configuration and save.
12. Go to Implement Design — Run all.
13. Go to Generate Programming File and Run
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14. Go to Config. Target Device and Run — Impact wizard opened — select Device 2
(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx
IC And select Program.

Sample Program: Implement 1:8 Demultiplexer using behavioral model.
1:8Demultiplexer:

VHDL Code

library IEEE;

use IEEE.STD LOGIC 1164.ALL;

use [EEE.STD_LOGIC ARITH.ALL;

use I[EEE.STD LOGIC UNSIGNED.ALL;

entity dmux1 is

port(D:in std_logic;

s:in std_logic_vector(2 downto 0);
y:out std_logic_vector(7 downto 0));
end demux1;

architectural behavioral of dmuxl1 is
begin

y(0)<=D when s="000"else'0";
y(1)<=D when s="001"else'0';
y(2)<=D when s="010"else'0";
y(3)<=D when s="011"else'0';
y(4)<=D when s="100"else'0";
y(5)<=D when s="101"else'0';
y(6)<=D when s="110"else'0";
y(7)<=D when s="111"else'0';
end behavioral;
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Program Statement for Student: Implement 1:4 Demultiplexer using dataflow model.

1:4 Demultiplexer

VHDL Code

X1l Resources Used:

sg Instrument /Components Specification Quantity

1.

2.

X1 Actual Procedure Followed (use blank sheet provided if space not sufficient)

X1V  Precautions followed:
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XV  Observations (use blank sheet provided if space not sufficient)
Observations for Problem Statement given to Student.

SO [S1 |Y3|Y2]|Y1l|YO
0 |0
0 |1
1 |0
1 |1

XVI  Results (output of Program)

XVII Interpretation of result

XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)

XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. Give the syntax of when-else statement.
2. Write the VHDL code for 1:4 demultiplexer using the ‘if else” statement.

[Space for Answers]
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XX  References / Suggestions for further reading
https://buzztech.in/vhdl-modelling-styles-behavioral-dataflow-structural/

1
2
3

4

()]

https://www.tutorialspoint.com/vlsi_design/vlsi_design vhdl introduction.htm

https://www.tutorialspoint.com/vlsi_design/vhdl programming for combinational

_circuits.htm

https://www.rfwireless-world.com/source-code/VHDL/1X8-DEMUX-vhdl-

code.html

http://ece2day.blogspot.com/2012/10/vhdl-tutorial-introducction-part-7.html

https://www.allaboutcircuits.com/technical-articles/sequential-vhdl-if-and-case-

statements/

http://vhdlbynaresh.blogspot.com/2013/07/design-of-1-8-demultiplexer-using-

when.html

XXI  Assessment Scheme

Performance indicators Weightage
Process related(15 Marks) 60%
1 | Coding ability 30%
2 | Debugging ability 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA Board 20%
5 | Answer to sample questions. 15%
6 | Timely Submission of report Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained

Process Product Total
Related (15) Related (10) (25)

Dated signature of Teacher
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Vi

Vil

Practical No. 08: Implement T and D flip flop using FPGA.

Practical Significance

A flip flop is an electronic circuit with two stable states that can be used to store binary
data. The stored data can be changed by applying varying inputs. Flip-flops and
latches are fundamental building blocks of digital electronics systems used in
computers, communications, and many other types of systems. This practical will help
the students to implement the T and D flip flop using FPGA.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.”

e Use relevant VHDL model for the given applications.

e Debug VHDL programme for the given application.

Relevant Course Outcome
Debug VHDL programme for the given application.

Practical Outcome
Implement T and D flip flop using FPGA.

Relevant Affective domain related Outcome(s)
e Follow safety practices.

e Maintain tools and equipment.
e Follow ethical practices.

Minimum Theoretical Background
Flip-flops and latches are used as data storage elements. It is the basic storage element
in sequential logic.

D type FF: D type FF has only one input referred to as D input or Data input. The
input is applied to S/J and it is inverted before applied to either R/K input. the input
applied at the D terminal will appear at the output after one clock pulse hence it is
referred to as Delay or D FF. for this complete clock cycle as the input is holded this
circuit is known as LATCH.
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This NAND inverter
avoids S to be equal
toR

Fig 8.1: D Flip Flop

Table 8.1: Truth Table for D Flip flop

Input D Output Q
0 0
1 1

Qutputs

:

Toggle
input

CLK

Qutputs

Ol

Fig 8.2: T Flip Flop

Table 8.2: Truth Table for T Flip Flop

Input T Output Q
0 Qn
1 @n

T Type FE: In a JK FF then the resulting FF is referred as T Type FF. it has only one input
refereed as t input. If T=1 then it acts as toggle switch i.e. the output changes
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VIl Practical Circuit Diagram:

a) Practical JTAG cable setup:-

10-pin Female Connector

(Connects to target printed
aircuit board 10-pin male header.)

LED Color Description

Off Not connected or suspended

Blue Connected at 12MHz (USB full speed) \J
Teal Connected at 460MHz (USB high speed)

Green JTAG port open, idle

Green flickering | JTAG port open, active

Magenta blinking | Set by user to identify a cable "

— .

L ,

Loghe Ol

O B

e
i Digital Input Output interface Board
B

Fig 8.3.b: Lab Practical Setup
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b) Create DFF .vhd file:

[2) File Edit View Project Source Process Tools Window Layout Help

D2EF [s0bxvel fr 3R, R =m0 s0[rcf]9
[Design #O&8 x| & 28 -- any Xilinx primicives in this code. 2
i {6} implementation () [ Smulaton = | 29 --library UNISIM:
Hierarch —| 30 --use UNISIM.VComponents.all:
(] | Hierarchy by
& pFe w 32 entity DFF is
— | = xa35|‘=‘00-49q9103 33 Port ( din : in STD_LOGIC:
a5 - [ef% DFF - Behavioral (DFFvhd) 32 clk : in STD_LOGIC;
= ) 35 reset : in STD_LOGIC;
& —| 36 dout : out STD_LOGIC):
A 37 end DFF:
38
2 A1 Ze azcnicectuze Senavioral of DFF is
m Al a0
% 41
~—| 22 begin
(| &3 daff : process (dinm,clk,reset) is
> €2 Mo Processes Running e 44 begin
74 | Processes: DFF - Behavioral = = if (zeset='1') then
b B Renort: 46 dout<= '0';
H oz Desian U“"”"‘a'y" eports 47 el3if (clk'eveat and clk = '1') thea
% U“‘gc” tilities 48 dout<= din; =
% ser Constraints P end 15:
50 end process dff;
Tmga  ImplementDesign by F
F2  Generate Programming File =
8" Configure Target Device Ol Behavioral:
@ Analyze Design Using ChipScope e
55 =
< m 3
|, Start ‘ B Design ‘@ Files |® Lbranes‘ @ DFF.vhd gz Design Summary (Synthesized) B8]
Console 08X
Process "Synthesize - X5I" completed successfully s
=

< .

Console Erors | ) Warnings | (8 Find in Fles Results

Fig 8.4: DFF .vhd file

c) Create DFF test bench file:

@ File Edit View Project Source Process Tools Window Layout Help

BEE]

DAEFLiXnbX|wa| irrER 28|

RETC[sR PPV

|Design «08 x| E a2 o
DT Views () Implememznuni imulation = 83 -- Stimulus process
Behavioral ] — 84 stim proc: process
EE' 85 begin
Hierarchy o 86 -- hold reset state for 100 na.
—| - & oFF 27 clike="0";
| B £ xa3sd00-4pgg208 28 dine='1';
E @-m DFF_tb - behavior (DFF_thwhd) - 89 wait for 50 ns;
= —| 90 elke=10";
Al 91 din¢="0';
% 92 wait for 50 ns:
Ia 93 clk<='0";
- A o dine="0';
%| 95 wait for 50 ne;
— 96 clk<='1";
@ 97 din¢='1';
P | £ NoProcesses Running o = wait for 50 ns:
% Processes: DFF_th - behavior - 13; d:rl\l:f?(;:}l’
kR 4 "” simultor 101 wait for 50 ns;
= 103 din<="1";
m 104 wait for 50 ns; =
105 clke='1";
106 din¢="'0";
107 wait for 50 ns;
108 —-wait for clk period*10;
108 -
4 m 3
| stat | 52 pesion [ Fies [ Y tibreries| | [ DFFvhd UL cesgnsummay Sythesizd) [ [2) DFF._th.vhd ﬂJ
Console +08 X
Process "Simulate Behavioral Model" completed successfully -
=)

[l —T—

Console |° Errors |_ﬁ Warnings |ﬁ Find in Files Results

Fig 8.5: DFF Test Bench file

Ln107 Col17 VHDL
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d) DFF test bench Simulation waveforms:

L4 Isim 2031013 - Dot AR - T B

EFHE Edit View Simulation Window layout Help

OBHEE $REX®|wa|diE ) BED| IR ALPE AR
Instances and Processes + 0 & X||Objects “+08 x ¢ -- . -
Simulation Objects for dff_th 2
’ o
Name
;’j‘c
& @

Instance and Process Name

{J drito dil| Object Name Value ’ -U; dk
|
o) std_logic 1164 st Q d‘\: 0 -U; reset
g d 1 i
g reset B Tl dout
& dout 1 18 dk_period 10000 ps

1y <k_period 10000 ps

I 3 4 ol i [

226,688 ns
A

.

] 3
a%lnstanc Memory ESDUTEE 4 I b j Defaultwefy [ x]

Console

WARNING: A WEBPACK license was found. -
WARNING: Please use Xiinx License Configuration Manager to check out a full ISim license,

WARNING: ISim will run in Lite mode. Plezse refer to the ISim documentation for more information on the differences between the Lite and the Full version.
This is a Lite version of [Sim,

Time resolution is 1 ps

Simulator is doing circuit initialization process,

Finished circuit initialization process,

ISim>

m

B console j Compiation Log | @ Breskpoints | (9§ Findin Files Results | [ Search Results

Fig 8.6 DFF Simulation output

e) Actual Experimental set up used in laboratory:
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IX  Resources Required:

Elg'. g]cfrtr:;cr)?]eerr]&é Specification Quantity
Device: Xilinx FPGA (XC3S400 PQ208), On board
FPGA +5V, +3.3Y, fr2.5V supply to FPGA and other
1. | Development hardware circuit. On board, 2 Crystal 8MHz and | No.
kit 25MHz. JTAG Interface ( Boundary Scan ), PROM
Interface (XCF02S), 40 pin, 4 header connector for
external I/O's
Desktop PC Loaded with open source IDE, simulation and program
2. . 1 No.
downloading software.
X Precautions to be followed:
1. Check the syntax / rules of VHDL Programming.
2. Do not power up the board before completing connections.
Xl Procedure:

1. Create the Xilinx ISE project for your top-level FPGA design, by doing the

following in ISE:

In the ISE software, select File > New Project.

In the Project name and Project location fields, enter the project name and location,
respectively.

Select HDL or Schematic as the Top-level source type, and click Next.

2. Create New Source file. Select Source Type” select the Source type and give the
name to the source then click “Next”.

3. Define Module”. Enter the entity used in design and then click “Next”.

4. Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic.

5. Create Test Bench file- A test bench is HDL code that allows you to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing.

6. Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation.

7. 1In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioral Check
Syntax” to make sure that you didn’t make any syntax errors while making
changes.

8. Double click on “Simulate Behavioral Model” in the “Process Pane”, which will
open the ISim software with your test bench loaded.

9. ISim simulator window will open with your simulation executed, as shown in Fig.
8.6. where you are able to simulate your designs and check for errors.

10. After simulation implement D flip flop using FPGA development board.

11. Go to User Constraints — select Floorplan Area/IO/Logic (Plan Ahead) — Windows
— Properties — now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run
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14. Go to Config Target Device and Run — Impact wizard opened — select Device 2 (as
per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC
And select Program.

Sample Program: Implement T and D flip flop using FPGA using behavioral modelling.
T Flip Flop :

VHDL Code
library IEEE;
use [EEE.STD_LOGIC 1164.all;

entity Toggle flip flop is
port(
t:in STD LOGIC;
clk : in STD _LOGIC;
reset : in STD _LOGIC;
dout : out STD LOGIC
)i
end Toggle flip flop;

architecture T _FFof Toggle flip flop is
begin

tff : process (t,clk,reset) is
variable m : std_logic : ='0";
begin

if (reset ='1") then

m:="'0"

elsif (rising_edge (clk)) then
if (t="1") then

m : =not m;

end if;

end if;

dout<=m;

end process tff;

end T FF;

D Flip Flop:

VHDL Code

library IEEE;

use IEEE.STD_LOGIC 1164.all;

entity d_flip flop is
port(
din : in STD_LOGIC;
clk : in STD_LOGIC;
reset : in STD_LOGIC;
dout : out STD_LOGIC
);
end d flip_flop;
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architecture D _FF of d_flip flop is
begin
dff : process (din,clk,reset) is
begin
if (reset="1") then
dout<="0";
elsif (clk’event and clk="1") then
dout<= din;
end if;
end process dff;
end D FF;

Problem Statement for Student:

Write the VHDL code for D flip flop with respect to the structure shown:

D D1

[ >—

D2

VHDL Code

X1l Resources Used:

Sr.

No Instrument /Components Specification

Quantity
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XI1  Actual Procedure Followed (use blank sheet provided if space not sufficient)

XV  Observations (use blank sheet provided if space not sufficient)

Observations for Problem Statement given to Student.

Clk
0
1
1

Y

| ol ol O

XVI  Results (output of Program)

XVII Interpretation of result
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XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)

XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. Write the VHDL code for T flip flop using structural modelling.
2. Write the VHDL test bench code for T Flip Flop using characteristic equation.

[Space for Answers]
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XX  References / Suggestions for further reading
https://buzztech.in/vhdl-modelling-styles-behavioral-dataflow-structural/

1.
2.
3.

4,
5.

https://www.tutorialspoint.com/vlsi_design/vlsi_design vhdl introduction.htm

https://www.tutorialspoint.com/vlsi_design/vhdl programming for sequential cir

cuits.htm

http://ece2day.blogspot.com/2012/10/vhdl-tutorial-introducction-part-7.html
https://electronicstopper.blogspot.com/2017/07/t-flip-flop-in-vhdl-with-

testbench.html

XXI Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Coding ability 30%
2 | Debugging ability 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA Board 20%
5 | Answer to sample questions. 15%
6 | Timely Submission of report Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained

Process Product Total
Related (15) | Related (10) (25)

Dated signature of Teacher
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Vi

Vil

Practical No. 9: Implement 2:4 Decoder using FPGA.

Practical Significance
The electronic Decoders are used with analog to digital converter. They are used to
convert higher level instructions into CPU control signals. They are mainly used in
logical circuits as well as data transfer circuits. This practical will help the students to
develop programming skills that is. Implement a decoder application on FPGA board
using Xilinx ISE tools.

Relevant Program Outcomes (POs)

Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills
This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronic circuits and equipments.’

Develop ‘VHDL’ code using IDE tools.
Use Input/output port pins of FPGA.
Interface FPGA KIT and desktop PC.

Relevant Course Outcome(s)
Debug VHDL programme for the given application.

Practical Outcome
Implement 2:4 Decoder using FPGA.

Relevant Affective domain related Outcome(s)

Follow safe practices.
Maintain tools and equipment.
Follow ethical practices.

Minimum Theoretical Background

Binary decoder :- Binary decoder has n-bit input lines and 2" output lines. It can
be 2:4, 3:8 and 4:16 line configurations. Binary decoder can be easily constructed
using basic logic gates. VHDL Code of 2 to 4 decoder can be implemented with
structural and behavioral modeling.
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Decoder BO
Bl

2tod B2
B3

Fig. 9.1: 2 : 4 Decoder

Table No. 9.1: Truth Table for 2 : 4 Decoder

INPUT OUTPUT
Al A2 B3 B2 Bl B0
0 0 0 0 0 1
0 1 0 0 1 0
1 0 0 1 0 0
1 1 1 0 0 0

VIIl  Practical Circuit diagram:

10-pin Female Connector

(Connects to target printed
circuit board 10-pin male header.)
LED Color Descriptio

n
Off Mot connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Green flickering JTAG port open, active
Magenta blinking | Set by user to identify a cable "'

Fig. 9.2.a: Practical Setup with JTAG CABLE
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St
o

B=
-

| Logic .hPU‘.

S

Laglc Cutpul

3 BRI

Digital Input Output merface Board

Fig. 9.2.b: Lab Practical Setup

a) Decoder 2 :4 .vhd file :-

& ISE Project Navigator (P.20131013) - F:\l SCHEME\VI SEM | SCHEME\DECODER2TO4\ DECODER2TO4.xise - [DECODE2TO4.vhel] - X
) File Edit View Project Source Process Tools Window Layout Hel -8 x
j y P
DAL sDEXval| i ALRRARA ZEMa LR PEL
Design +08X & 20 ~
] View: ® {8 tmplementation O [ Smuation 5= 21
— 1lib:
o | Hierarcny zi LEzary feeanis
[ '#] DECODER2TO4 = 24
— | & £3 xc3s400-5pq208 e
& [l decoder! - bhv (DECODE2TO4, 26
= - 27
& — 28 ) ] OR (1 downto 0):
A 29 bt CTOR (3 downto 0)
% 30 )i
] a1
- * 32 end decoderl;
| 33
g 4 6 34 architecture bhv of decoderl is
35
: T2 Mo Processes Running o 36 begin
2, | Processes: decoder! - bhv @ a7
20 View RTL Schematic > process (a)
View Technology Schema... el oin
% T2 CheckSyntax Pl i (a—00") then
- ¥)  Generate Post-Synthesis S... = N A
. £2C) Implement Design hs :
T2 Generate Programming File bl c1air (e
&  Configure Target Device e N
% Generate Target PROM/A...
Manage Configuratian Pr o
1sif (a="10") ther
G4 Analyze Design Using ChipSc.. P = ) when _
& Strt B Desgn 3 Fles [ Lbraries | I Design Summary (Programming File Generated) DECODEZTO4vhd [ | (2] decodert (RTLY) | decodert (rech) |2 tb_decoderL.vhd
View by Category o0/ X
Design Objects of Top Level Block Properties of Instance: decoder1
Instances Pins Signals Name Value ~
& decoder! # decoder] & decoder! Type decoder!:1
OriginalSymbal decoder] M

Console @ Erors 1\ Warnings

g6 FindinFilesResults  [EH  View by Category

Fig. 9.3:

.vhd file
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b) Decoder 2 : 4 test bench file-

ISE Project Navigator (P.20131013) - F:\l SCHEME\Y] SEM | SCHEME\DECODER2TOA\DECODER2TO4uxise - [tb_decoder] vhd] - X
File Edit View Project Source Process Tools Window Layout Help
O@ 3@ | = 2RARA BREOS SR PP
Design o088 x n
view: O 13 Implementation @) (] Simulation
] [pehavira v
(| Hierarchy
= =] DECODER2TO4
5 £ xe3s400-5pq208
g| © J th_decoder! - behavior (th_decod
& uut - decoder] - bhy (DECODE; 35 Y th_decoderl 15
4 36 ) th_decoder
\ " 37
4 . 3 behavior OF tb_decoderl IS
m A 39
% 40 - C D fi
< > 41
Q 2
| #2 NoProcesses Running =
74 | Processes: th_decoder! - behavior 44 to 0);
0% fsim Simulator b ovnte 0)
€20 Behavioral Check Syntax -
“ el 1 43
m 49
50
51 downta 0) := (athers =» '0');:
52
53
54 o (3 downto 0); v
< >
Start 3 Design ) Fies [ Libraries | %% Design Summary (Programming File Generated) DECODEZTO4. vhd ) decodert RTLY) ¥ decodert (Techt) th_decoderivhd [
View by Category 08 %
Design Objects of Top Level Block Properties of Instance: decoderl
Instances Pins Signals Name Value A
i gy decoder] i gy decoder] i & decoderl Type decoderl:1
OriginalSymbol decoder] M
[Z] console @ Errors 1\ Wamings @6 FindinFlesResuts 5 View by Category
c) Decoder 2 to 4 test bench Simulation waveforms-
£ 1Sim (P.20131013) - [Defaultwcfg) X

[E] File Edit View Simulation Window Layout Help

DP2ES s REX® 0 o|dhH BEDSARIALEL AN,

[ Re-aunch

Default.wefg [x]

Console S06 X

WARNING: A WEBPACK license was found. ~
WARNING: Please use Xilinx License Configuration Manager to chedk out a full 1Sim license.
WARNING: ISim wil run in Lite mode. Please refer to the ISim documentation for more information on the differences between the Lite and the Full version.
This is a Lite version of ISim.
Time resolution is 1ps
Simulator i doing dircuit intialization process.
Finished circuit initalization process.
im> v

B console [ ] Complatonlog @ Breakpoints [p4 FindinFilesResults g SearchResults

Fig. 9.5: Simulation output
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d) Actual Experimental set up used in laboratory

IX Resources Required

Sr. Instrument

No. /Components Specification Quantity

1. | FPGA Development kit Device: Xilinx FPGA (XC3S400 PQ208),0n | 1 No.
board +5V, +3.3V, +2.5V supply to FPGA
and other hardware circuit. On board, 2
Crystal 8MHz and 25MHz.JTAG Interface (
Boundary Scan ),PROM Interface
(XCFO02S),40 pin, 4 header connector for
external I/O's

2. | Desktop PC Loaded with open source IDE, simulation and | 1 No.
program downloading software.

X Precautions to be followed
1. Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
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Xl Procedure

1.

[98)

10.

11

12.
13.
14.

Create the Xilinx ISE project for your top-level FPGA design, by doing the
following in ISE:

In the ISE software, select File > New Project.

In the Project name and Project location fields, enter the project name and location,
respectively.

Select HDL or Schematic as the Top-level source type, and click Next.

Create New Source file. Select Source Type” select the Source type and give the
name to the source then click “Next”.

Define Module”. Enter the entity used in design and then click “Next”.

Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic. Ref Fig no.9.3.

Create Test Bench file- A test bench is HDL code that allows you to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing. Ref Fig no. 9.4.

Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation.

In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioural
Check Syntax” to make sure that you didn’t make any syntax errors while making
changes.

Double click on “Simulate Behavioural Model” in the “Process Pane”, which will
open the ISim software with your test bench loaded.

ISim simulator window will open with your simulation executed, as shown in Ref
Fig no. 9.5. where you are able to simulate your designs and check for errors.

After simulation implement 2 : 4 decoder Using FPGA development board.

. Go to User Constraints — select Floorplan Area/IO/Logic (PlanAhead) — Windows

— Properties — now assign pin configuration and save.

Go to Implement Design — Run all.

Go to Generate Programming File and Run

Go to Config. Target Device and Run — Impact wizard opened — select Device 2
(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx
IC And select Program.
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SAMPLE PROGRAM : Step 1. Develop VHDL code for 2:4 Decoder .

VHDL Code using if else statement.
library IEEE;
use [EEE.STD LOGIC 1164.all;

entity decoderl is

port(

a:in STD LOGIC VECTOR(1 downto 0);
b:out STD LOGIC VECTOR(3 downto 0)
);

end decoderl;

architecture bhv of decoderl is
begin
process(a)

begin
if (a="00") then
b <="0001";
elsif (a="01") then
b <="0010";
elsif (a="10") then
b <="0100";
else
b <="1000";
end if;
end process;
end bhv;

Step 2: Develop Test Bench file for simulation.

VHDL Code
LIBRARY ieee;
USE ieee.std logic 1164.ALL;

ENTITY tb_decoderl IS
END tb_decoderl;

ARCHITECTURE behavior OF tb_decoder1 IS

-- Component Declaration for the Unit Under Test (UUT)
COMPONENT decoderl
PORT(
a:IN std logic vector(1 downto 0);
b : OUT std logic vector(3 downto 0)
);
END COMPONENT;

Maharashtra State Board of Technical Education 104



Very Large Scale Integration with VHDL (22062)

--Inputs
signal a : std_logic vector(1 downto 0) := (others =>'0");
--Outputs
signal b : std_logic_vector(3 downto 0);

BEGIN

-- Instantiate the Unit Under Test (UUT)
uut: decoderl PORT MAP (
a=>a,
b=>b
);

-- Stimulus process
stim_proc: process
begin
-- hold reset state for 100 ns.
wait for 100 ns;

a<="00";

wait for 100 ns;
a<="01";

wait for 100 ns;
a<="10";

wait for 100 ns;
a<="11"
walit;

end process;

END;

Problem statement for student: Design VHDL Code for 3 to 8 decoder using if else
statement.

Step 1: Develop VHDL code.
VHDL Code using case statement.
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Step 2: Develop Test Bench file for simulation.
VHDL Code

X1l Resources Used

Sr. No. Instrument /Components Specification Quantity

1.

2.

XI  Actual Procedure Followed (use blank sheet provided if space not sufficient)
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XV  Observations (use blank sheet provided if space not sufficient)

Truth table of 2 : 4 decoder is (verified/ not verified) using FPGA
development board.

XVI Result (Output of the Program)

XVII Interpretation of Results (Give meaning of the above obtained results)

XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the
interpretation of results)

XIX Practical Related Questions

Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO

1. Design VHDL Code using FPGA board for 3 : 8 decoder using case statement.

2. Design VHDL Code using FPGA board for 4 : 16 using if else statement.

3. Design VHDL Code using FPGA board for 4 : 16 decoder using case statement

[Space for Answers]
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XX  References / Suggestions for further reading
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/u

1.

2.
3.
4.

g usb_blstr ii_cable.pdf

https://www .xilinx.com/support/documentation/data_sheets/ds610.pdf

https://www.elprocus.com/designing-3-line-to-8-line-decoder-demultiplexer/

https://www.rfwireless-world.com/source-code/VHDL/3-8-decoder-vhdl-

code.html

XXI  Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA Board 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission of report, Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained

Process Product Total
Related (15) | Related (10) | (25)

Dated signature of Teacher
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Vi

Vil

Practical No. 10: Implement 8:3 Encoder using FPGA.

Practical Significance

Binary encoder has 2" input lines and n-bit output lines. It canbe 4 : 2,8 : 3 and 16 : 4
line configurations. VHDL Code for encoder can be designed both in structural and
behavioral modeling. This practical will help the students to develop programming
skills that is Implement a encoder application on FPGA board using Xilinx ISE tools.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain FPGA based circuits’.

e Develop ‘“VHDL’ code using IDE tools.

e Use Input/output port pins of FPGA.

e Interface FPGA KIT and desktop PC.

Relevant Course Outcome(s)
Develop basic applications using VHDL.

Practical Outcome
Debug VHDL programme for the given application.

Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.

e Follow ethical practices.

Minimum Theoretical Background
Binary encoder :- Priority Encoder generally, digital encoders produce outputs of 2-

bit, 3-bit or 4-bit codes depending upon the number of data input lines. An “n-bit”
binary encoder has 2" input lines and n-bit output lines with common types that
include 4:2, 8:3 and 16:4 line configurations. VHDL Code of 8:3 encoder can be
easily implemented with structural and behavioral modeling.
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Lowset Friorite |nputs Outpute
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[ : 0O 000 O0ODO0OOD0D 7 o0 0 0
e el ¢ 0 0D0DODODOD 1T x |00 1
Dg—hp?i;r?w . o 00000 1xx|010
D“_'"Enmder - 00D D 1 xx x |0 11
e 0 00 1 x xx x|100
B 0001 %2 v xx %2 |10 1
[l i I 1 = = = x = x 1 1 0

Higheet Frigrity 1T x x x x xx x |1 11

Awgdonioars

Fig 10.1: 8:3 Priority Encoder and its Truth Table

VIl  Practical Circuit diagram:
a) Practical JTAG cable setup:-

10-pin Female Connector

(Connects to target printed ("\
drcuit board 10-pin male header.) w

LED Color Description
Off Not connected or suspended i =
Blue Connected at 12MHz (USE full speed)

Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable )

Fig 10.2.a: Practical Setup with JTAG CABLE
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8

Lol Cutput

& ® 5 @ ©

Fig 10.2.b: Lab Practical Setup

b) Create Encoder 8:3 .vhd file :-

# |SE Project Navigator (P.20131013) - F:\l SCHEMENVI SEM | SCHEME\ENCODERETO3\ENCODERETO3.3se - [ENCODERSTO3.vhel] - X
File Edit View Project Source Process Tools Window Layout Help -8 X%
DBHAIL ABEX|0a| [APBRARIAZBDC SR PEL Q
Design 08 X € 19 Py
D View: () {lﬁ}lmp\ementﬁﬁun ® S\mu\aﬁon y=| 20 library
—| 21 IEEE.STD LOGIC 1164.ALL;
_\_g Behavioral v o i _
(3] | Hierarchy w | 23 entity ENCODERSTO3 is
— ﬁ ENCODERATO3 24 Port ( a : in 3TD LOGIC VECTOR (7 downto 0);
at | B £ xe3sS0-5pg208 25 b : out STD LOGIC VECTOR (2 downto 0)):
| & i) ENDCODERTO3 T8~ behavior (EN . | 26 end ENCODERSTO3;
% uut- ENCODERETO3 - Behavie —| 27
A 28 architecture Behavioral of ENCODERETO3 is
% 29 begin
B 30 process(a)
= A 31 begin
- %| 32 caseais
S 2[—| 33 when b <=
) Mo Processes Running Q = e b

b <=
= b <=
= g = 11
b <="1

when

@
n

Processes: ENDCODERSTO3_TB - behavier | — 36  when

B w 15im Simulator 2; :::
P20 Behavioral Check Syntax .

H 2927 2% | v

= 3 39  when => b <= "110";
[ Simulate Behavioral Model 40 when "1 b <= "117:
41

42  when others => b <= "IIL";

43  end case;

44 end process;

P

46 v
< >

& St B Desgn L) Fles [ Ubraries ENCODERSTO3.vhd @| L Desnsummary (utofcate) || o) EVCODERGTO3RMLY) [ | ¥) ENCODERSTO3 (fecht) [ | [E) ENDCODERSTO3 TB.vhd

Errars «08x

< >
Console o Errors ﬂ Warnings 194 FindinFiesResuts 5 View by Category

Fig 10.3: .vhd file
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c) Create Encoder 8:3 test bench file-

ISE Project Navigator (P.20131013) - E\l SCHEMEV! SEM | SCHEME\ENCODERSTO3\ENCODER8TO3.xise - [ENDCODERBTO3_TB.whd] - X
File Edit View Project Source Process Tools Window Layout Help
o Y | »
Design R 24 o
View: () Imp\ementaﬁon ® @S\mu\aﬁon 25
Behavioral v 26
Hierarchy
(5] ENCODERSTO3
B £ xc3s30-5pq208
= ENDCODERSTO3_TB - behavior (El
uut - ENCODERBTO3 - Behavie
4
= %
L
%
: ]
< > =
) Mo Processes Running - . i
{ Processes; ENDCODERETO3_TE - behavior
. NCODERSTO3
E{ = y ISim Simulator
W BETANREh L] a: IN std
I:?f @ Simulate Behavioral Model b OUT s
H 1 downto Q) := (others => '0'); v
{ >
Start & Design ) Files ID Libraries ENCODERSTO3.vhd £ Design Summary (out of date) ,_: ENCODERSTO3 (RTLL) f ENCODERSTO3 (Tech1) ENDCODERSTO3 TBvhd [
Errors 08X
< >
Ej Cansole 0 Erors 1\ Wamings [§ FindinFlesResuts &3 View by Category
Fig 10.4: Test bench file
d) Encoder 8:3 test bench Simulation waveforms-
£ 1Sim (P.20131013) - [Default.wefg] - X

jFMe Edit View Simulation Window Layout Help

DAL XBEX®|® o|ME EETS AR ALBAIR x|t 0@ b [Los]b [J Redaunch

=] Default.wefg B

Fig 10.5: Simulation output.
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e) Actual Experimental set up used in laboratory

IX Resources Required

Sr. Instrument /

No. | Components Specification Quantity
1. | FPGA Device: Xilinx FPGA (XC3S400 PQ208),0n board | 1 No.
Development | +5V, +3.3V, +2.5V supply to FPGA and other
kit hardware circuit., On board, 2 Crystal 8MHz and

25MHz.JTAG Interface ( Boundary Scan ),PROM
Interface (XCF02S),40 pin, 4 header connector for
external I/O's

2. | Desktop PC Loaded with open source IDE, simulation and 1 No.
program downloading software.

X Precautions to be followed
1. Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.

Xl Procedure
1. Create the Xilinx ISE project for your top-level FPGA design, by doing the
following in ISE:

In the ISE software, select File > New Project.
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In the Project name and Project location fields, enter the project name and location,
respectively.
Select HDL or Schematic as the Top-level source type, and click Next.

2. Create New Source file. Select Source Type” select the Source type and give the

name to the source then click “Next”.

Define Module”. Enter the entity used in design and then click “Next”.

4. Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic. Ref Fig 10.3.

5. Create Test Bench file- A test bench is HDL code that allows you to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing. Ref Fig no.10.4.

6. Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation.

7. In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioural
Check Syntax” to make sure that you didn’t make any syntax errors while making
changes.

8. Double click on “Simulate Behavioural Model” in the “Process Pane”, which will
open the ISim software with your test bench loaded.

9. ISim simulator window will open with your simulation executed, as shown in Ref
Fig no.10.5. where you are able to simulate your designs and check for errors.

10. After simulation implement 8:3 encoder using FPGA development board.

11. Go to User Constraints — select Floorplan Area/IO/Logic (PlanAhead) — Windows
— Properties — now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run

14. Go to Config.. Target Device and Run — Impact wizard opened — select Device 2
(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx
IC And select Program.

[98)

SAMPLE PROGRAM 1:Step 1. Develop VHDL code for 8:3 Encoder

VHDL Code using Case statement

library IEEE;
use IEEE.STD LOGIC 1164.ALL;

entity ENCODERSTO3 is
Port (a:in STD LOGIC VECTOR (7 downto 0);
b:out STD LOGIC VECTOR (2 downto 0));
end ENCODERSTO3;

architecture Behavioral of ENCODERSTO3 is
begin

process(a)

begin

case a is

when "00000001" =>b <="000";
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when "00000010" =>b <="001";
when "00000100" =>b <="010";
when "00001000" =>b <="011";
when "00010000" =>b <="100";
when "00100000" =>b <="101";
when "01000000" =>b <="110";
when "10000000" =>b <="111";

when others => b <="ZZ7";
end case;

end process;

end Behavioral,;

Step 2: Develop Test Bench file for simulation.

VHDL Code

LIBRARY ieee;
USE ieee.std logic 1164.ALL;

ENTITY ENDCODERSTO3 TB IS
END ENDCODERSTO3 TB;

ARCHITECTURE behavior OF ENDCODERSTO3 TB IS
-- Component Declaration for the Unit Under Test (UUT)

COMPONENT ENCODERSTO3

PORT(
a:IN std logic_vector(7 downto 0);
b: OUT std logic vector(2 downto 0)
);

END COMPONENT;

--Inputs
signal a : std_logic_vector(7 downto 0) := (others =>"'0");

--Outputs
signal b : std_logic_vector(2 downto 0);
-- No clocks detected in port list. Replace <clock> below with
-- appropriate port name

BEGIN
uut: ENCODERSTO3 PORT MAP (
a=>a,
b=>b
);
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-- Stimulus process
stim_proc: process
begin

-- hold reset state for 100 ns.
wait for 100 ns;

a<="00000001";
wait for 100 ns;
a<="00000010";
wait for 100 ns;
a<="00000100";
wait for 100 ns;
a<="00001000";
wait for 100 ns;
a<="00010000";
wait for 100 ns;
a<="00100000";
wait for 100 ns;
a<="01000000";
wait for 100 ns;
a<="10000000";
wait;
end process;
END;

Problem statement for student: Design VHDL Code for 8 to 3 encoder using if else

statement.
Step 1: Develop VHDL code.

VHDL Code using if else statement
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Step 2: Develop Test Bench file for simulation.
VHDL Code

XI1 Resources Used

Sr.

No Instrument /Components Specification Quantity

1.

2.

X1  Actual Procedure Followed (use blank sheet provided if space not sufficient)
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XV  Observations (use blank sheet provided if space not sufficient)

Truth table of 8:3 encoder is (verified/ not verified) using FPGA development
board.

XVI Result (Output of the Program)

XVII Interpretation of Results (Give meaning of the above obtained results)

XVI1II Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)

XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. Design VHDL Code using FPGA board for 8:3 priority encoder using when
statement.
2. Design VHDL Code using FPGA board for 16:4 priority encoder using if else
statement.

[Space for Answers]
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XX  References / Suggestions for further reading

1.
2.
3.
4.

5.

https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/u
g usb_blstr ii_cable.pdf
https://forums.xilinx.com/
https://www.electronics-tutorials.ws/combination/comb_4.html
https://circuitdigest.com/tutorial/encoder-circuit-basics-truth-table-and-

explanations

https://www.technobyte.org/vhdl-code-for-an-encoder-dataflow/

XXI Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA board 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission of report, Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained
Process Product Total
Related (15) | Related (10) (25)

Dated signature of Teacher
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Vi

Vil

Practical No. 11: Implement up-counter using FPGA.

Practical Significance

A counter is a device which stores the number of times a particular event or process
has occurred, often in relationship to a clock signal. There are two types of counters:
a)up counters b)down counters.

This practical will help the students to develop programming skills i.e. up-counter
(MOD-N) application on FPGA board using Xilinx ISE tools.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronics circuits and equipments.’

e Develop ‘VHDL’ code using EDA tools.

e Use Input/output port pins of FPGA.

e Interface FPGA KIT and desktop PC.

Relevant Course Outcome(s)
Debug VHDL programme for the given application.

Practical Outcome
Implement up-counter using FPGA.

Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.

e Follow ethical practices.

Minimum Theoretical Background

An Asynchronous counter can count using Asynchronous clock input. Counters can be
easily made using flip-flops. As the count depends on the clock signal, in case of an
Asynchronous counter, changing state bits are provided as the clock signal to the
subsequent flip-flops. Those Flip-flops are serially connected together, and the clock
pulse ripples through the counter. Due to the ripple clock pulse, it’s often called a
ripple counter. An Asynchronous counter can count 2" — 1 possible counting states.
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Modulo or MOD counters are one of those types of counters. The configuration made
in such a way that the counter will reset itself to zero at a pre-configured value and
has truncated sequences.

So, if a counter with the specific number of resolutions (n-bit Resolution) count up to
is called as full sequence counter and on the other hand, if it is count less than the
maximum number, is called as a truncated counter.

To get the advantage of the asynchronous inputs in the flipflop, Asynchronous
Truncated counter can be used with combinational logic.

Modulo 16 asynchronous counter can be modified using additional logic gates and can
be used in a way that the output will give a decade (divided by 10) counter output,
which is useful in counting standard decimal numbers or in arithmetic circuits. This
type of counters called as Decade Counters.

Decade Counters requires resetting to zero when the output reaches a decimal value of
10.Following table shows 0-9 (10 steps) the binary number.

Table: Truth table of MOD 10 counter

CLR CLK 'event | CLK NO. Q3 Q2 Q1 Qo
1 1 0 0 0 0 0
0 1 1 0 0 0 0
0 1 2 0 0 0 1
0 1 3 0 0 1 0
0 1 4 0 0 1 1
0 1 5 0 1 0 0
0 1 6 0 1 0 1
0 1 7 0 1 1 0
0 1 8 0 1 1 1
0 1 9 1 0 0 0
0 1 10 1 0 0 1
Qo Q1 Q2 Q3
T 0 T Q T 0 T E!J
Data [N ——7Clk Q' fo———Clk Q'fo——Clk Q' fp———Clk '
R R R R
| ‘ ‘ ‘

Fig. 11.1.a: Four bit up-counter (MOD-10/ Decade counter)
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1 2 3 « & g 7 8 2 1 1 12 1 14 15 16

sf UV UUUHUULUUL
| |
:JT{» | 1 F 1 F | 1 r Y Ln;m.b.;-

I |
I |

a3 | t ¥ |
| |

az |

i
(i : ¥ ek}

Fesat Fulas

I
CLAY
1

OFG0 ARI1 9010 0811 B 1M @i1d 911 1803 1081 | oemr  enm omm e GO @@ Gt
Gount® 1 2 F 4 & &% 7 & ¥ " ®# 1 2 I 4 & 6

Fig. 11.1.b: Four bit up-counter (MOD-10/ Decade counter) timing waveforms.

VIl Practical Circuit diagram:
a) Practical JTAG cable setup:-

10-pin Female Connector

(Connects to target printed (“\
circuit board 10-pin male header.) >
g SR @)

LED Color Description
Off Not connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Green flickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable ")

Fig. 11.2.a: Practical Setup with JTAG CABLE
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Pruamn Bt Sl
il A
s""l LS

Laglc Output

® 9 s @D

Digital Input Output imerface Board

Fig. 11.2.b: Lab Practical Setup

b) Create binary to Up-counter .vhd file diagram :-

# ISE Project Navigator (P.20131013) - FAl SCHEMEYI SEM | SCHEME\pulkit\mod 10count\mod10count.xise - [mod10.vhd"] - X
File Edit View Project Source Process Tools Window Layout Help -8 x
DAL % Xwa| AFBRARABEDLRIPELD
5 [Desion #08X E[ 24 entity modlo is @
“; [} | View: ® {8} Implementation ) 25 Port ( CLK , LOAD: in
26 CIR : in )
0 ‘E Hierarchy 27 Q : inout std logic_vector (3 downto 0));
£ | ) modidcount - 28 end modl0;
a5l® [+ XE35A00-5pq208 e
#h [Befls mod10 - Behavioral (mod10.vhd) 30 architecture Behavioral of modlo is
a °| =
= —| 32  signal tmp: std logic vector(3 downto 0):
A 33 begin
2 o | 34 process (CLK, CLR)
= 35
- % 36 begin
- % 37
—| 38 if (CLK'EVENT AND CLK='1'} then
O 39 IF CLR="1" then
(5] 40 tmp <= " "y
No Processes Runnin
Al ¢ 41 elsif load = 'l' then
T | Processes: mod10 - Behavioral Q 42 if tmp " then
2 £ Design Summary/Reports b Tmp <= "0000";
= Design Utilities 44 else wp <= tmp + "00
A User Constraints 45 end if;
— | = T2E) Synthesize - XST 46 _ end if;
View RTL Schematic & end 1f;
View Technology Schematic 8
¥)  Check Syntax 29 end process;
¥)  Generate Post-Synthesis Simulation M... S0 Q <= tmp;
Q) Implement Design 51 v
F)  Generste Programming File < >
@ Configure Target Device || % Design Summary (out of date) mod10.vhd™ [ x] mod10_th10.vhd
Console P =N-
ISim simulation engine GUI launched successfully ~
Process "Simulate Behavioral Model" completed successfully
v
< >

Console @ Evors 1\ Wamings [ Findin Fles Results

Fig. 11.3: .vhd file diagram
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c) Create binary to Up-counter test bench file-

ISE Project Navigator (P.20131013) - FAl SCHEME\VI SEM | SCHEME\pulkit\mod10count\mod 10countdse - [mad10_tb10.vhd]
[2) File Edit View Project Source Process Tools Window Layout Help

hE; el [ APBRPRIA BRI SR PP
£ [Desin ~08x g 77 wait for CLK period/2;
@ view: (O {8 implementation (8) [ Smuiation - 78 CLE <= '1';
'EJ Behavioral v "7:1 wait for CLK period/2:
w [ 80 end process;
% [j'zl Hierarchy = 81
il ] mod1bcount 82
- 3 xc3s400-5pq208 83 -- Stimmlus proce
- = mad10_th10 - behavior (mod10_tb10.vhd) 84 stim proc: process
& uut - mod10 - Behavioral (mod10.vhd) 85 begin
A| =6 -- hold
. % 87 wait for
= 88
e g8
- 89
% a0 wait for CLK period*10;
- 91 clrg= '1';
Q| o wait for 100 ms:
» | B2 Mo Pracesses Running 93> clre= '0Yy
94 wait for 100 ns;
7 | Processes: mod10_tb10 - behavior 1 load <='1';
£ 5% IsimSimulster 96
72(0) Behavioral Check Syntax 27 )
1 [ Simulate Behavioral Model o8 77 imsert Stimalus hers
99
m 100 wait;
101 end process;
102
103 END;
104
<
£ Design Summary (Implemented) mod10.vhd mod10_th10.vhd
Console

I5im simulation engine GUI launched successfully

Process "Simulate Behavioral Model" completed successfully

<
2 cosoe @ Emors 1) Wamings (@ Findin FiesResults

Fig. 11.4: test bench file diagram

d) binary to Up-counter test bench Simulation waveforms-

X
~
v

>
<08 x
~
v

>

Fig. 11.5: Simulation diagram
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e) Actual Experimental set up used in laboratory

IX

Resources Required

Sr.
No

Instrument
/Components

Specification

Quantity

1.

FPGA
Development
kit

Device: Xilinx FPGA (XC3S400 PQ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other
hardware circuit.,On board, 2 Crystal 8MHz and
25MHz.JTAG Interface ( Boundary Scan ),PROM
Interface (XCF02S),40 pin, 4 header connector for
external I/O's

1 No.

Desktop PC

Loaded with open source IDE, simulation and program
downloading software.

1 No.

Xl

Precautions to be followed
Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.

1.

Procedure
Create the Xilinx ISE project for top-level FPGA design, by doing the following

1.

in ISE:

In the ISE software, select File > New Project.
In the Project name and Project location fields, enter the project name and location,

respectively.

Select HDL or Schematic as the Top-level source type, and click Next.
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2. Create New Source file. Select Source Type” select the Source type and give the

name to the source then click “Next”.

Define Module”. Enter the entity used in design and then click “Next”.

4. Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic. Ref Figno.11.3.

5. Create Test Bench file- A test bench is HDL code that allows to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing. Ref Figno.11.4.

6. Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation. Or
Directly go to simulation tab — Process DAC behavioural — ISim simulator—select
input entity bit — right click — select Force constant.

7. In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioural
Check Syntax” to make sure that didn’t make any syntax errors while making
changes.

8. Double click on “Simulate Behavioural Model” in the “Process Panel”, which will
open the ISim software with test bench loaded.

9. ISim simulator window will open with simulation executed, as shown in Ref Fig
no.14.3.b where able to simulate designs and check for errors.

10. After simulation Implement up-counter using FPGA.

11. To create .ucf file -- Go to User Constraints — select Floorplan Area/IO/Logic
(PlanAhead) — Windows — Properties — now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run

14. Go to Configure Target Device and Run — Impact wizard opened — select Device 2
(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx
IC And select Program.

15. Verify expected result on relevant FPGA lab kit.

(O8]

SAMPLE PROGRAM 1: Step 1.Develop VHDL code for Mod-10 Up-counter

VHDL Code using If else statement

library IEEE;
use [IEEE.STD LOGIC 1164.ALL;
use ieee.std logic_signed.all;

entity mod10 is
Port (CLK , LOAD: in STD_LOGIC;
CLR :in STD LOGIC;
Q : inout std_logic_vector(3 downto 0));
end mod10;

architecture Behavioral of mod10 is
signal tmp: std_logic_vector(3 downto 0);

begin
process (CLK, CLR)

Mabharashtra State Board of Technical Education 129




Very Large Scale Integration with VHDL (22062)

begin

if (CLK'EVENT AND CLK='1") then
IF CLR="1" then
tmp <="0000";
elsif load ='1' then
if tmp <="1001" then

tmp <= "0000";
else tmp <= tmp + "0001";
end if;
end if;

end if;

end process;
Q <= tmp;

end Behavioral;

Step 2: Develop Test Bench file for simulation.

VHDL Code

LIBRARY ieee;
USE ieee.std logic 1164.ALL;

ENTITY mod10 tb10 IS
END mod10_tb10;

ARCHITECTURE behavior OF mod10_tb10 IS

-- Component Declaration for the Unit Under Test (UUT)
COMPONENT mod10
PORT(
CLK : IN std logic;
LOAD : IN std logic;
CLR : IN std logic;
Q : INOUT std logic_vector(3 downto 0)
);
END COMPONENT;
--Inputs
signal CLK : std_logic :="'0";
signal LOAD : std_logic :='0";
signal CLR : std_logic :="'0";

--BiDirs
signal Q : std_logic_vector(3 downto 0);

-- Clock period definitions
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constant CLK period : time := 10 ns;

BEGIN
-- Instantiate the Unit Under Test (UUT)
uut: mod10 PORT MAP (

CLK => CLK,

LOAD => LOAD,

CLR =>CLR,

Q=>Q

);

-- Clock process definitions
CLK process :process

begin
CLK <="0"
wait for CLK period/2;
CLK <="'1";
wait for CLK period/2;
end process;

-- Stimulus process
stim_proc: process
begin
-- hold reset state for 100 ns.
wait for 100 ns;

wait for CLK_period*10;

clr<="1";

wait for 100 ns;
clr<="0";

wait for 100 ns;
load <='1";

wait;
end process;

END;
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Problem statement for student: Design VHDL Code for Mod-6 counter using if else
statement.
Step 1.Develop VHDL code for Mod-6 Counter

VHDL Code

Step 2: Develop Test Bench file for simulation.

VHDL Code
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X1l Resources Used
Sr.
No.
1.

Instrument /Components Specification Quantity

2.

XII  Actual Procedure Followed (use blank sheet provided if space not sufficient)
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XV  Observations (use blank sheet provided if space not sufficient)

Truth table of Binary Mod-6 up-counter is (verified/ not verified) using
FPGA development board.

XVI Result (Output of the Program)

XVII Interpretation of Results (Give meaning of the above obtained results)

XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the
interpretation of results)

XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1.Design VHDL Code using FPGA board for Binary Down-counter.

[Space for Answers]
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XX  References / Suggestions for further reading
1. https://www.pantechsolutions.net/vhdl-code-to-simulate-4-bit-binary-counter-by-

software-using-spartan-3-starter-kit

https://www .xilinx.com/support/documentation/data_sheets/ds610.pdf
https://forums.xilinx.com/
https://www.youtube.com/watch?v=VeKDFGoqwgU
https://www.geeksforgeeks.org/differences-between-synchronous-and-

SNk

asynchronous-counter/

XXI  Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connection s to FPGA board. 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission of report, Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained

Process Related
(15)

Product Related
(10)

Total
(25)

Dated signature of Teacher
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Vi

Practical No. 12: Implement synchronous counter using FPGA.

Practical Significance

In Synchronous Counter all the individual output bits changing state at exactly the
same time in response to the common clock signal with no ripple effect and therefore,
no propagation delay in the system.

Synchronous Counter, the external clock signal is connected to the clock input of
every individual flip-flop within the counter so that all of the flip-flops are clocked
together simultaneously (in parallel) at the same time. In other words, changes in the
output occur in “synchronization” with the clock signal.

This practical will help the students to develop programming skills that is up/down
synchronous counter application on FPGA board using Xilinx ISE tools.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronics circuits and equipment.’

e Develop ‘VHDL’ code using EDA tools.

e Use Input/output port pins of FPGA.

e Interface FPGA KIT and desktop PC.

Relevant Course Outcome(s)
Debug VHDL programme for the given application.

Practical Outcome
Implement up-counter using FPGA.

Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.
e Follow ethical practices.
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Vil

Minimum Theoretical Background
In Asynchronous binary counter the output of one counter stage is connected directly
to the clock input of the next counter stage and so on.
The result of this is that the Asynchronous counter suffers from what is known as
“Propagation Delay” in which the timing signal is delayed a fraction through each flip-
flop. The solution over this problem is synchronous counter.
In synchronous counters, the clock inputs of all the flip-flops are connected together
and are triggered by the input pulses.
There are two types of counter:
a) Up counter
b) Down counter.
As well as counting “up” from zero and increasing or incrementing to some preset
value, it is sometimes necessary to count “down” from a predetermined value to zero
allowing us to produce an output that activates when the zero count or some other pre-
set value is reached.

Table 12.1: Truth table of Up / down Synchronous counter.

CLK ' event UP_DOWN Q3 | Q2 | Q1 | Q0| UP.DOWN [[Q3 | Q2| Q1| QO
1 1 0 0 0 0 0 1 1 1 1
1 1 0 0 0 1 0 1 1 1 0
1 1 0 0 1 0 0 1 1 0 1
1 1 0 0 1 1 0 1 1 0 0
1 1 0 1 0 0 0 1 0 1 1
1 1 0 1 0 1 0 1 0 1 0
1 1 0 1 1 0 0 1 0 0 1
1 1 0 1 1 1 0 1 0 0 0
1 1 1 0 0 0 0 0 1 1 1
1 1 1 0 0 1 0 0 1 1 0
1 1 1 0 1 0 0 0 1 0 1
1 1 1 0 1 1 0 0 1 0 0
1 1 1 1 0 0 0 0 0 1 1
1 1 1 1 0 1 0 0 0 1 0
1 1 1 1 1 0 0 0 0 0 1
1 1 1 1 1 1 0 0 0 0 0

Note: UP. DOWN =1 - UP counter
UP_DOWN =0 - DOWN counter
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o - = = b= b= = Least Significant Bit

— Most Significant Bit

Figure 12.1: Four bit Up counter timing waveform.

VIl Practical Circuit diagram:
a) Practical JTAG cable setup:-

10-pin Female Connector
(Connects to target printed
aircuit board 10-pin male header.)

LED Color Description

Off Not connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 460MHz (USB high speed)
Green JTAG port open, idle

Greenflickering | JTAG port open, active
Magenta blinking | Set by user to identify a cable "

Figure 12.2.a: Practical Setup with JTAG CABLE
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p

€

"

Laglc Output

® 9 s @D

Digital Input Output imerface Board

Figure 12.2.b: Lab Practical Setup

b) Create 4 bit Up/down counter .vhd file :-

# |SE Project Navigator (P.20131013) - FAl SCHEME\NEWUP_DOWN_SYNC\NEWUP_DOWN_SYNC xise - [counter_up_down_sync.vhd] X
File Edit View Project Source Process Tools Window Layout Help - 8 X%
LDAEF L isDbEX|wd| fA,2RRLARIAZEDDERPEL)D
Design +08X% 4 1 library ieee; ~
D View: (O {lﬁ}lmp‘em&nﬁﬁun ® S\mu\aﬁun 5 2 use ieee.std logic 116 H
@ Behavioral ] — 3 use ieee.std logic w ned.all;
4
H; Hierarchy [ 5 entity counter up_down_sync is
— | 5] NEWUP_DOWN_SYNC [ port (
41t | B €3 xc3s400-5pq208 7 CLK, CLR, UP_DOWN : in std lagic;
E 2 8 Q : out std logic_vector (3 downto 0));
=l 'l uut - counter_up_down_sync - archi (count — g
A 10 end counter_up_down sync;
@ % 11 . . .
= 12 architecture archi of counter_up_down sync is
- A 13
* 14 signal tmp: std logic_vector(3 downtoe 0);
—_ 15
< > Q 16 Dbegin
'\,) 17
| #2 Mo Processes Running —| 18 process (CLK, CLR)
— 18 begin
?{ Processes: NEWUP_DOWN_SYNC_TB - behavior 20
E’j: B & 1Sim Simulator 21 if RISING EDGE (CLK) then
= P2 Behavioral Check Syntax 22
i Simulte Behavioral Model 23 if (CLR='1') cthem
- 24 tmp <= "00007;
25
26 elsif (UP_DOWN='1') then
27 tmp <= tmp + " H
28 ELSE tmp <= tmp - :
28 end if;
an h
< >
P Design Summary (Synthesized) counter_up_down_sync.vhd a | NEWLUP_DOWN_SYNC_TB vhd*
Consale +08x
P INFO:ProjectMgmt - Parsing design hierarchy completed successfully. "
v
>

<
Console o Errors _t_\, Warnings

Figure 12.3: .vhd file
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c) Create 4 bit Up/down counter test bench file-

ISE Project Navigator (P.20131013) - F:\l SCHEME\NEWUP_DOWN_SYNC\NEWUP_DOWN_SYNC ise - [NEWUP_DOWN_SYNC_TB.vhe*] - X
File Edit View Project Source Process Tools Window Layout Help
O2Ed 5 wa| A ALRX AR BHADS SR PEL
Design «+08x g 71 begin ~
view: (O {83} mplementation @) & Simuiation 5 72 CLE <= '0';
sehaviaral » 73 wait for CLE_period/2;
74 CLK <
Hierarchy “w 75 wait for CLK period/2:
=] NEWUP_DOWN_SYNC 76 end process;
B €3 xc3s400-5pq208 77
2| [ NEWUP.DOWN SYNC_TE - behavior (NEWUP_ 78
& uut - counter_up_down_sync - archi (count| 79
A
\ Y
B -- nol
= A wait for 100 ns;
T /’
= wait for CLK period<l0:
< b4 -t
clr<= '1';
| T2 No Processes Running walt for 100 ns;
clre= '0';
4 | Processes: NEWUP_DOWN_SYNC_TB - behavior 50 wait for 1000 ns;
[ B3 15im Simulator 91 UP_DOWN <= '1':
T)  Behavioral Check Syntax 52 wait for 100 ns;
E [ Simulate Behavioral Model 93 UP_DOWN <= '1':
= 54 walit;
g5
Se end process;
a7
83 END:
g
v
< >
5l Design Summary (Synthesized) counter_up_down_syne.vhd NEWLP_DOWN_SYNC_TB.vhd* [
Console 08 x
I} INFO:ProjectMgmt - Parsing design hierarchy completed successfully. ~
v
< >
5 consoe @ Emors £\ Wamings
d) 4 bit Up/down synchronous counter test bench Simulation waveforms-
£ 1Sim (P.20131013) - [Default.wefg] - X

File Edit View Simulation Window Layout Help

ODFH L EDEX®|w oM@ ) B A M= Rliw=|t =@ b pE[ro0s|v (3 Redaunch
+

¥

2

2
o
/

(<]

Q

1w

=

=

18 clic_period

| Defauit.wefy [ x]
Conscle +08x
WARNING: Please use Xiinx License Configuration Manager to check out a full 15im license. ~

WARNING: ISim will run in Lite mode. Please refer to the ISim documentation for mere information on the differences between the Lite and the Full version,

This is 3 Lite version of I5im.

Time resolution is 1ps

Simulator is doing circuit initialization process,

Finished drcuit initialization process.

at 5 ns(1), Instance fnewup_down_sync_thfuuty : Warning: There is an 'UTXTW[Z| in an arithmetic operand, the result will be ¥ (es).

1Sim> v

@ console [] Compiationlog @ Breakpoints (g FindinFiesResults [gf SearchResuits

Figure 12.5: Simulation output
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e) Actual Experimental set up used in laboratory

IX Resources Required

Eg_ /CI:r:)sr;r;;Jonr]lgrr::s Specification Quantity
1. | FPGA Device: Xilinx FPGA (XC3S400 PQ208),0On board | 1 No.
Development | +5V, +3.3V, +2.5V supply to FPGA and other hardware
kit circuit., On board, 2 Crystal 8MHz and 25MHz.JTAG
Interface ( Boundary Scan ),PROM Interface
(XCF02S),40 pin, 4 header connector for external 1/O's
2. | Desktop PC Loaded with open source IDE, simulation and program | 1 No.
downloading software.
X Precautions to be followed
1. Use proper Mains cord.

2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.

XI Procedure
Create the Xilinx ISE project for top-level FPGA design, by doing the following

1.

in ISE:

In the ISE software, select File > New Project.
In the Project name and Project location fields, enter the project name and location,

respectively.

Select HDL or Schematic as the Top-level source type, and click Next.
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2. Create New Source file. Select Source Type” select the Source type and give the
name to the source then click “Next”.

3. Define Module”. Enter the entity used in design and then click “Next”.

4. Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic. Ref Figno.12.3.

5. Create Test Bench file- A test bench is HDL code that allows to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing. Ref Figno.12.4.

6. Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation.

7. In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioural
Check Syntax” to make sure that didn’t make any syntax errors while making
changes.

8. Double click on “Simulate Behavioural Model” in the “Process Pane”, which will
open the ISim software with r test bench loaded.

9. ISim simulator window will open with simulation executed, as shown in Ref Fig
no.12.5. where able to simulate designs and check for errors.

10. After simulation implement UP counter using FPGA development board.

11. Go to User Constraints — select Floorplan Area/IO/Logic (Plan Ahead) — Windows
— Properties — now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run

14. Go to Configure Target Device and Run — Impact wizard opened — select Device 2

(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx
IC And select Program.

SAMPLE PROGRAM 1: Step 1.Develop VHDL code for 4 bit Up/down synchronous counter

VHDL Code using When statement

library ieee;
use ieee.std logic 1164.all;
use ieee.std logic unsigned.all;

entity counter up_down_sync is
port(

CLK, CLR, UP_DOWN : in std_logic;
Q : out std_logic_vector(3 downto 0));

end counter up down_sync;

architecture archi of counter up down_sync is
signal tmp: std_logic vector(3 downto 0);
begin

process (CLK, CLR)
begin
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if RISING_ EDGE(CLK) then

if (CLR="1") then
tmp <= "0000";

elsif (UP_ DOWN='1") then
tmp <= tmp + "0001";
else tmp <= tmp - "0001";

end if;
end if}
end process;
Q <= tmp;
end archi;

Step 2: Develop Test Bench file for simulation.

VHDL Code

LIBRARY ieee;
USE ieee.std logic 1164.ALL;

ENTITY NEWUP_DOWN_SYNC_TB IS
END NEWUP_DOWN_SYNC_TB;

ARCHITECTURE behavior OF NEWUP_DOWN_SYNC TB IS
-- Component Declaration for the Unit Under Test (UUT)

COMPONENT counter up down_sync
PORT(
CLK : IN std logic;
CLR : IN std logic;
UP_DOWN : IN std logic;
Q : OUT std logic vector(3 downto 0)
);
END COMPONENT;

--Inputs

signal CLK : std logic :='0";

signal CLR : std logic :='0";

signal UP_DOWN : std_logic :="'0";

--Outputs
signal Q : std_logic vector(3 downto 0);

-- Clock period definitions
constant CLK period : time := 10 ns;
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BEGIN

-- Instantiate the Unit Under Test (UUT)
uut: counter up down sync PORT MAP (
CLK => CLK,
CLR => CLR,
UP_DOWN =>UP DOWN,
Q=>Q
);

-- Clock process definitions
CLK process :process

begin
CLK <='0"
wait for CLK period/2;
CLK <="11
wait for CLK period/2;
end process;

-- Stimulus process
stim_proc: process
begin
-- hold reset state for 100 ns.
wait for 100 ns;

wait for CLK period*10;

clr<="1";
wait for 100 ns;
clr<="0";
wait for 1000 ns;
UP_DOWN <="1";
wait for 100 ns;
UP_DOWN <="1";
wait;

end process;

END;

Problem statement for student: Design VHDL Code for 3 bit up/down synchronous counter
using if else statement logic gates etc.
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Step 1.Develop VHDL code for 3 bit up/down synchronous counter

VHDL Code

Step 2: Develop Test Bench file for simulation.

VHDL Code
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XI1 Resources Used

Sr. No. | Instrument/Components Specification Quantity

1.

2.

3.

XI  Actual Procedure Followed (use blank sheet provided if space not sufficient)

XIV  Precautions Followed (use blank sheet provided if space not sufficient)

XV  Observations (use blank sheet provided if space not sufficient)

Truth table of up/down synchronous counter is (verified/ not verified) using
FPGA development board.

XVI Result (Output of the Program)
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XVII Interpretation of Results (Give meaning of the above obtained results)

XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)

XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO

1. Design VHDL Code using FPGA board for 3 Bit Binary Down-counter.

[Space for Answers]
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XX  References / Suggestions for further reading
https://www.pantechsolutions.net/vhdl-code-to-simulate-4-bit-binary-counter-by-

1.

2.
3.
4.

software-using-spartan-3-starter-kit
https://circuitdigest.com/tutorial/synchronous-counter
https://forums.xilinx.com/

https://www.geeksforgeeks.org/differences-between-synchronous-and-

asynchronous-counter/

XXI Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA board. 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission of report, Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained

Process Product Total
Related (15) | Related (10) (25)

Dated signature of Teacher
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Practical No. 13: Implement binary to gray code converter using FPGA.

VI

Vil

Practical Significance

Binary Number is normally used number system in digital electronics. In many
applications coding is essential and for the purpose variation in binary number system
is required. For such applications excess-3, gray code and other coding methods are
used. The Gray code was originally designed to prevent undesired transient states or
outputs from electro- mechanical switches. Today, this code is used to facilitate error
correction in digital communications and instrumentation This practical will help
students to develop programming skills that is Binary to Gray code converter
application on FPGA board using Xilinx ISE tools.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronics circuits and equipments.’

e Develop ‘VHDL’ code using EDA tools.

e Use Input/output port pins of FPGA.

e Interface FPGA KIT and desktop PC.

Relevant Course Outcome(s)
Debug VHDL programme for the given application.

Practical Outcome
Implement binary to gray code converter using FPGA.

Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.

e Follow ethical practices.

Minimum Theoretical Background
Gray Code system is a binary number system in which every successive pair of

numbers differs in only one bit. It is used in applications in which the normal sequence
of binary numbers generated by the hardware may produce an error or ambiguity
during the transition from one number to the next.
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Vil

For example, the states of a system may change from 3(011) to 4(100) as- 011 — 001
— 101 — 100. Therefore there is a high chance of a wrong state being read while the

system changes from the initial state to the final state.

This could have serious consequences for the machine using the information. The
Gray code eliminates this problem since only one bit changes its value during any

transition between two numbers

Gray code equivalent of the given binary number is computed as follows:
G3 = B3

Gz = B3 XOR B2

G] = B2 XOR B1

G() = B1 XOR Bo

A binary to gray code converter can be implemented using XOR gates. For n input,

n-1 gates are required. As shown in fig.. 13.1 for 4 inputs, 3 XOR gates are used.

Binary Gray Cade
by [ba[bi bo[[es]e]a|eo
o[olo oflaJo|o]o
D100 1 0lo]l0]1
Dl1ae]1 0 0l]o]l1]1
p|lol1 1foJof1]0
o[1]o0o ofaJ1[1]o
o|[1lo 1ol 21]1
B, G, D11 offofl1[o]|1
o111 1flolr1|o]o
B, D_ G, 1Ljo]o off1]trt]ofo
t{ofo 11101
D— G 1lo|1 of1[1[1][1
B, 1 i1[o[1 1[[1[1[1]0
L]{1]o of1]Jo]1]o
110 11]ol1]1
B G, I[1[1 of1[o[o]1
0 1|11 1fr1]Joflofo

Fig 13.1: Binary to Gray Code Converter Table No. 13.1: Truth table

Practical Circuit diagram:
a) Practical JTAG cable setup:-

-pin Female Connector
(Connects to target printed
circuit board 10-pin male header. )

LED Color
Off

ted nded
at 12MHz (USB full speed)
Connected at 480MHz (USB high speed)
JTAG port open, idle

JTAG port open, active

Set by user to identify a cable )

Blue
Teal

Green

Green flickering
Magenta blinking

.’f;l

/
\@
S

= g
a—a

Fig 13.2.a: Practical Setup with JTAG CABLE
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Fig 13.2.b: Lab Practical Setup

Digital Input Output interface Board

b) Create binary to gray code converter .vhd file:-

Laglc Output

» 98 @

. |SE Project Navigator (P.20131013) - FAl SCHEME\VI SEM | SCHEME\BINTOGRAY\BINTOGRAY xise - [binary_2_gray.vhd] X
[2) File Edit View Project Source Process Tools Window Layout Help I
DBEF L soBx/wal[repprElRmsoc[sr)irel@
[Design «+08& x| 1 library IFEE;
1] | View: @ 36} implementation O [ Simulation 2 wse IFEE.STD LOGIC 1164.ALL;
= 3 use IFFE.STD LOGIC_ARITH.ALL:
& "'BE""Y = 4 use IFEE.STD LOGIC_UNSIGNED.ALL:
5] BINTOGRAY - : - -
% - £ xc35400-5pq208 = :
& - [l binary 2 gray - gate level (binary 2 grayvh{ — 7 entity binary 2 gray is
= L 8 porc(
E — 9 bin : in std logic_vector(3 downto 0): --binary input
A 10 G : out std_logic_vector(3 downto 0) --gray code output
| 12
E 1z )i
n A 13
% | 14 end binary 2_gray:
3 &2 6 15
16 architecture gate_level of binary 2_gray is
: ¥ Mo Processes Running ® i
% | Processes: binary_2_gray - gate level Af—| 18 Dbegin
) 18
2| -x gs!gnf}l:.llv_\l.nalylkepans 5,
esign Utlities 21 G(3) <= bin(3);
s User Constraints X q
2|5 63 synthesize- 167 22 G(2) bin(3) xor bin(2);
m (e e 23 G(1) bin(2) xor bin(l);
View Technology Schematic Qc (" < bin{l) mor bin{0):
E)  Check Syntax gz ey
F)  Generate Post-Synthesis Simulation M... b ¢
€2 Implement Design
-0 Generate Programrming Fie . < 5
& Strt 53 Oesign [) Fles [ Libraries | £ Desgnsumary Gynthesized) )| [2) binary_2_gray.vhd 8= binary_2_gray (RTL1) 2]
|View by Category 08 x|
Design Objects of Top Level Block Properties: (No Selection}
Instances = || Ppins “ || signals = | [ Name v Value

o % binary_2_gray

[E] console @ Evors Y Wamings @ FindinFlesResults & Viewby Category

Fig. 13.3: .vhd file
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c) Create binary to gray code converter test bench file-

ISE Project Navigater (P.20131013) - F:\l SCHEME\VI SEM | SCHEME\BINTOGRAY\BINTOGRAY xise - [BINTOGRAY_TB.vhd*]

- x
[2) Fle Edit View Project Source Process Jools Window Layout Help
DEd » BIAI =B D= AR > E £ S
Design a=0-F3 65 G =G ~
view: (O {2} implementation @) Fff Simulation 66 ie
(5] [Behavieral - a
<= (3:3
(72 | Hierarchy =
= '] BINTOGRAY 70
B £ xc3s400-5pq208 7
& =[] BINTOGRAY_TE - behavior (BINTOGRAY_TB.vh 2
uut - binary_2_gray - gate_level (binary_2_g 73
= 4 T
" 5
v < Ed iy €
B Find: v 7
Type: Missing Module |~ [) Options =
80
| B2 Mo Processes Running o
! | Processes: BINTOGRAY_TB - behavior 8. wait for 100 ns;
- 83
| =~  ISim Simulator .
84 bin <=
o ;_) Behavioral Check Syntax ae e e AT meE
7 A 86 bin <=
m 87 wait for 100 ns;
13 bin <=
89 wait for 100 ns;
S0 bin <=
sl wait for 100 ns;
92 v
< >
Start 3 Design U] Fles [[) Lbraries b Design Summar ¥y E binary_2_gray.vhd B BINTOGRAY _TB.vhd* (]
Consale ~08x%
Q) ERROR:ProjectMgmc - 4 error(s) found while parsing design hierarchy. ~
Started : "Launching ISE Text Editor to edit BINTOGRAY TB.vhd".
v
< >

(2] console @ Erors I\ Warnings [p§ Findin Fies Results

Fig. 13.4: Test bench file

d) binary to gray code converter test bench Simulation waveforms-

o O PG Deak
']H\e it e S W Lyt

DVH i X@” (M bl M? /+/-;“1: M%ﬂ |UMELUUUW(€ e

Fig. 13.5: Simulation output
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e) Actual Experimental set up used in laboratory

IX Resources Required

Sr.
No.

Instrument /
Components

Specification

Quantity

1.

FPGA
Development
kit

Device: Xilinx FPGA (XC3S400 PQ208),0n board
+5V, +3.3V, +2.5V supply to FPGA and other
hardware circuit., On board, 2 Crystal 8MHz and
25MHz.JTAG Interface ( Boundary Scan ),PROM
Interface (XCF02S),40 pin, 4 header connector for
external I/O's

1 No.

Desktop PC

Loaded with open source IDE, simulation and
program downloading software.

1 No.

X Precautions to be followed
Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.

1.
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Xl

[98)

10.

11

12.
13.
14.

Procedure

1. Create the Xilinx ISE project for top-level FPGA design, by doing the following
in ISE:

In the ISE software, select File > New Project.

In the Project name and Project location fields, enter the project name and location,

respectively.

Select HDL or Schematic as the Top-level source type, and click Next.

Create New Source file. Select Source Type” select the Source type and give the name

to the source then click “Next”.

Define Module”. Enter the entity used in design and then click “Next”.

Develop VHDL code for given problem and Synthesize the .vhd file and view RTL

schematic. Ref Figno.13.3.

Create Test Bench file- A test benchis HDL code that allows to provide a

documented, repeatable set of stimuli that is portable across different simulators.

A test bench can be as simple as a file with clock and input data or a more complicated

file that includes error checking, file input and output, and conditional testing. Ref Fig

no.13.4.

Go to implementation to simulation tab , right click on main source file and create Test

Bench file for simulation.

In order to view test files, select the box of “Simulation” in the “View Panel” of the

“Design” panel. In the “Process Panel,” double click on the “Behavioral Check

Syntax” to make sure that didn’t make any syntax errors while making changes.

Double click on “Simulate Behavioral Model” in the “Process Pane”, which will open

the ISim software with test bench loaded.

ISim simulator window will open with simulation executed, as shown in Ref Fig

no.13.5. where are able to simulate designs and check for errors.

After simulation implement binary to gray code converter Using FPGA development

board.

. Go to User Constraints — select Floorplan Area/IO/Logic (PlanAhead) — Windows —

Properties — now assign pin configuration and save.

Go to Implement Design — Run all.

Go to Generate Programming File and Run

Go to Config. Target Device and Run — Impact wizard opened — select Device 2 (as
per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx IC
And select Program.

SAMPLE PROGRAM :: Step 1.Develop VHDL code for Binary to Gray conversion

VHDL Code using When statement

library IEEE;

use IEEE.STD _LOGIC 1164.ALL;

use IEEE.STD LOGIC ARITH.ALL;

use IEEE.STD LOGIC UNSIGNED.ALL;

entity binary 2 gray is
port(
bin : in std logic_vector(3 downto 0); --binary input
G : out std_logic vector(3 downto 0) --gray code output

);
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end binary 2 gray;
architecture gate level of binary 2 gray is
begin

--XOor gates.

G(3) <=bin(3);

G(2) <= bin(3) xor bin(2);
G(1) <= bin(2) xor bin(1);
G(0) <= bin(1) xor bin(0);

end;

Step 2: Develop Test Bench file for simulation.

VHDL Code

LIBRARY ieee;
USE ieee.std logic 1164.ALL;

-- Uncomment the following library declaration if using
-- arithmetic functions with Signed or Unsigned values
--USE ieee.numeric_std.ALL;

ENTITY BINTOGRAY TB IS
END BINTOGRAY TB;

ARCHITECTURE behavior OF BINTOGRAY TB IS
-- Component Declaration for the Unit Under Test (UUT)

COMPONENT binary 2 gray

PORT(
bin : IN std logic vector(3 downto 0);
G : OUT std logic_vector(3 downto 0)
);

END COMPONENT;

--Inputs
signal bin : std logic_vector(3 downto 0) := (others =>"'0");

--Outputs
signal G : std_logic vector(3 downto 0);
-- No clocks detected in port list. Replace <clock> below with
-- appropriate port name
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--constant <clock> period : time := 10 ns;
BEGIN

-- Instantiate the Unit Under Test (UUT)
uut: binary 2 gray PORT MAP (

bin => bin,
G=>G
);

-- Clock process definitions
-- <clock> process :process
-- begin
-- <clock><="0";
-- wait for <clock> period/2;
-- <clock><="1";
-- wait for <clock> period/2;
--end process;

-- Stimulus process

stim_proc: process

begin
-- hold reset state for 100 ns.
wait for 100 ns;

bin <= "0000"
wait for 100 ns;
bin <="0001"
wait for 100 ns;
bin <="0011"
wait for 100 ns;
bin <="0100"

wait for 100 ns;
wait;

end process;

END;

Problem statement for student: Design VHDL Code for Binary to Gray code converter

using if else statement logic gates etc.

Step 1: Develop VHDL code for Binary to Gray conversion.

VHDL Code using behavioral method statement
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Step 2: Develop Test Bench file for simulation.

VHDL Code
X1l Resources Used
sg Instrument /Components Specification Quantity
1.
2.
3.
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XI1  Actual Procedure Followed (use blank sheet provided if space not sufficient)

XIV  Precautions Followed (use blank sheet provided if space not sufficient)

XV  Observations (use blank sheet provided if space not sufficient)

Truth table of Binary to Gray is (verified/ not verified) using FPGA
development board.

XVI Result (Output of the Program)

XVII Interpretation of Results (Give meaning of the above obtained results)

XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)
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XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. Design VHDL Code using FPGA board for Gray to Binary using When statement.

2. Design VHDL Code using FPGA board for Gray to Binary using Dataflow method
statement.

[Space for Answers]
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XX  References / Suggestions for further reading

1. https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/u

g usb_blstr ii_cable.pdf

2. https://www .xilinx.com/support/documentation/data_sheets/ds610.pdf

3. https://forums.xilinx.com/

4. https://www.geeksforgeeks.org/digital-logic-code-converters-binary-gray-code/

XXI Assessment Scheme

Total (25 Marks)

Performance indicators Weightage

Process related (15 Marks) 60%

1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%

4 | Correct connections to FGA board 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission of report, Answer to sample questions. 05%
100%

Name of student Team Member

Marks Obtained

Process Related | Product Related | Total
(15) (10) (25)

Dated signature of Teacher
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VI

Vil

Practical No. 14: Build / Test DAC using FPGA.

Practical Significance

In the real world, most of the data are available in analog form. There are two types of
electronic converters namely Analog to Digital converter and Digital to Analog
converter. While manipulating the data, these two converting interfaces are essential.
This practical will help the students to develop programming skills to Build / Test
DAC application on FPGA board using Xilinx ISE tools.

Relevant Program Outcomes (POs)

e Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

e Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

e Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

e Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronics circuits and equipments.’

e Develop ‘VHDL’ code using EDA tools.

e  Use Input/output port pins of FPGA.
e Interface FPGA KIT and desktop PC.

Relevant Course Outcome(s)
Debug VHDL programme for the given application.

Practical Outcome
Build / Test DAC using FPGA.

Relevant Affective domain related Outcome(s)
e Follow safe practices.

e Maintain tools and equipment.
e Follow ethical practices.

Minimum Theoretical Background

Digital to Analog Converter (DAC) :- It is a device that transforms digital data into an
analog signal. A DAC can reconstruct sampled data into an analog signal with
precision. The digital data may be produced from a microprocessor, Application
Specific Integrated Circuit (ASIC) or Field Programmable Gate Array (FPGA), but
ultimately the data requires the conversion to an analog signal in order to interact with
the real world.
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A D/A converter takes a precise number (most commonly a fixed-point binary
number) and converts it into a physical quantity (example: voltage, pressure,
temperature). D/A converters are often used to convert finite-precision time series data
to a continually varying physical signal.

Digital Data:-
Evenly spaced discontinuous values, temporally discrete, quantitatively discrete.

Analog Data (Natural Phenomena):-
Continuous range of values, temporally continuous, quantitatively continuous.

rr00r ——
Qre=rvT = 00—
TETT == —
;C)::C)F -g—r DAC
ol gl © Bl W
~+000 '

Digital Analog

Fig 14.1.a: Basic Digital to Analog signal representation.

— DO —>»

— D1 —>»

— D2 >
Digital — D3 —>» 8-Bit DAC
Input  —— D4 —»  (pigital to Analog Converter) > Voltage

— D5 —>»

— D6 —>»

— D7

Fig 14.1.b: 8 Bit Digital to Analog converter.
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VIl Practical Circuit diagram:

it

Logie tnput

Fig 14.2.b: Lab Practical Setup by set MSB data Bit high Analog output is high voltage
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Create ADC .vhd file:-

ISE Project Navigator (P.20131013) - F:Al SCHEME\VI SEM | SCHEME\pulkit\ DAC\DAC xise - [DAC_7528.vhd] - X
[Z) File Edit View Project Source Process Jools Window Layout Help
o3 | » Blaimeo=isw £
Design w08 x = =
View: @ 3} Implementation () [ Simulation 20 library
21 use
Hierarchy - .
22
] bAc 23 use
5 €3 xc3s400-5pq202 o
[Rde%: DAC - Behavioral (DAC_7528vhd) 25 use work.sine 4086 8.211;
26
27
Y2
. % 29
- - 30
- 31
% 32 entity DAC is
33 Port ( clk :
& 32 rst
£ No Processes Runring o= s
" | Processes: DAC - Behavioral & a3 Wz
p 37 a_b
B{| I DesignSummary/Reports 3 124 (7 downto 0);
3 Design Utilities ; iin (7 dowmre 0)
6w User Constraints pos )
- | = 41 )z
View RTL Schematic el nac:
View Technology Schematic ot
F)  Check Syntax . I .
B2 Generate Post-Synthesis Simulation M 3; prebitecture Behavioral of DAC 1s
£.T)  Implement Design 46 signal clk2 : std v
T)  Generate Programming File =
i A Confinuee Tanet Deics, = g 2
Start B8 Design U Files [[) Libraries E Desion Summary (Synthesized) DAC_7528.vhd ]
Console «+08 x
~
Process "Synthesize - XST" completed successfully
v
< >
[E] consoe € Emors 1\ Wamings (a6 FindinFies Resuits
£ 15im (P.20131013) - [Defaultonch] Jf Cut Cirl+X - X
z File Edit View Simulation [ Copy Ctrl+C
D2E|%i¥B EEE Cerl+V TEMD AN ALBAR x|t @ b F |16 () Re-aunch
- _ X ™
¢
2 Rename
/
8 B4 Find... Cirl+F
y_ Select All Ctrl+A
L
e Ungroup
=
2 Name »
Radix 3
+
[N 1 oe Signal Color 3
LI B cntr Divider Color
1 1§ ramp Reverse Bit Order
1§ data
o T 6o To Source Code
a Show Drivers
Force Clock...
Remove Force

L : New Group
New Divider

# New Virtual Bus

B UETaltwierg [ x]
Consale +08x%
WARNING: A WEEPACK cense was found. A
WARNI lease use Xiinx License Configuration Manager to check out a full 15im license,

WARNING: ISim wil run in Lite mode. Please refer to the I5im documentation for more information on the differences between the Lite and the Full version,

This is a Lite version of ISim.

Time resolution is 1 ps

Simulater is doing drcuit initialization process.

Finished drcuit initialization process,

15im> v

B consle =] Complationlog @ Greakpoints 6 FindinFlesResuts [jj SearchRewits

Fig 14.4.a: Simulation diagram
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£ [Sim (P0131013) - [Defaut wefg'] - X
jFMe Edit View Simulaton Window Layout Help

NELGIE CIGEE Y RETC AN AARAE e L@ b R s v G || ||BRetand
306,265

1% rit
'Y
Tyw

Vm b
p B ledral

[
] 0

1 o

b M otz
Ty vamp
“;; data 1

Fig 14.4.b: Simulation diagram (arrow shows peak level of converted analog signal)

c) Actual Experimental set up used in laboratory
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IX Resources Required
Sr. | Instrument/ | Specification Quantity
No. | Components
1. | FPGA Device: Xilinx FPGA (XC3S400 PQ208),0n board +5V, | 1 No.
Development | +3.3V, +2.5V supply to FPGA and other hardware
kit circuit.,On board, 2 Crystal S8MHz and 25MHz.JTAG
Interface ( Boundary Scan ), PROM Interface
(XCFO02S).,40 pin, 4 header connector for external I/O's
2. | Desktop PC Loaded with open source IDE, simulation and program 1 No.
downloading software.
3. | Digital Multi Voltage:- DC: 600 volts; AC: 600 volts; DC Accuracy: = | 1 No.
meter 0.5% + 3 digit; AC Accuracy: + 1% + 3 digit, Resistance:
-40 M ohm; Resistance Accuracy: + 1.5% + 3 digit,
AC/DC voltage, resistance, capacitance, frequency
measurement.
X Precautions to be followed
1. Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.
XI Procedure
1. Create the Xilinx ISE project for top-level FPGA design, by doing the following
in ISE:
In the ISE software, select File > New Project.
In the Project name and Project location fields, enter the project name and location,
respectively.
Select HDL or Schematic as the Top-level source type, and click Next.
2. Create New Source file. Select Source Type” select the Source type and give the
name to the source then click “Next”.
3. Define Module”. Enter the entity used in design and then click “Next”.
4. Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic. Ref Figno.14.3.
5. Create Test Bench file- A test benchis HDL code that allows to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing.
6. Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation. Or
Directly go to simulation tab — Process DAC behavioural — [Sim simulator—select
input entity bit — right click — select Force constant. Ref Fig no.14.4.a.
7. In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioral Check
Syntax” to make sure that didn’t make any syntax errors while making changes.
8. Double click on “Simulate Behavioral Model” in the “Process Panel”, which will
open the ISim software with test bench loaded.
9. ISim simulator window will open with simulation executed, as shown in Ref Fig

no.14.4.b where able to simulate designs and check for errors.

10. After simulation Build and Test DAC Using FPGA development board.
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11. To create .ucf file -- Go to User Constraints — select Floorplan Area/IO/Logic
(PlanAhead) — Windows — Properties — now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run
14. Go to Config. Target Device and Run — Impact wizard opened — select Device 2
(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx

IC And select Program.

15. Verify expected result on relevant FPGA lab kit.

SAMPLE PROGRAM 1: Step 2. Develop VHDL code for DAC converter.

VHDL Code using if else statement

library IEEE;
use [IEEE.STD LOGIC 1164.ALL;
use IEEE.STD LOGIC_ARITH.ALL;

use IEEE.STD LOGIC UNSIGNED.ALL;

use work.sine 4096 8.all; --using package for sine wave.

entity DAC is
Port (clk:in STD LOGIC;
rst :in std logic;
cs :out std logic;
wr :out std logic;
a_b: out std logic;

led : out std logic_vector(7 downto 0);
din : out std logic vector(7 downto 0)

);
end DAC;

architecture Behavioral of DAC is

signal clk2 : std logic;

signal cntr : std logic_vector(22 downto 0);

signal ramp : integer range 0 to 4100 ;
signal data : integer range 0 to 260 ;
begin

cs <=0
wr <="0"
a_b<="1}

clk2 <= cntr(1);
led <= conv_std logic vector(data,8);
din <= conv_std logic vector(data,8);

process(clk,rst)
begin
if(rst = '1")then
cntr <= (others =>"'0");
elsif(clk'event and clk ='1")then

--system clock
--system reset
--chip select
--write enable
--output select
--output leds
--input to DAC

Mabharashtra State Board of Technical Education

170




Very Large Scale Integration with VHDL (22062)

cntr <= cntr + 1;
if(entr="11111111111111111111111")then
cntr <= (others =>"'0");
end if;
end if;
end process;

process(rst,clk2)
begin
if(rst ="1")then
ramp <= 0;
elsif(clk2'event and clk2 ='1")then
ramp <=ramp + 1;
if(ramp = 4095)then
ramp <= 0;
end if;
data <= amp2(ramp);
end if}
end process;
end Behavioral;

Problem statement for student: Design VHDL Code for DAC using if else statement.
Step 1: Develop VHDL code.

VHDL Code using if else statement performed in lab practical.
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XIl Resources Used

l?l(r). Instrument /Components Specification Quantity

1.

2.

XI1  Actual Procedure Followed (use blank sheet provided if space not sufficient)

XV  Observations (use blank sheet provided if space not sufficient)

1?; Digital Data input | Analog output voltage in volts
1 0000 0000

2 0000 0011

3 0000 1111

4 00111111

5 11111111

XVI  Result (Output of the Program)
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XVII Interpretation of Results (Give meaning of the above obtained results)

XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)

XIX Practical Related Questions

Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO.

1. Design VHDL Code for ADC using FPGA board..

[Space for Answers]
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XX  References / Suggestions for further reading
https://www.pantechsolutions.net/vhdl-code-to-simulate-4-bit-binary-counter-by-

1.
2.
3.
4.

S.

software-using-spartan-3-starter-kit

https://www .xilinx.com/support/documentation/data_sheets/ds610.pdf

https://forums.xilinx.com/

https://www.rohm.com/electronics-basics/ad-da-converters/what-are-ad-da-

converters

https://www.elprocus.com/digital-to-analog-converter-dac-applications/

XXI Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connections to FPGA board. 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission of report, Answer to sample questions. 05%
Totals (25 Marks) 100%

Name of student Team Member

Marks Obtained

Process Product Total
Related (15) | Related (10) (25)

Dated signature of Teacher
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Vi

Vil

Practical No. 15: Implement Stepper motor controller using FPGA.

Practical Significance

FPGA provides a good combination to achieve both high speed and high precision
motion on a compact hardware. It can easily drive full, half and micro-step mode
applications due to the flexibility and the reduced computing time with the FPGA
implementation. FPGA can drive several stepper motors simultaneously without
increasing the processing time. This practical will help the students to develop skills to
interface stepper motor to FPGA and rotate in clockwise and anticlockwise direction.

Relevant Program Outcomes (POs)

Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering

problems.
Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills

This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronics circuits and equipments.’

Develop ‘“VHDL’ code using EDA tools.
Use Input/output port pins of FPGA.
Interface FPGA KIT and desktop PC.

Relevant Course Outcome(s)
Maintain FPGA based circuits.

Practical Outcome
Implement Stepper motor controller using FPGA.

Relevant Affective domain related Outcome(s)

Follow safe practices.
Maintain tools and equipment.
Follow ethical practices.

Minimum Theoretical Background

Stepper motor:-

The basic principle of stepper motor is electromagnetic induction which means while
apply a current to the circuit, the EMF will be induced due to change of magnetic field
of the circuit.

Working of stepper motor
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The rotor shaft of the stepper motor is surrounded by the electromagnetic stator. The
rotor and stator have poles which would be teethed or depends upon the motor type.
When apply the electrical pulse to the stator which gets energized and produced EMF.
The EMF cuts the conductor of the rotor. Now the torque will be introduced. This
torque (force) is used to rotate the rotor shaft which means the rotor align itself along
with stator.

Direction select - Stepper motor Shaft
output rotation
Frequency select > Clock pulses

Fig. 15.1: Basic Stepper motor system

The stepper motor operates at various modes such as Full step, Half step, Micro step
Full step:-

The full step of stepper motor is 200 steps per revolution. So the angle of rotation is
1.8 degrees which is calculating from given formula.

Step angle = 360 degrees / no of steps.

Step angle =360 / 200 = 1.8 degrees.

Half step:-

The half step of stepper motor is 400 steps per revolution. So the angle of rotation is
0.9 degrees which is calculating from given formula.

Step angle = 360 degrees / no of steps.

Step angle = 360 / 400 = 0.9 degrees.

Micro step:-

The advanced stepper motor has come with micro step system. Micro stepping of
stepper motor means which subdivides the number of positions between poles for
increasing the steps. Some micro stepping has a capable of divide a full step (1.8
degrees) into 256 micro steps. The result would be 51200 steps in one revolution
(0.007 degrees/step).

Interfacing stepper motor with Spartan3 FPGA Development Kit:-

The motor is used to covert mechanical energy into electrical energy. Stepper motor is
not like as any other motor which means is not rotating continuously. It is rotating step
by step according to given electrical pulse. The FPGA cannot drive stepper motor
directly. Because of the I/O capability of FPGA is 3.3v. So for the driver circuit are
required able to drive the stepper motor. A full rotation divides into a number of equal
steps. So this motor called as also stepper motor.

The four different color wires represent the four different windings.
Red-Yellow and White-Blue are the four-color wires.

Mabharashtra State Board of Technical Education 177



Very Large Scale Integration with VHDL (22062)

Stator
/

Fig. 15.2: Stepper motor stator and rotator

L1-Red-1a
L2-Yellow-1b
L3-White-2a
L4-Blue-2b

The control sequence for rotating the motor is shown in the table 15.1 and 15.2.
The respective windings should be made high according to the sequence given in the

table 15.1 and 15.2 and the controller very well executes this function.

Table No. 15.1: Clockwise Rotation

Step L1 L2 L3 L4
1 1 0 1 0
2 0 1 1 0
3 0 | 0 1
4 1 0 1 1

Table No. 15.2: Anti Clock Wise Rotation

Step L1 L2 L3 L4
1 1 0 0 1
2 0 1 0 1
3 0 1 1 0
4 1 0 1 0

The above shown sequence is in full step mode. In a single step the motor rotates by
1.8 degree.
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VIl Practical Circuit diagram:
a) Practical JTAG cable setup:

Fig. 15.2: Lab Practical Setup

b) Create stepper motor .vhd file :-

& ISE Project Navigator (P.20131013) - FAl SCHEMEWYI SEM | SCHEME\pulkit\sample\sample.ise - [ALU_code.vhd] X
File Edit View Project Source Process Teols Window Layout Help M
DREHD| L 200X 0va| JAPBRAR|A =B 0 SR P LT
|Design 08 x| 1o ~
[ |view: @ {8} implementation () 5 Simuiation 20 library IEEE;
Hierarch 21 wuse IEEE.STD LOGIC 1164.ALL;
& [ Hiearchy 22 use IEEE.NUMERIC_STD.ALL;
G| G sample o 23 use IEEE.STD_LOGIC_UNSIGNED.ALL:
| B £3 xc3s400-5pq208 ] —
#t| & [l ALU_code - Behavioral (ALU_code.vhd) 25 entity ALU code is
& - [ ALU_codewct 9 26 Port ( input A : in SIGNED (3 downto 0);
v — 27 input_B i in SIGNED (3 downto 0);
Al 28 out_final : out SIGNED (3 downto 0):
| €2 MNoProcesses Running | 2o select_operation : in STD LOGIC VECTOR (3 downto 0));
B 30 end ALU_code;
1 | Processes: ALU_code - Behavioral o1 1Y ey -
Sf| ~ L Design Summary/Reports > 32 archicecture Behavioral of ALU code is
= Design Utilities —| 33 begin
E User Constraints ©| 34 process(inpus A,input 3, select operation)
- 5 Creste Timing Constraints @| 35 vegin
& 10 Pin Planning (Plan&head) - Pre-Sy... —| 38 case select operation is
10 Pin Planning (PlanAhead) - Post-5... 37
| Floorplan Area/I0/Logic (PlanAhead) 38 when X"0" =>
Synthesize - XST 33 out_final <= input_A + input_B;
View RTL Schematic 40 when X"1" =>
- |E]  View Technology Schematic 41 out_final <= input A - input B;
L) CheckSyntax 42 when X727 =>
- F)  Generate Post-Synthesis Simulation M... 43 out_final <= input_A and input B:
2.1\ Implement Design 44 when X"3" =>
- F2() Generate Programming File 45 out_final <= input_A nand input B:
=3 @ Configure Target Device 46 when X"4" => v
: Generate Target PROM/ACE File w < >
L St T Design ) Fles [ Lbraries [E Design Summary (Implementec) =IIE] ALU_code vhd <]l
Conscle +08x
ISim simulation engine GUI launched successfully ~
Process "Simulate Behavioral Model" completed successfully
v
< >

Fig. 15.3: .vhd file
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¢) Create View technology schematic diagram :-

[3) Fle Edit View Project Source Process Iools Window Layout Help

BE; . o] [ APBR AR EET SRPEL
Design «0ax i
view: ®) {8 Implementation () {4 Simulation W,
Hierarchy

©] steppermotor

5 3 xc3sd00-5pq208 t p t
[ stepmotor - Behavioral (stepper_motar.vhd) S e mo Or

0 speed(3:0 s2out(3:0)
m clk
< ) B dirctn

) No Processes Running

Processes: stepmotor - Behavioral rst b
£ Design Summary/Reports

f Design Utilties
i User Constraints k ‘

= 8).1\ Synthesize - X5T
View RTL Schematic
0
[¢]

12728 =

gl

View Technology Schematic Ste pmotor

Check Syntax
Generate Post-Synthesis Simulation Model
@ @) Implement Design
?)  Generate Programming File
- Configure Target Device
@4 Analyze Design Using ChipScope L Design Ssummary (Synthesized) stepper_motor.vhd 5 stepmotor (Tech) 8

Fig. 15.4: View Technology schematic diagram

d) Stepper motor Simulation waveforms-

D YEIL X EEX®|0 o MK ) RBEDG ! 3y %ﬂ um'}zl‘DDUSV“E [ Redaunch

(]
0
e j Force Selected Signal
3
g Enter parameters below to force the signal to a constant
I 10 value. Assignments made from within HDL code or any
i 3 0 previously applied constant or clock force will be
! overridden.
Signal Name: [stepmator/dirctn
n 0 0 Value Radix Binary
Force o Value: 1
Starting at Time Offeet: 0
Cancel after Tme Offset:
Cancel Anply Help
) Default wy ]
Console «+08X

Fig. 15.5: Forcefully to generate simulation output
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% 15im (P.20131013) - [Defauttwcf]
gFile Edt View Simulation Window Layout Help

02H - £E0Xx@oo/M@l [0EET

T o
1] dircn
¥ B speed3d)

- |3 FO@

& Defauftwcfg

T 0 b %[ v G ||| GRetand:

16,200 ns

Console

«08Xx
Fig. 15.6: Simulation output

e) Actual Experimental set up used in laboratory
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IX Resources Required
EIB'. /CI:r;Sr;r;olegfcs Specification Quantity
1. | FPGA Device: Xilinx FPGA (XC3S400 PQ208), On board 1 No.
Development | +5V, +3.3V, +2.5V supply to FPGA and other hardware
kit circuit, On board, 2 Crystal 8MHz and 25MHz.JTAG
Interface ( Boundary Scan ), PROM Interface
(XCFO02S), 40 pin, 4 header connector for external I/O's
2. | Stepper Motor | With 5V / 1.2A rating, Select frequency of rotation of 1 No.
motor through DIP switches, Select direction of rotation
(clockwise or counter clockwise.) through
toggle switch.
3. | Desktop PC Loaded with open source IDE, simulation and program 1 No.
downloading software.
X Precautions to be followed
1. Use proper Mains cord.
2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.
3. Check syntax / rules for VHDL programming.
XI Procedure
1. Create the Xilinx ISE project for top-level FPGA design, by doing the following
in ISE:
In the ISE software, select File > New Project.
In the Project name and Project location fields, enter the project name and location,
respectively.
Select HDL or Schematic as the Top-level source type, and click Next.
2. Create New Source file. Select Source Type” select the Source type and give the
name to the source then click “Next”.
3. Define Module”. Enter the entity used in design and then click “Next”.
4. Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic. Ref Figno.15.3 and 15.4.
5. Create Test Bench file- A test bench is HDL code that allows to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing.
6. Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation or directly simulate and apply entity value forcefully
as shown in fig.. 15.5.
7. In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioural
Check Syntax” to make sure that didn’t make any syntax errors while making
changes.
8. Double click on “Simulate Behavioural Model” in the “Process Pane”, which will
open the ISim software with test bench loaded.
9. ISim simulator window will open with simulation executed, as shown in Ref Fig

no.15.6. where are able to simulate designs and check for errors.
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10. After simulation implement 2 as 4 decoder Using FPGA development board.

11. Go to User Constraints — select Floorplan Area/IO/Logic (Plan Ahead) — Windows
— Properties — now assign pin configuration and save.

12. Go to Implement Design — Run all.

13. Go to Generate Programming File and Run

14. Go to Config. Target Device and Run — Impact wizard opened — select Device 2
(as per practical Kit set up) -- open Bit file -- and initialize Chain — Right click on
Xilinx IC and select Program.

SAMPLE PROGRAM :- Step 1.Develop VHDL code for Stepper Motor.

VHDL Code using if else statement

library IEEE;

use I[EEE.STD LOGIC 1164.ALL,;

use [EEE.STD LOGIC ARITH.ALL;

use [EEE.STD LOGIC _UNSIGNED.ALL,;

--use UNISIM.VComponents.all;

entity stepmotor is
Port (clk : in STD LOGIC; --input clock
dirctn : in STD LOGIC; --direction
speed : in STD LOGIC VECTOR(3 downto 0);  --frequency select
s2out: out STD LOGIC VECTOR(3 downto 0);--output to stepper 3
serial port
rst b :instd logic -- external reset

);

end stepmotor;

architecture Behavioral of stepmotor is

signal counter:std logic vector(22 downto 0); --Signal for main counter
signal flasher:std logic vector(1 downto 0); --signal for stepper sequence
begin

process(clk,dirctn,speed,rst_b)

begin

if(rst b ="1")then
counter <= (others =>"'0");

elsif(clk'event and clk="1")then
counter<=counter+1; --counter increment

if(speed="0000")then
if(counter(20)='1")then
flasher<=flasher+1;
counter<="00000000000000000000000";
end if;
elsif(speed="0001")then
if(counter(19)="1")then
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flasher<=flasher+1;
counter<="00000000000000000000000";
end if;
elsif(speed="0011")then
if(counter(18)="1")then
flasher<=flasher+1;
counter<="00000000000000000000000";
end if;
elsif(speed="0111")then
if(counter(17)="1")then
flasher<=flasher+1;
counter<="00000000000000000000000";
end if;
elsif(speed="1111")then
if(counter(16)="1")then
flasher<=flasher+1;
counter<="00000000000000000000000";
end if;
end if;

if(dirctn='0")then--direction check
case flasher is
when "00"=>s2out<="1000";--"0001";--step 1 "0101";
when "01"=>s2out<="0100";--"0010";--step 2 "1001";
when "10"=>s2out<="0010";--"0100";--step 3 "1010";
when "11"=>s20out<="0001";--"1000";--step 4 "1001";

when others=>s2out<="XXXX";

end case;
else
case flasher is
when "00"=>s2out<="0001";--"1000";--step 1"0110";
when "01"=>s20ut<="0010";--"0100";--step 2sout<="1010";
when "10"=>s20ut<="0100";--"0010";--step 3sout<="1001";
when "11"=>s20out<="1000";--"0001";--step 4sout<="0101";
when others=>s2out<="XXXX";
end case;
end if;

end if;
end process;
end Behavioral;
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Problem statement for student: Design VHDL Code for Stepper Motor using if else
statement

Step 1.Develop VHDL code for Stepper Motor.

VHDL Code using if else statement

XIl  Resources Used
r. e L. .
lflo Instrument /Components Specification Quantity
1.
2.
3.
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XI1  Actual Procedure Followed (use blank sheet provided if space not sufficient)

XIV  Precautions Followed (use blank sheet provided if space not sufficient)

XV  Observations (use blank sheet provided if space not sufficient)

Stepper motor operations as per select direction input value is (verified/ not
verified) using FPGA development board.

XVI Result (Output of the Program)

XVII Interpretation of Results (Give meaning of the above obtained results)

XVI1II Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)
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XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. A stepper motor with a step angle of 7.5 degrees. Write requirement of steps per
revolution.
2. Write 5 wires and 6 wires stepper motor technical specification.
Write FPGA limitations to drive stepper motor without driver circuit.
4. 1If a motor takes 180 steps per revolution then calculate the step angle for this
motor.

(98]

[Space for Answers]
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XX  References / Suggestions for further reading
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/u

1.

(O8]

g usb_blstr ii_cable.pdf

https://www .xilinx.com/support/documentation/data_sheets/ds610.pdf

https://forums.xilinx.com/

https://www.researchgate.net/publication/258507854 FPGA based_stepper motor

_controller

https://www.pantechsolutions.net/interfacing-stepper-motor-with-spartan3-fpga-

development-kit

XXI Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60%
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct connection to FPGA board 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission of report, Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained

Process Product Total
Related (15) Related (10) (25)

Dated signature of Teacher
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Practical No. 16: Implement four Bit ALU or sequence generator using

Vi

FPGA.

Practical Significance

An arithmetic logic unit (ALU) represents the fundamental building block of the
central processing unit of a computer. An ALU is a digital circuit used to perform
arithmetic and logic operations

A sequence detector is a sequential circuit that outputs high (1) when a particular
pattern of bits sequentially arrives at its data input. This practical will help the
students to develop programming skills that is four Bit ALU or sequence generator
application on FPGA board using Xilinx ISE tools.

Relevant Program Outcomes (POSs)

Discipline knowledge: Apply Electronics and Telecommunication engineering
knowledge to solve broad-based Electronics and Telecommunications engineering
related problems.

Experiments and practice: Plan to perform experiments and practices to use the
results to solve broad-based Electronics and Telecommunication engineering
problems.

Engineering tools: Apply relevant Electronics and Telecommunications
technologies and tools with an understanding of the limitations.

Lifelong learning: Engage in independent and life-long learning activities in the
context of technological changes also in the Electronics and Telecommunication
engineering and allied industry

Competency and Practical Skills
This practical is expected to develop the following skills for the industry-identified
competency: ‘Maintain VLSI based electronics circuits and equipments.’

Develop ‘VHDL’ code using EDA tools.
Use Input/output port pins of FPGA.
Interface FPGA KIT and desktop PC.

Relevant Course Outcome(s)
Maintain FPGA based circuits.

Practical Outcome
Implement four Bit ALU or sequence generator using FPGA.

Relevant Affective domain related Outcome(s)

Follow safe practices.
Maintain tools and equipment.
Follow ethical practices.
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VIl Minimum Theoretical Background

a) Arithmetic logic unit (ALU) :An arithmetic logic unit (ALU) is a digital circuit used

to perform arithmetic and logic operations. It represents the fundamental building
block of the central processing unit (CPU) of a computer. Modern CPUs contain
very powerful and complex ALUs. In addition to ALUs, modern CPUs contain a
control unit (CU).

Most of the operations of a CPU are performed by one or more ALUs, which load
data from input registers. A register is a small amount of storage available as part
of a CPU. The control unit tells the ALU what operation to perform on that data,
and the ALU stores the result in an output register. The control unit moves the data
between these registers, the ALU, and memory.

All information in a computer is stored and manipulated in the form of binary
numbers, i.e. 0 and 1. Transistor switches are used to manipulate binary numbers
since there are only two possible states of a switch: open or closed. An open
transistor, through which there is no current, represents a 0. A closed transistor,
through which there is a current, represents a 1.

Fig 16.1 & 16.2 shows how AND operation and OR operation is performed. Four
bit two inputs and four bit one output.

inputs inputs inputs inputs
o 0 1 0 0 1 a S |
AND gate
o 0 0 1
output output output output
Fig. 16.1: AND operation.
inputs inputs inputs inputs
o 0 1 O 0 1 11
OR gate
o 1 1 1
output output output output

Fig. 16.2: OR operation.
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Table 16.1 shows that ALU operation performed according to select signal. With this
logic user can develop the VHDL code.

Table 16.1: Signal and operation.

Select signal | Operation

0000 Addtion

0001 Substraction

0010 ANDing operation
0011 NANDing operation
0100 XORing operation
0101 XNORing operation
0110 ORing operation

b) Sequence detector: A sequence detector is a sequential state machine which takes
an input string of bits and generates an output 1 whenever the required sequence
has been detected.

There are two types:

i.  Moore machine: In a Moore machine, output depends only on the present state
and not dependent on the input (x).

ii. Mealy machine: In a Mealy machine, output depends on the present state and
the external input (x).

VIl Practical Circuit diagram:
a) Practical JTAG cable setup:-

10-pin Female Connector
(Connects to target printed
circuit board 10-pin male header. )

LED Color Description

off Not connected or suspended

Blue Connected at 12MHz (USB full speed)
Teal Connected at 480MHz (USB high speed)
Green JTAG port open, idle

Green flickering | JTAG port open, active

Magenta blinking | Set by user to identify a cable ")

Fig. 16.3.a: Practical Setup with JTAG CABLE
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Fuann Burton S
il A
s""l LS

& °

Laglc Output

® 9 s @D

| Loglc Input

Digital Input Output imerface Board

Fig. 16.3.b: Lab Practical Setup

b) Create four Bit ALU .vhd file :-

& |SE Project Navigator (P.20131013) - Al SCHEME\VI SEM | SCHEME\pulkit\sample\samplexise - [ALU_codevhd] - X
File Edit View Project Source Process Tools MWindow Layout Help - & x
CAEFIZ X Xlwa| P[RR RIAREETIC|LRIPELQ
Design ~08x & 1e =
View: @ 1} mplementation ) [ Simulation 20 library Il
21
Hierarchy 2
] sample “ 23 use L
B €3 xc3s400-5pq208 24
£+ [Wleffs ALU_code - Behavioral (ALU_code.vhd) 25 entity ALU code is
[ ALU code.uc 26 Port ( input A : in SIGNED (3 downto 0);
27 input_B : in SIGNED (3 downto 0);:
28 out_final : out SIGNED (3 downto 0);
€2 Mo Processes Running 28 select_operation : in STD_LOGIC VECTOR (3 downto 0)):
30 end ALU code;
Processes: ALU_code - Behavioral “ B -
T Design Summary/Reports 32  architecture Behavioral of ALU code is
Design Utilities 33 begin
B User Constraints 34 process(input_A,input_B,select operation)
“} Create Timing Constraints 35 begin
1/0 Pin Planning (PlanAhead) - Pre-Sy... 36 case select_operacion is
1/0 Pin Planning (PlanAhead) - Post-5... 37
Floorplan Area/|0fLogic (PlanAhead) 38 when X"0
=By Synthesize - XST 39 out_final <= input_& + input_B:
View RTL Schematic 40 when X"1" =>
%|  View Technology Schematic a1 out_final <= input A - input B;
) Check Syntax 42 when =
T)  Generate Post-Synthesis Simulation M... 43 out_final <= input A and input B:
2.4y Implement Design 44 when X"3" =>
P2() Generate Programming File 45 out_final <= input_A nand input_B;
©-[%  Configure Target Device 46 when XUav =» w
@ Generate Target PROM/ACE File © < >

L Strt ©% Design ] Fles [ Lbraries T Design Summary (Implemented) ALU_code.vhd <]

Console 08 x
ISim simulation engine GUI launched successfully ~
Process "Simulate Behavioral Model" completed successfully

v
< >

Console @ Errors  _f\ Warnings [p§ Find in Files Results

Fig. 16.4: .vhd file
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c) Apply entity values forcefully to generate simulation waveforms.

£ 15im (P.20131013) - [Default.wefg*] - X
[ File Edit View Simulstion Window Layout Help
D2 A B EX®| 0| MR = Nl = Rliwar |t (@ p pE[roous|v]6: (3 Redaunch

A ¥ ot Ctrlex

y i} ™ Copy Ctrl+C

o y Rename —
1

Jg - Find... Ctrl+F

—
I
]
e ——
|
e
f - Select Al Ctrl+A B [
Expand
Collapse
Ungroup
a
- Name
Radix
Signal Color
Divider Color

'.E Go To Source Code

>
= Show Drivers o
Console e coAax
#isim force add {/alu_code/select operal  Remove Force ~
15im>
# im force add {/al_code/select_9PeI2 27 New Group
ISim> o
#run 1.00us New Divider
15im=> % New Virtuzl Bus
#run 1.00us
15im> hd
B console (=] Compiationlog @ Breakpoints (@4 FindinFlesResults [fy SearchReaults
Fig. 16.5: Forceful Simulation
d) Bit ALU Simulation waveforms-

ISim (P.20131013) - [Defaultwefg'] - X
j File Edit View Simulation Window Layout Help

OD2a|: : ® oo RIS AR ALR AR e &0 Lo v (3 Redaunch

1011

» % selm,uperatmn[z:o]

X1: 3,567458 us

) Default.wefg™ (]

Console +08x

#gim force add {falu_code select_operation} 0101 -radix bin ~
ISim>

#isim force add {Jalu_code select_operatiori} 0101 adix bin

ISim>

#run 1.00us

ISim>

#run 1.00us

ISim> v
@ console [ Compiatonlog @ Breskpoints (8§ FindinFlesResults [gf SearchResults

Fig. 16.6: Simulation Output
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e) Actual Experimental set up used in laboratory

IX Resources Required
Sr. Instrument / I .
No. | Components Specification Quantity
1. | FPGA Device: Xilinx FPGA (XC3S400 PQ208),0n board | 1 No.
Development | +5V, +3.3V, +2.5V supply to FPGA and other
kit hardware circuit. On board, 2 Crystal 8MHz and
25MHz.JTAG Interface ( Boundary Scan ),PROM
Interface (XCF02S),40 pin, 4 header connector for
external I/O's
2. | Desktop PC Loaded with open source IDE, simulation and | I No.
program downloading software.
X Precautions to be followed

1. Use proper Mains cord.

2. To avoid fire or shock hazards, observe all ratings and marks on the instrument.

3. Check syntax / rules for VHDL programming.
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Xl Procedure

1.

(O8]

10.
1.

12.
13.
14.

Create the Xilinx ISE project for top-level FPGA design, by doing the following
in ISE: In the ISE software, select File > New Project.

In the Project name and Project location fields, enter the project name and location,
respectively.

Select HDL or Schematic as the Top-level source type, and click Next.

Create New Source file. Select Source Type” select the Source type and give the
name to the source then click “Next”.

Define Module”. Enter the entity used in design and then click “Next”.

Develop VHDL code for given problem and Synthesize the .vhd file and view
RTL schematic. Ref Figno.16.4.

Create Test Bench file- A test bench is HDL code that allows to provide a
documented, repeatable set of stimuli that is portable across different simulators.
A test bench can be as simple as a file with clock and input data or a more
complicated file that includes error checking, file input and output, and
conditional testing.

Go to implementation to simulation tab , right click on main source file and create
Test Bench file for simulation or directly simulate and apply entity value forcefully
as shown in fig. 16.5.

In order to view test files, select the box of “Simulation” in the “View Panel” of
the “Design” panel. In the “Process Panel,” double click on the “Behavioral Check
Syntax” to make sure that didn’t make any syntax errors while making changes.
Double click on “Simulate Behavioral Model” in the “Process Pane”, which will
open the ISim software with test bench loaded.

ISim simulator window will open with simulation executed, as shown in Ref Fig
no.16.6. where are able to simulate designs and check for errors.

After simulation implement 4-bit ALU using FPGA development board.

Go to User Constraints — select Floorplan Area/IO/Logic (Plan Ahead) — Windows
— Properties — now assign pin configuration and save.

Go to Implement Design — Run all.

Go to Generate Programming File and Run

Go to Config. Target Device and Run — Impact wizard opened — select Device 2
(as per practical Kit) -- open Bit file -- and initialize Chain — Right click on Xilinx
IC And select Program.

SAMPLE PROGRAM :- Step 1.Develop VHDL code four Bit ALU.

VHDL Code using When statement

library IEEE;

use IEEE.STD LOGIC 1164.ALL;

use [IEEE.NUMERIC STD.ALL;

use IEEE.STD LOGIC UNSIGNED.ALL;

entity ALU code is
Port (input_A : in SIGNED (3 downto 0);
input B :in SIGNED (3 downto 0);
out final : out SIGNED (3 downto 0);
select_operation : in STD _LOGIC VECTOR (3 downto 0));
end ALU code;
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architecture Behavioral of ALU code is
begin
process(input_A,input_B,select operation)
begin

case select operation is

when X"0" =>out_final <= input_A + input_B;
when X"1" =>out_final <= input A - input_B;
when X"2" => out final <= input_A and input_B;
when X"3" =>out_final <= input_A nand input_B;
when X"4" =>out_final <= input_A xor input_B;
when X"5" =>out_final <= input_A xnor input_B;
when X"6" =>out_final <= input_A or input_B;
when others => null;
end case;
end process;
end Behavioral;

Problem statement for student: Design VHDL Code for 4-bit ALU using if else statement.

Step 1: Develop VHDL code for four Bit ALU.

VHDL Code using if else statement
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X1l Resources Used
z'; Instrument /Components Specification Quantity
1.
2.
3.
XII1  Actual Procedure Followed (use blank sheet provided if space not sufficient)
XIV  Precautions Followed (use blank sheet provided if space not sufficient)
XV  Observations (use blank sheet provided if space not sufficient)
ALU operations as per select input value are (verified/ not verified) using
FPGA development board.
XVI  Result (Output of the Program)
XVII Interpretation of Results (Give meaning of the above obtained results)

Mabharashtra State Board of Technical Education 198



Very Large Scale Integration with VHDL (22062)

XVIII Conclusion and Recommendation (Actions/decisions to be taken based on the

interpretation of results)

XIX Practical Related Questions
Note: Below given are few sample questions for reference. Teacher must design
more such questions so as to ensure the achievement of identified CO
1. Design VHDL Code using FPGA board four Bit ALU using Case statement.

2. Design VHDL Code using FPGA board for sequence generator using if else
statement.

[Space for Answers]
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XX  References / Suggestions for further reading
https://www.intel.com/content/dam/www/programmable/us/en/pdfs/literature/ug/u

1.

SNk

g usb_blstr ii_cable.pdf

https://www .xilinx.com/support/documentation/data_sheets/ds610.pdf

https://forums.xilinx.com/
https://en.wikipedia.org/wiki/Arithmetic logic unit

https://study.com/academy/lesson/how-to-design-sequence-detectors-steps-

example.html

XXI  Assessment Scheme

Performance indicators Weightage
Process related (15 Marks) 60% (15)
1 | Coding and Debugging ability 30%
2 | Making connections of hardware 20%
3 | Follow ethical practices. 10%
Product related (10 Marks) 40%
4 | Correct corrections to FPGA Board 20%
5 | Relevance of output of the problem definition. 15%
6 | Timely Submission of report, Answer to sample questions. 05%
Total (25 Marks) 100%

Name of student Team Member

Marks Obtained

Process Product Total
Related (15) Related (10) (25)

Dated signature of Teacher
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